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About this document

The following topics are discussed in this section:

• “Who should read this document and why” (page 11)

• “What you need to know” (page 11)

• “How this document is organized” (page 11)

• “What’s new in this document” (page 12)

• “Text conventions” (page 12)

• “Related documents” (page 14)

Who should read this document and why
This document is for those who require performance metrics for devices in the 
Preside MDM network. This document describes the Performance 
management tools and how to use them.

What you need to know
This document assumes that you have an understanding of 

• network management

• the elements in your network including the Passport product 

• the UNIX operating system

How this document is organized
This document contains the following sections:

• “Performance management overview” (page 15) gives a description of 
the performance management tools and how to access them.
Preside MDM Performance Management  User Guide   14.3RSUP



12   About this document
• “Data Viewer” (page 19) describes the Data Viewer tool for collecting 
and displaying performance information about Simple Network 
Management Protocol (SNMP) and Passport devices and components. 
This section also provides procedures for using this tool.

• “DPN Performance Viewer” (page 115) describes the DPN Performance 
Viewer tool for collecting and displaying performance information about 
Passport and DPN components and provides procedures for using this 
tool.

• “Passport performance metrics” (page 139) provides a list of metrics 
supported by the Data Viewer application.

• “DPN-100 metrics” (page 265) provides a list of metrics supported by 
the Data Viewer application.

• “Metric file format” (page 271) provides a description of the SNMP 
metric file format and elements.

What’s new in this document
The following changes were made to this document:

• “Enhancements” (page 12)

Enhancements
The following enhancements have been made to the Data Viewer tool:

• new metrics for this release

• minor corrections

Text conventions
This document uses the following text conventions: 

• nonproportional spaced plain type

Nonproportional spaced plain type represents system generated text or 
text that appears on your screen.

• nonproportional spaced bold type

Nonproportional spaced bold type represents words that you should type 
or that you should select on the screen.
241-6001-031   14.3RSUP   



About this document   13
• italics

Statements that appear in italics in a procedure explain the results of a 
particular step and appear immediately following the step.

Words that appear in italics in text are for naming.

• [optional_parameter]

Words in square brackets represent optional parameters. The command 
can be entered with or without the words in the square brackets.

• <general_term>

Words in angle brackets represent variables which are to be replaced with 
specific values.

• UPPERCASE,lowercase

Uppercase and lowercase letters that appear in UNIX commands and 
parameters must be matched exactly. The system matches upper and 
lowercase characters differently.

• UPPERCASE,lowercase

Passport commands are not case-sensitive and do not have to match 
commands and parameters exactly as shown in this document, with the 
exception of string options values (for example, file and directory names) 
and string attribute values.

• ->

A right-pointing arrow in a procedure indicates that a menu item has 
submenus from which you must choose. The appropriate submenu 
selection is shown immediately after the arrow. 

• |

This symbol separates items from which you may select one; for 
example, ON|OFF indicates that you may specify ON or OFF. If you do 
not make a choice, a default ON is assumed.
Preside MDM Performance Management  User Guide   14.3RSUP



14   About this document
• ...

Three dots in a command indicate that the parameter may be repeated 
more than once in succession.

The term absolute pathname refers to the full specification of a path starting 
from the root directory. Absolute pathnames always begin with the slash ( / )
symbol. A relative pathname takes the current directory as its starting point, 
and starts with any alphanumeric character (other than /).

Related documents
See the following documents for related information:

• 241-6001-011 Preside MDM Fault Management User Guide
241-6001-031   14.3RSUP   
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Chapter 1
Performance management overview

Performance management
The Preside Multiservice Data Manager (MDM) tools for accessing 
performance are available from the Performance toolset in the Preside MDM 
window. 

The figure “Preside MDM performance management tools” (page 16) shows 
the selection of performance management tools. 
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Figure 1
Preside MDM performance management tools

The following list provides a brief description of the performance 
management tools:

• Data Viewer
Data Viewer monitors performance metrics of components associated 
with (Simple Network Management Protocol (SNMP) and Passport 
devices using a graphical interface, traces faults in the network, collects 
information about network load, and generates statistics for reporting 
analytical purposes. For details, see “Data Viewer” (page 19).

• DPN Performance Viewer
DPN Performance Viewer monitors performance metrics of components 
associated with DPN devices using a graphical interface, traces faults in 
the network, collects information about network load, and generates 
statistics for reporting analytical purposes. For details, see “DPN 
Performance Viewer” (page 115).
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Accessing performance management tools
Access performance management tools from the Preside MDM window or 
the Start Tool menu from within a Preside Multiservice Data Manager 
(MDM) fault tool.

1 Start the performance management tool by one of the following methods:

• In the Preside MDM window, select Performance and then the tool 
name that you want to use. For example, to start the Data Viewer tool, 
select Performance -> Data Viewer.

• From a fault management tool, open the Start Tools menu. (For 
details, see the tool’s documentation.) From the pop-up menu that 
opens, select Start Tool and then the tool name that you want to use. 
For example, to start the Data Viewer, select
Start Tool -> Performance -> Data Viewer.

• From the command line by typing /opt/MagellanNMS/bin/
dataviewer -mode <REALTIME|REPLAY>. REALTIME launches 
the Data Viewer in real-time mode. REPLAY launches the Data 
Viewer in replay mode. The default is real-time mode.

The selected performance management tool opens.
Preside MDM Performance Management  User Guide   14.3RSUP
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Chapter 2
Data Viewer

This section describes the Data Viewer tool. The following information is 
contained in this section:

• “Data Viewer overview” (page 19)

• “Applicable to real time mode” (page 20)

• “Applicable to replay mode” (page 32)

• “Applicable to real-time and replay modes” (page 37)

Note: For information on using the Data Viewer tool, see “Data Viewer 
procedures” (page 57)

Data Viewer overview
The Data Viewer tool is a Preside Multiservice Data Manager (MDM) 
diagnostic tool that lets you collect, display and analyze performance 
information in real-time mode and replay mode. 

The Data Viewer supports the following views:

• spreadsheet view 

• record view

• component view 
This view supports all device types in real-time mode. In replay mode, 
this view supports Statistical Retrieval System (SRS), Streamed Passport 
Statistics (PMSP), Data Viewer Saved Statistics, and Management Data 
Provider statistics.
Preside MDM Performance Management  User Guide   14.3RSUP
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• latest poll view (real-time mode only)

Note 1:  The Performance Measurement Stream Processor (PMSP) 
server is used only in a Succession Network solution.

Note 2:  See “Data panel area” (page 37).

This section includes information specific to real-time mode, replay mode, 
and to both modes. See the following sections for more information:

• “Applicable to real time mode” (page 20). 
See “Menu bar” (page 23) for more information on the menu items 
specific to real time mode.

• “Applicable to replay mode” (page 32).
See “Menu bar” (page 23) for more information on the menu items 
specific to replay mode.

• “Applicable to real-time and replay modes” (page 37). 

Applicable to real time mode
Note: This section applies to real-time mode. See the following sections: 
“Applicable to replay mode” (page 32), and “Applicable to real-time and 
replay modes” (page 37).

Data from Passport and Simple Network Management Protocol (SNMP) 
devices is collected in real-time mode. You can use the Data Viewer to do the 
following tasks:

• help trace faults in the network 

• collect information about network load

• generate statistics for reporting and analytical purposes

The Data Viewer collects attributes for Passport and SNMP devices and uses 
the attributes to derive more meaningful metric values. The Data Viewer also 
supports 64-bit counters for Passport and SNMP devices.

Passport network components use the Generic Prober (GP) server to collect 
performance information. This tool also provides a metric file that contains a 
list of available metrics for each Passport and SNMP component. A metric 
241-6001-031   14.3RSUP   
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file is a text file that is written in XML format. The contents of a metric file 
depends on the SNMP or Passport device type to which the file applies. One 
metric file is required for each SNMP or Passport device type. 

The metric names appear in the Data Viewer window when you select a 
component to monitor. You can choose the metrics to display for each 
component, during each polling session. The metric values display in both 
tabular and graphical formats. You can also add metrics and components to 
the metric file as required. 

You can customize the metric files by adding metrics and components as 
required. To customize a metric file, use a standard UNIX text editor. You 
must follow the format in the file and provide accurate and complete 
information. For information on the elements of a metric file and the format 
in which they must be used, see “Metric file format” (page 271).

This section contains the following information on real-time mode:

• “Data Viewer window for real-time mode” (page 21)

• “Authenticate dialog” (page 30)

• “Working with Data Viewer Saved Statistics files” (page 31)

Data Viewer window for real-time mode
The Data Viewer window for real-time mode is described in this section. This 
section contains the following areas:

• “Menu bar” (page 23)

• “Polling criteria area” (page 26)

• “Metric selection area” (page 28) 

• “Command buttons” (page 29) 

• “Status line” (page 30)

• “Graph button” (page 30) 

The figure “Data Viewer window - Real-time mode in latest poll view” 
(page 23) shows a sample display of the Data Viewer default window in real-
time mode.
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A splitter bar between the metric selection area and the data panel area divides 
the Data Viewer window into two adjustable window panes. You can adjust 
the window panes to hide or show each area or to have one area fill the entire 
Data Viewer display. To change the relative size of each window pane, click 
and drag the mouse over one of the window pane movement arrows.

When you first attempt to establish a connection to a network component, 
there is a delay until a response is received from the server. During this delay, 
the status line at the bottom of the Data Viewer window displays the status of 
the connection.

From the Data Viewer window, you can launch the Graph window to view 
details of the data collected for each component. See “Authenticate dialog” 
(page 30).
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Figure 2
Data Viewer window - Real-time mode in latest poll view

Menu bar
The menu bar commands let you use the Data Viewer and view its 
performance information. The menu bar contains the following menus:

• “File menu” (page 35)

• “Options menu” (page 35)

• “View menu” (page 35)
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• “Help menu” (page 36)

File menu
The File menu contains the following commands:

• Connect To Server connects to the server to start a polling session. A 
message in the Status line informs you of the connection status. 

• Start Recording lets you write statistical data, including baseline-delta 
statistics, to the Data Viewer Saved Statistics file. This command has the 
following options:

— Record All Available Data writes to the Data Viewer Saved 
Statistics file all the metric data that the Data Viewer has collected 
since start-up. 

— Record Starting Now writes the metric data that the Data Viewer 
collects during the next and subsequent polling intervals.

You can choose to overwrite an existing Data Viewer Saved Statistics file or 
start a new file with a new name. The file is placed in your home directory, 
unless you provide an absolute pathname. 

The Data Viewer Saved Statistics file is updated every time data is received. 
Updates stop when you select the Stop Recording command or exit the Data 
Viewer. 

The null value makes a break point on the graph to make a pause and resume 
more visible. In the data record file, the null values appear as empty between 
the delimiter. All baseline values are reset to the value collected from the first 
poll taken after you click Continue.

• Stop Recording stops output to the Data Viewer Saved Statistics file and 
saves and closes the file. 

• View Recording displays the View File window to let you select a file 
to view. You can also view baseline-delta statistics. If you select the file 
that is currently open, new data are written to the file as they are received. 

The File menu of the View File window has the following options:

— Load File opens the selected Data Viewer Saved Statistics file and 
writes it to the screen.
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— Exit closes the Data Viewer Saved Statistics file.

• Exit terminates the polling session and closes all Data Viewer windows. 

Note: These commands, except Exit, are disabled in Replay mode.

Options menu 
The Options menu contains the following commands: 

• Replay Mode lets you replay collected data. When this option is 
selected, Replay Mode is disabled.

• Load MIBs launches a dialog that lets you select the Management 
Information Base (MIB) file to load. A MIB file maps each Simple 
Network Management Protocol (SNMP) device type to its object ID 
(OID). If the MIB file for a device type is specified in the resource file, 
the MIB file loads automatically when you click Start in the Data Viewer 
window. If not, the Load MIBs dialog prompts you to select the MIB file 
to load.

• Unload MIBs unloads the MIB files that are currently loaded. You must 
unload the current MIB file when you change the device type during a 
polling session.

Note: The Load MIBs and Unload MIBS commands are enabled only 
if Data Viewer is configured to collect performance data on Simple 
Network Management Protocol (SNMP) devices, and when you select 
the SNMP device as the Device Type in the Polling Criteria area.

View menu
The View menu contains a list of data views. The view you select is displayed 
in the data panel area. You can only select one view at a time. When a view is 
selected, its menu option is disabled. The View menu contains the following 
commands:

• Spreadsheet View sets the data displayed in the data panel area to 
Spreadsheet View. 

• Record View sets the data displayed in the data panel area to Record 
View. 

• Component View sets the data displayed in the data panel area to 
Component View.
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• Latest Poll View sets the data displayed in the data panel area to Latest 
Poll View.

Note: The views are described in the section, “Data panel area” 
(page 37).

Help menu
The Help menu contains the following commands:

• Help On Context contains help information on a specific object in the 
window. When you select this command, the cursor changes to a question 
mark. You can then place it anywhere on the window, click and online 
help is displayed.

• Help On Window provides descriptive help information about a 
window.

• About Data Viewer shows you the release of Data Viewer.

Polling criteria area
The polling criteria area in the Data Viewer window lets you specify the 
device and associated component(s) for which to gather information, and the 
polling interval.

The polling criteria area contains three fields: 

• Device Type lets you specify the device type to monitor. 
When there is only one device type in the list, this device is selected 
automatically when Data Viewer starts in Real-time mode, or when 
switched from Replay mode to Real-time mode.

• Device Name consists of a list of device names when you select the 
device type. You can enter the device name or select an item from the 
menu. If the device type for Passport is selected, the Authenticate dialog 
then prompts you for the group, username and password. See 
“Authenticate dialog” (page 30).
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• Component lets you specify the component(s) to monitor. The 
Component field contains a list of the component types that are defined 
in the metric file for a Passport family. You can select one or more 
components to monitor. 

To select a component, you can click an item in the list or type the 
component name in the Component Name field. If there are multiple 
instances of a component, a forward slash appears after the component 
name. In this case, you must enter the instance of the component you 
want to monitor. The instance must appear immediately after the forward 
slash.

To select multiple components, you can enter one of the following after 
the forward slash: 

— the wild-card “*” to poll all instances of the component

— if the component instances are sequential, the first and last number 
in the range, separated by dots (for example, to select instances 2, 3, 
4, and 5, type SHELF CARD/0..5)

— the number of each component instance to be polled. Use a semi-
colon to separate each component instance from the next (for 
example, SHELF CARD/2;4;5).

For guidelines on selecting multiple components, see “Collecting 
performance information for multiple components for SNMP devices” 
(page 63).

Multiple component instances are only allowed for the lowest component 
type (for example, LP/* E1/1...10 and LP/* E1/1;5;7 are not supported)

• Max Components lets you specify the maximum number of components 
to monitor. The default value for this field is 100. Network traffic is 
impacted if the maximum component number is too large. You must 
enter a number in this field when you select multiple components using 
either the wildcard (*) or a range of component numbers. 

No Max Component value is necessary if you select a single component 
instance, or multiple component instance with a semi colon as the 
separator. If the Max Component value is specified, it will not have any 
impact on the number of components returned. 
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• Polling interval (Secs) lets you specify the polling interval (in seconds) 
for data collection. The polling interval has a range of 10 seconds to 600 
seconds for Simple Network Management Protocol (SNMP) devices. 
The default value is 60 seconds. For Passport devices, the polling interval 
has a range of 30 seconds to 600 seconds. The default is 60 seconds. If 
the polling interval is not within the range, the Information dialog opens 
and displays the acceptable range.

Note: The polling interval is a target value; depending on network speed, 
some data collection may take longer. The polling interval also impacts 
the traffic of the network. A small polling interval can flood the network 
with too much traffic and impact network performance. The Passport 
polling interval of less than 30 seconds is not recommended. 

Follow the recommendation below when deciding what polling interval 
to use and how many attributes to poll to facilitate optimum network 
performance:

— number of metrics X number of components / polling interval in 
seconds < 1.7 

• Number of Polls lets you specify the number of polls to execute during 
the polling session. If you enter a number in the Count field, polling 
stops when this number is reached. If you do not enter a value, polling 
continues until you exit the tool, pause or stop the polling, or start 
monitoring another component.

Metric selection area
The Metric Selection area in the Data Viewer window lets you specify the 
metrics to poll. This area contains the following fields and buttons:

• Available Metrics lists the metrics that are defined for the component 
but are not selected for polling. You can select any or all of the metrics 
from this list for polling. You can also right-click a metric to display a 
description of the metric.

• Selected Metrics lists the metrics that are selected for polling. You can 
remove any metric from this list by clicking the metric name, and then 
clicking the left arrow. You can also right-click a metric to display a 
description of the metric.
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• Select All lets you select all the available metrics to be polled. This 
option is grayed out if there are no metrics in the Available Metrics 
section.You can click Select All when you select one or more metrics. 
The metrics are moved from the Available Metrics list to the Selected 
Metrics list. 

• Select lets you select a specific metric to be polled. This option is grayed 
out if no metrics are selected in the Available Metrics section. You can 
click Select when you select one or more metrics. The metric is moved 
from the Available Metrics list to the Selected Metrics list. 

• Remove lets you remove a specific metric to be polled. The Remove 
option is grayed out if no metrics are selected from the Available 
Metrics section. You can click Remove when you select one or more 
metrics. The metric is moved from the Selected Metrics list to the 
Available Metrics list. 

• Remove All lets you remove all metrics to be polled. This option is 
grayed out if there are no metrics in the Selected Metrics section. You 
can click Remove All when you select one or more metrics. The metrics 
are moved from the Selected Metrics list to the Available Metrics list.

Note: Use Shift + click to select a block of metrics. Use Ctrl + click to 
select more than one metric.

Command buttons
The command buttons in the Data Viewer window let you control the polling 
session. The following buttons are available:

• Start applies the settings in the polling criteria and metric selection areas 
and launches a new polling session. All statistical data from previous 
polling sessions are discarded. 

• Pause suspends the current polling session. Statistical data collected to 
this point remain in the data panel area.

• Continue resumes the polling session. All subsequent statistical data are 
added to the data panel area. When polling is resumed after a pause, all 
metric values will be reset to null for the first poll after resuming. The 
null value makes a break point on the graph to make a pause and resume 
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more visible. In the data record file, the null values appear as empty 
between the delimiter. All baseline values are reset to the value collected 
from the first poll taken after you click Continue.

• Stop ends the polling for the current settings. If you wish to restart 
polling using the same settings, click Start.

• Reset Baseline resets the value of all baseline delta metrics. No other 
metric will be affected by this reset and all previous data (gathered before 
the reset) will be maintained and can be viewed and saved. This button is 
only enabled when baseline delta metrics are being measured during 
active polling.

Status line 
The status line appears at the bottom of the Data Viewer window. The status 
line displays messages about the connection process. For example, the 
message “Waiting for server response” is displayed during a connection 
attempt to a component. 

When the connection is made, the status line shows the device type and name, 
and the name of the component that is selected. 

Graph button
When you click the Graph button, the Graph window opens. See “Graph 
window” (page 46).

The Graph button is enabled for all views in real time mode. It is enabled for 
some files in replay mode in any of the four views. These files include DV 
collected record (CSV), Management Data Provider (MDP) collected 
statistics, Statistics Retrieval System (SRS) and Streamed Passport Statistics 
(PMSP) files. 

Authenticate dialog
The Authenticate dialog provides userid and password authentication to a 
Passport device. The dialog opens when you enter the Passport device name 
or select an item from the menu of the Data Viewer window in real-time 
mode. The dialog contains the following fields:

• Group contains a menu of all Passport groups. You can select an item 
from the menu.
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• Userid contains the userid to authenticate

• Password contains the password to authenticate

The Authenticate dialog contains the following command buttons:

• OK begins the authentication process. The Authenticate dialog closes 
when the authentication succeeds. If the authentication fails, another 
dialog describing the problem opens.

• Cancel closes the Authenticate dialog. All information in the dialog is 
ignored.

See the figure “Authenticate dialog” (page 30).

Figure 3
Authenticate dialog

Working with Data Viewer Saved Statistics files
The Data Viewer lets you write the information it collects in real-time mode 
to a Data Viewer Saved Statistics file and save it for future reference. The 
Data Viewer Saved Statistics file is updated as new data is received. 

The Data Viewer Saved Statistics file is saved in your home directory, unless 
you specify an alternate path. If you wish you can change the default directory 
by double clicking on a directory name. 

The information of a Data Viewer Saved Statistics file matches the 
information you entered in the polling criteria and metric selection areas of 
the Data Viewer window. 
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The figure “Data Viewer Saved Statistics file” (page 32), shows an example 
of this file.

Figure 4
Data Viewer Saved Statistics file

Applicable to replay mode
Note: This section applies to replay time mode. See the following 
sections: “Applicable to real time mode” (page 20), and “Applicable to 
real-time and replay modes” (page 37).

In replay mode, you can view collected data from

• Performance Measurement Stream Processor (PMSP)

• Management Data Provider (MDP)

• Statistical Retrieval System (SRS)

• Data Viewer 

Note: This document does not contain information on PMSP, MDP or 
SRS. See 241-6001-309 Preside MDM Management Data Provider User 
Guide.

This section contains the following information on replay mode:

• “Data Viewer window for replay mode” (page 33)
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Data Viewer window for replay mode
The Data Viewer window for replay mode is described in this section. Replay 
mode lets you replay data collected by Management Data Provider (MDP), 
Statistical Retrieval System (SRS), Performance Management Stream 
Processor (PMSP, and Data Viewer. Data is viewed in bulk data format (BDF) 
or comma separated value (CSV) format. 

This section contains the following sections:

• “Menu bar” (page 34)

• “File retrieval criteria area” (page 36) 

• “Files selected area” (page 37)

The figure, “Data Viewer window - Replay mode in spreadsheet view” 
(page 34), show a sample display of the Data Viewer default window.

A splitter bar between the metric selection area and the data panel area divides 
the Data Viewer window into two adjustable window panes. You can adjust 
the window panes to hide or show each area or to have one area fill the entire 
Data Viewer display. To change the relative size of each window pane, click 
and drag the mouse over one of the window pane movement arrows.
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Figure 5
Data Viewer window - Replay mode in spreadsheet view

Menu bar
The menu bar commands let you to use the Data Viewer and view its 
performance information. The menu bar contains the following menus:

• File menu

• Options menu

file 
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area

files 
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menu bar
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• View menu

• Help menu

File menu
The File menu contains the following command:

• Exit terminates the polling or file retrieval session and closes all Data 
Viewer windows. 

Options menu 
The Options menu contains the following commands: 

• Real-Time Mode sets the collection mode to real time. When this option 
is selected, Real-Time Mode is disabled.

• Select RDF displays a dialog to select an RDF file. The specified RDF 
file is used to view the selected Bulk Data Format (BDF) files in replay 
mode.

• Unselect RDF clears the selected RDF file when this menu item is 
selected.

View menu
The View menu contains a list of data views. The view you select is displayed 
in the data panel area. You can only select one view at a time. When a view is 
selected, its menu option is disabled. The View menu contains the following 
commands:

• Spreadsheet View sets the data displayed in the data panel area to 
Spreadsheet View. 

• Record View sets the data displayed in the data panel area to Record 
View. 

• Component View sets the data displayed in the data panel area to 
Component View.
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Help menu
The Help menu contains the following commands:

• Help on Context contains help information on a specific object in the 
window. When you select this command, the cursor changes to a question 
mark. You can then place it anywhere on the window, click and online 
help is displayed.

• Help on Window provides descriptive help information about a window.

File retrieval criteria area
The file retrieval criteria area lets you select files that you want to replay. The 
file retrieval criteria area consists of the following input areas:

• Data Type is a pull-down list of the following data types: Accounting, 
Alarm, All, Availability, Data Viewer Saved Statistics, Log, Outage, 
SRS, Scn, Statistics, Streamed Passport Statistics. The default is All 
for all data types.

• Device Type is a pull-down list of the following device types: All, DPN, 
Others, Passport. Selecting Device Type lets you filter on specific 
device types. The default is All for all device types.

• Device Name lets you type in a device name to filter on. This field 
matches the following field of filename field depending on the selected 
data type:

— specify <nodename | nodeid> for Accounting, Alarm, Scn, Log, 
Statistics and Outage data types

— device name has no impact on Availability type

— specify <nodename> for SRS and Data Viewer Saved Statistics data 
types

— specify <Passport-groupname> in Streamed Passport statistics data 
type

• Start Date lets you specify a range of the start date (yyyy/mm/dd) and 
time (hh:mm:ss) of the filename to be filtered. Any files with the start 
date and time larger than the Start Date are selected.

• End Date lets you specify a range of the end date (yyyy/mm/dd) and 
time (hh:mm:ss) of the filename to be filtered. Any files with the end date 
and time smaller than the End Date are selected.
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• Retrieve Files opens the File Selection dialog that contains a tree 
representation of the available directions and files of the selected type 
from which you can navigate the file system to locate files of the selected 
data type.

Files selected area
The files selected area displays a listing of the files that you retrieved. The 
files are displayed in tabular format. You can click and drag a column heading 
to reorder the columns.

This area consists of the following input areas:

• File Names displays the name of the files selected for possible 
viewing.

• Path displays the directory location of the selected BDF files.

• File Size in Bytes displays the size of each selected BDF file.

• Remove Selected removes the selected file from the Files Selected area.

• Remove All removes all files from the Files Selected area.

• View lets you view the selected files in the specified view.

Applicable to real-time and replay modes
This section contains information that applies to both real-time mode and 
replay mode. See the following information:

• “Data panel area” (page 37)

• “Graph window” (page 46)

Data panel area
The data panel area in the Data Viewer window in real-time mode displays 
the metric values collected during the current polling session, and the 
retrieved data files in replay mode. 

In real-time mode, the maximum number of records that may be collected in 
real time is 50,000/(number of metrics polled + 2). When this number is 
reached, the oldest set of data records is discarded and replaced by the latest 
set of data records received. 
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The data appear in red if the values exceed the thresholds defined in the metric 
file for the component.

The data panel area displays one of the following views:

• spreadsheet

• record

• component

• latest poll

The information displayed in the views is displayed in the following columns:

1 Record # contains the record number. This column is visible in 
spreadsheet view and record view. 

2 Index/Component is visible in real-time mode. The Index/Component 
column contains either the Passport name or the Simple Network 
Management Protocol (SNMP) device indexID of the component(s), and 
the component that you are monitoring. 

Note: The Index/Component is visible in the spreadsheet, record and 
latest poll view in real-time mode. In component view, the component is 
shown in a tree diagram.

File name is visible in replay mode. This column contains the location 
and the name of the file.

3 Time is visible in real-time mode. This column contains the time the 
metrics were received.

4 The remaining columns contain metric values or data from replayed files.

Spreadsheet view
The spreadsheet view displays the data values in spreadsheet tabular format. 
Spreadsheet view supports real-time mode and replay mode. Spreadsheet 
view is the default view in replay mode if the data type is Accounting, 
Alarm, SCN, Log or Outage.
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Spreadsheet view uses a record description file (RDF) to label each column if 
the data is in bulk data format (BDF).The data in the first row of a comma 
separated value (CSV) file is used to label each column if the data is in CSV 
format. 

When you select a row, and then click Graph, you can view the detailed 
statistics table and the summary table. You can display summary or detailed 
statistics by selecting a tab.

Note: The field names are described in “Data panel area” (page 37).

See the following figures:

• “Real-time - Spreadsheet view” (page 40) shows the Data Viewer 
window in real-time mode and spreadsheet view.

• “Replay - Spreadsheet view” (page 41) shows the Data Viewer window 
in replay mode and spreadsheet view.
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Figure 6
Real-time - Spreadsheet view
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Figure 7
Replay - Spreadsheet view

Record view
The record view supports all device types in real-time mode and all data types 
in replay mode.The record view shows the field name and the field value. 
Selecting the record number displays the content of the record at the right.

When you select a record number, and then click Graph, you can view the 
detailed statistics table and the summary table of the component instance 
specified in the selected record. You can display summary or detailed 
statistics by selecting a tab.

Note: The field names are described in “Data panel area” (page 37).

data 
panel 
area
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See the following figures:

• “Real-time - Record view” (page 42) shows the Data Viewer window in 
real-time mode and record view. 

• “Replay - Record view” (page 43) shows the Data Viewer window in 
replay mode and record view.

Figure 8
Real-time - Record view

data 
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Figure 9
Replay - Record view

Component view
The component view supports all device types in real-time mode. In replay 
mode, the component view supports the data types: SRS, Streamed Passport 
Statistics, Data Viewer Saved Statistics, and Management Data Provider 
statistics. 

The panel displays the components and subcomponents in the data collected 
in real-time collection mode or the selected files in replay mode. The 
component information is displayed in a tree format. Select a component in 
the component tree to view the records associated with the component in 
detail and summary tables. When you click Graph, you can view the Graph 
window associated with the selected component. You can display summary 
or detailed statistics by selecting a tab.

data 
panel 
area
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Note: The field names are described in “Data panel area” (page 37).

See the following figures:

• “Real-time - Component view” (page 44)

• “Replay - Component view” (page 45) 

Figure 10
Real-time - Component view
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Figure 11
Replay - Component view

Latest poll view
The latest poll view supports real-time mode only. The latest poll view is the 
default view for real-time collection mode. Latest Poll View displays the 
metric values from the latest poll during the current polling session. Each row 
of data in the latest poll view applies to a different component instance. When 
you select a row, and then click Graph, you can view detailed statistics table 
and the summary table. You can display summary or detailed statistics by 
selecting a tab.

Note: The field names are described in “Data panel area” (page 37).

The figure “Real-time - Latest poll view” (page 46) shows the Data Viewer 
window in real-time mode and latest poll view. 

data 
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Figure 12
Real-time - Latest poll view

Graph window
The Graph window opens when you select a row or a component in the data 
panel, and click Graph. Depending on whether the Data Viewer is operating 
in real time mode or replay mode, and the file type replayed, the Graph 
button is enabled to allow viewing the data in a graphical display.
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The Graph window provides summary and detailed performance 
information for the selected component, when you select the Detail or 
Summary tab. The information is available in both textual and graphical 
formats.

Metric field values for a particular component are displayed in graphical 
format. Only the metric fields you select appear in the graph. The line 
displayed in the graph for each metric field matches the color you selected in 
the graph selection table.

Three types of graphs are available: thumbnail, multi graphs, and trend 
graphs. You can select a graph type by clicking the appropriate tab in the 
graph area. Different metric fields are displayed on the graphs with different 
colors. The color of the line representing the metric in the graph is determined 
by the color of the metric defined in the graph selection table.

You can launch multiple Graph windows, one for each component in the 
statistics shown in the data panel area.

The Graph window contains summary and detailed statistics tables. 
Selecting the Detail or Summary tab displays the appropriate table.

See the figures “Graph window: Summary panel” (page 48) and “Graph 
window: Detail panel” (page 49) for sample displays.

The Graph window contains the following areas: 

• “Title bar” (page 50)

• “Menu bar” (page 50)

• “Statistics tables” (page 50)

• “Graph area” (page 52)

• “Graph selection table” (page 56)

A splitter bar separates the summary or detail statistics display into two 
adjustable window panes. Clicking the mouse on one of the arrows in the 
splitter bar lets you configure the size of the window panes. You can adjust 
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the window panes to hide or show each area or to have one area fill the entire 
Data Viewer display. Another splitter bar separates the graph and graph 
selection table.

Figure 13
Graph window: Summary panel
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Figure 14
Graph window: Detail panel
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Title bar
The title bar in the Graph window identifies the component to which the data 
applies. The title bar displays the full component name, including the device 
type and name.

Menu bar
The menu bar in the Graph window contains the following menus:

• “File menu” (page 50)

• “Options menu” (page 50)

• “Help menu” (page 50)

File menu
The File menu in the Graph window contains the following commands:

• Close closes the Graph window.

Options menu
The Options menu in the Graph window contains the following commands:

• Line changes thumbnail, multi graphs, and trend graphs to line graphs

• Bar changes thumbnail, multi graphs and trend graphs to bar 
graphs

Help menu
The Help menu in the Graph window contains the following commands:

• Help On Context contains help information on a specific object in the 
window. When you select this command, the cursor changes to a question 
mark. You can then place it anywhere on the window, click and online 
help is displayed.

• Help On Window provides descriptive help information about a 
window.

Statistics tables
The statistics table appears in the upper half of the Graph window. The table 
displays the values for each record in the record file. The table displays metric 
values for each of the metrics polled for a particular component. New data is 
added to the statistics tables as it is received. The data appear in red if the 
241-6001-031   14.3RSUP   



Chapter 2 Data Viewer   51
values exceed the thresholds defined in the metric file for the component. You 
can display summary statistics or detailed statistics by selecting the 
appropriate tab.

Summary statistics
Numeric type values are displayed in the summary statistics table. Summary 
statistics are available when you select the Summary tab. The Summary tab 
contains the following information:

• Field contains the names of the metrics.

• Minimum contains the minimum value of the statistic data collected for 
each of the metrics.

• Maximum contains the maximum value of the statistic data collected for 
each of the metrics.

• Average contains the average value of the statistic data collected for each 
of the metrics.

Detailed statistics
Numeric and string type values are displayed in the detailed statistics table. 

Detailed statistics are available when you select the Detail tab. The detailed 
statistics table provides statistic data (numeric type or string) collected for 
each of the metrics polled for a particular component. 

The detailed statistics table contains

• a record received for the component at different polling intervals (real-
time mode)

• a record in a file associated with the selected component (replay mode)

• the name of each field that is being is displayed in each column. You can 
change the order of the columns by dragging each header to its new 
location. 

Note: The number of Graph windows opened and the number of graphs 
running also impacts the memory usage.
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Graph area
The graph area appears in the lower half of the Graph window. The graph 
area displays metric field values for a particular component in graphical 
format. Only the metric fields you select appear in the graph. The line 
displayed in the graph for each metric field matches the color you selected in 
the graph selection table. 

Three types of graphs are available: thumbnail, multi graphs, and trend 
graphs. You can select a graph type by clicking the appropriate tab in the 
graph area. From the Options menu, you can change thumbnail, multi graphs 
and trend graphs to a line graph or a bar graph by selecting the Line or Bar 
command. Different metrics are displayed on the graphs with different colors. 
The color of the line representing the metric in the graph is determined by the 
color of the metric defined in the graph selection table.

New data is added to the graph as it arrives in real-time mode.

See the figures “Graph window showing thumbnail graphs” (page 53), 
“Graph window showing multi graphs” (page 54), and “Graph window 
showing trend graphs” (page 55).
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Figure 15
Graph window showing thumbnail graphs

The multi graph shows an absolute graph. The X axis shows the time value. 
If there is not enough space, not all the time values are displayed in the trend 
and multi graph panels. Use the horizontal scroll bar to view the other time 
values. The Y axis shows the field value. 
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Figure 16
Graph window showing multi graphs

The trend graph is a percentage relative scale with the Y axis showing the 
field value relative to the maximum. The comparison is with the instance field 
value to the maximum value on this field that has occurred during the time 
captured in the trend graph. The X axis shows the time stamps when the field 
values are polled
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Figure 17
Graph window showing trend graphs
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Graph selection table
Only statistics metrics with numeric type are displayed in the graph selection 
table. The graph selection table contains the following columns:

• Graph contains a list of checkboxes that you can use to select metric 
fields for graphical display. Only the metric fields that you select in this 
table appear in the graph. The checkboxes can reduce or filter the metric 
fields to be shown on the graphs. For more information on the graphical 
display, see “Graph area” (page 52).

• Color contains the color of the graph associated with a metric fields. A 
default color is assigned to each metric. You can change the color by 
clicking in the “Color” column for the metric. This launches the “Pick a 
Color” window which lets you select a new color.

• Field contains the name of the metric fields.
241-6001-031   14.3RSUP   



57
Chapter 3
Data Viewer procedures

This section contains the following Data Viewer procedures:

• “Procedures for real-time mode” (page 57)

• “Procedures for replay mode” (page 94)

• “Procedures for real-time and replay modes” (page 106)

Procedures for real-time mode
This section contains the following procedures that you need to use the Data 
Viewer in real-time mode.

Getting started
• “Starting the Data Viewer from the Preside MDM window in real-time 

mode” (page 58)

• “Starting the Data Viewer in real-time mode from within another fault 
management tool” (page 59)

Collecting performance information
• “Collecting performance information for a single component instance for 

SNMP devices” (page 59)

• “Collecting performance information for multiple components for 
SNMP devices” (page 63)

• “Collecting performance information for a single component instance for 
Passport devices” (page 68)
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• “Collecting performance information for multiple components for 
Passport devices” (page 72)

Controlling the display of performance information
• “Controlling data collection” (page 77)

Data recording
• “Replaying data files on a remote workstation” (page 98)

• “Viewing a Data Viewer Saved Statistics file” (page 80)

• “Stopping data recording” (page 81)

Integrating SNMP devices
• “Creating a new metric file for SNMP devices” (page 83)

• “Updating the Data Viewer agent map file” (page 86)

• “Updating the PMDCD configuration file” (page 87)

• “Updating the Data Viewer client configuration file” (page 88)

Integrating Passport devices
• “Creating a new metric file for Passport devices” (page 89)

• “Updating the Data Viewer agent map file” (page 86)

Updating metric files
• “Updating an existing metric file for SNMP and Passport devices” 

(page 93)

Updating Data Viewer files
• “Updating the Data Viewer agent map file” (page 92)

• “Updating the PMDCD configuration file” (page 87)

• “Updating the Data Viewer client configuration file” (page 88)

Starting the Data Viewer from the Preside MDM window in 
real-time mode

You can analyze performance data in real-time when you use this mode.

Procedure steps
1 In the Preside MDM window, select Performance -> Data Viewer.
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The Data Viewer window opens. The default is real-time mode and latest 
poll view.

Starting the Data Viewer in real-time mode from within 
another fault management tool

You can start the Data Viewer from the following fault management tools:

• Network Viewer

• Component Information Viewer

• Component Status Display

• Network Status Bar

• Alarm Display

• Circuit Viewer

Procedure steps
1 From a fault management tool, open the Start Tools menu. For details, 

refer to the tool’s documentation. 

A pop-up menu opens.

2 From the pop-up menu, select Performance -> Data Viewer.

The DataViewer window opens. 

Collecting performance information for a single component 
instance for SNMP devices 

If you start the DataViewer from within another fault management tool by 
clicking an object, the device type and name, and the component name for the 
object, are displayed in the Data Viewer window at start-up. In this case, 
begin at step 4 of this procedure. 

Otherwise, begin at step 1.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 In the Device Type field of the Data Viewer window, select the SNMP 

device type from the pull-down list.
Preside MDM Performance Management  User Guide   14.3RSUP



60   Chapter 3 Data Viewer procedures
The SNMP device type is extracted from the Data Viewer agent map 
(pmrtype.map) file when you integrate an SNMP device into Data Viewer.

2 In the Device Name field, enter the device name.

A list of device names associated with the device appears in the Device 
Name field of the Data Viewer window. You can also click the down arrow 
in the Device Type field to scroll through the device names.

3 Specify the component to monitor. 

a. Do one of the following:

Click the down arrow at the right of the Component field to scroll to 
the component name.

Type the component name in the Component field.

The fully defined component name appears in the Component field. 
There can be multiple component levels in the fully defined 
component name, for example, CA/1 SH/1 BRM/5 

A forward slash after a component name indicates that there are 
multiple instances of that component. You must specify the instance 
for each of these components. 

b. If a forward slash appears after a component name, type the number 
of the component after the slash. 

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

c. Press Enter.

The message area at the bottom of the Data Viewer window displays 
status information on device and component connection. When 
connection is successful, a message in the status line indicates that 
the metric list was received. 

The metrics that are available for the component appear in the 
Available Metrics list. You can add new metrics for the component, 
if required. For information on adding metrics see “Applicable to 
replay mode” (page 32).

4 Enter the number of seconds for gathering data in the Polling interval 
(Secs) field. 

The polling interval default setting is 60 seconds. You can choose an 
interval between 30 and 600 seconds (10 minutes).
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5 If you wish to limit the number of times data is collected for this 
component, type a number in the Number of Polls field. 

Polling stops when the number of polls reaches the Number of Polls 
value. 

If you do not enter a number in this field, data collection continues until 
you click Pause or Stop, or select File -> Exit from the Data Viewer.

6 In the Available Metrics list, select the metrics to poll:

a. Click the metric name in the Available Metrics list.

b. Click Select to move the selected metric to the Selected Metrics list. 

You can click Remove to remove metrics from the Selected Metrics 
list.

Note: For a metric description, select the metric, and then right-click 
to display Help. A dialog displays the selected metric’s description.

7 Click Start to begin data collection.

8 If the metrics for the selected component requires the index from a MIB 
table column, the Index Selection dialog opens. Select the index for the 
component from the dialog.

Incoming data appears in the data panel area in the lower half of the Data 
Viewer window. A delay equal to the number of seconds in the polling 
interval can occur before data starts arriving.

You can change the order of the columns in the data panel area and sort 
the values for each metric in ascending order. See “Rearranging data 
display” (page 108).

From the View menu, you can change the view.

You can view detailed performance information about each component 
you are monitoring. See “Viewing summary and detailed performance 
information” (page 109).

CAUTION:
Selecting a low polling interval can flood the network and 
affect its performance.
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This sample screen displays information about a single component instance. 
The Data Viewer used a polling interval of 30 seconds.
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Collecting performance information for multiple components 
for SNMP devices

A forward slash after a component name in the Component field indicates 
that there are multiple instances of that component. To select multiple 
component instances to monitor, enter one of the following after the forward 
slash: 

• Type the wild-card “*” to poll all instances of the component. These 
restrictions apply to the use of the wildcard:

— If the attributes for a component are defined in multiple MIB tables, 
use the wildcard only if the MIB tables have the same index 
structure.

— A component can have a different IP address than the device type it 
is associated with. In this case, you cannot select multiple instances 
of the component. 

• If the component instances are sequential, type the first and last numbers 
in the range, separated by dots (for example, to select instances 2, 3, 4, 
and 5, type DIM_TI PO/2..5). 

If the attributes for a component are defined in multiple MIB tables, use 
this option only if the MIB tables have the same index structure.

Use the wildcard only for the lowest component type in the component 
name. For example, DIM_TI PO/*

• Type the number of each component instance to be polled. Use a semi-
colon to separate each component instance from the next (for example, 
DIM_TI PO/2;4;5).

Use the wildcard only for the lowest component type in the component 
name. For example, DIM_TI PO/*

The following procedure explains how to collect performance information for 
multiple components. If you start the Data Viewer from within another fault 
management tool by clicking an object, the device type and name, and the 
component name for the object, appear in the Data Viewer window at start-
up. In this case, begin at step 4 of this procedure. 
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Otherwise, begin at step 1.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 In the Device Type field of the Data Viewer window, select the SNMP 

device type from the pull-down list.

The SNMP device type is extracted from the Data Viewer agent map 
(pmrtype.map) file when you integrate an SNMP device into Data Viewer.

2 In the Device Name field, enter the device name.

A list of device names associated with the device appears in the Device 
Name field of the Data Viewer window. You can also click the down arrow 
in the Device Type field to scroll through the device names.

3 Select the components to monitor.

a. Do one of the following:

Click the down arrow at the right of the Component field to scroll to 
the component name.

Type the component name in the Component field.

The fully defined component name appears in the Component field. 
There can be multiple component levels in the fully defined 
component name, for example, DIM_TI PO/1;3.

A forward slash after a component name indicates that there are 
multiple instances of that component. You must specify the instance 
for each of these components. 

b. If a forward slash appears after a component name, type the number 
of the component after the slash. 

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

c. Specify the multiple component instances to monitor by entering their 
values after the lowest level component in the Component field.

For guidelines on entering multiple component numbers see 
“Collecting performance information for multiple components for 
SNMP devices” (page 63).
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d. Press Enter.

The message area at the bottom of the Data Viewer window displays 
status information on device and component connection. When 
connection is successful, a message in the status line indicates that 
the metric list was received.

4 In the Max Components field, enter the maximum number of 
components to monitor. You must enter a number in this field if you 
entered the wildcard (*) or a range of sequential component numbers in 
the Component field.

The metrics that are available for the selected components appear in the 
Available Metrics list. You can add new metrics for the components if 
required. For information on adding metrics see “Applicable to replay 
mode” (page 32).

5 Enter the number of seconds for gathering data. 

The polling interval has a 60-second default setting. You can choose an 
interval between 30 and 600 seconds (10 minutes).

6 In the Number of Polls field, type a number if you wish to limit the number 
of times data is collected. 

Polling stops when the number of polls reaches the Number of Polls 
value. 

If you do not enter a number in this field, data collection continues until 
you click Pause or Stop, or select File -> Exit from the Data Viewer.

7 In the Available Metrics list, select the metrics to poll:

a. Click a metric name in the Available Metrics list.

b. Click Select to move the selected metric to the Selected Metrics list. 

You can click Remove to remove metrics from the Selected Metrics 
list. 

Note: For a metric description, select the metric, and then right-click 
to display Help. A dialog displays the selected metric’s description.

CAUTION:
Selecting a low polling interval can flood the network and 
affect its performance.
Preside MDM Performance Management  User Guide   14.3RSUP



66   Chapter 3 Data Viewer procedures
8 Click Start to begin data collection.

9 If the metrics for the selected components require the index from a MIB 
table column, the Index Selection dialog opens. Select the index for the 
component from the dialog.

Incoming data appears in the data panel area in the lower half of the Data 
Viewer window. A delay equal to the number of seconds in the polling 
interval can occur before data starts arriving.

You can change the order of the columns in the data panel area and sort 
the values for each metric in ascending order. See “Rearranging data 
display” (page 108).

From the View menu, you can change the view.

You can view detailed performance information about each component 
you are monitoring. See “Viewing summary and detailed performance 
information” (page 109).
241-6001-031   14.3RSUP   



Chapter 3 Data Viewer procedures   67
This sample screen displays information about multiple components. The 
Data Viewer used a polling interval of 30 seconds.
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Collecting performance information for a single component 
instance for Passport devices

If you start the Data Viewer from within another fault management tool by 
clicking an object, the device type and name, and the component name for the 
object, appear in the Data Viewer window at start-up. In this case, begin at 
step 4 of this procedure. 

Otherwise, begin at step 1.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 In the Device Type field of the Data Viewer window, select the device 

type EM from the pull-down list.

2 In the Device Name field, enter the device name. A list of Passport device 
names appears in the Device Name field. You can also click the down 
arrow of the Device Type field to scroll to the device name.

The Authenticate dialog opens.

3 Use the arrow to select the following information: 

• Group

• Userid

• Password

4 Click OK.

A list of device names associated with the device appears in the 
Component field of the Data Viewer window. 

Note:  If the authentication fails, repeat step 2.

5 Specify the component to monitor. 
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a. Do one of the following:

Click the down arrow at the right of the Component field to scroll to 
the component name.

Type the component name in the Component field.

The fully defined component name appears in the Component field. 
There can be multiple component levels in the fully defined 
component name, for example, CA/1 SH/1 BRM/5 

A forward slash after a component name indicates that there are 
multiple instances of that component. You must specify the instance 
for each of these components. 

b. If a forward slash appears after a component name, type the number 
of the component after the slash. 

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

c. Press Enter.

The message area at the bottom of the Data Viewer window displays 
status information on device and component connection. When 
connection is successful, a message in the status line indicates that 
the metric list was received. 

The metrics that are available for the component appear in the 
Available Metrics list. You can add new metrics for the component, 
if required. For information on adding metrics see “Applicable to 
replay mode” (page 32).

6 Enter the number of seconds for gathering data in the Interval (Secs) 
field. 

The polling interval default setting is 60 seconds. You can choose an 
interval between 10 and 600 seconds (10 minutes).

7 If you wish to limit the number of times data is collected for this 
component, type a number in the Number of Polls field. 

CAUTION:
Selecting a low polling interval can flood the network and 
affect its performance.
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Polling stops when the number of polls reaches the Number of Polls 
value. 

If you do not enter a number in this field, data collection continues until 
you click Pause or Stop, or select File -> Exit from the Data Viewer.

8 In the Available Metrics list, select the metrics to poll:

a. Click the metric name in the Available Metrics list.

b. Click Select to move the selected metric to the Selected Metrics list. 

You can click Remove to remove metrics from the Selected Metrics 
list.

Note: For a metric description, select the metric, and then right-click 
to display Help. A dialog displays the selected metric’s description.

9 Click Start to begin data collection.

Incoming data appears in the data panel area in the lower half of the Data 
Viewer window. A delay equal to the number of seconds in the polling 
interval can occur before data starts arriving.

You can change the order of the columns in the data panel area and sort 
the values for each metric in ascending order. See “Rearranging data 
display” (page 108).

From the View menu, you can change the view.

You can view detailed performance information about each component 
you are monitoring. See “Viewing summary and detailed performance 
information” (page 109).
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This sample screen displays information about a single component instance. 
The Data Viewer used a polling interval of 60 seconds.
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Collecting performance information for multiple components 
for Passport devices

A forward slash after a component name in the Component field indicates that 
there are multiple instances of that component. To select multiple component 
instances to monitor, enter one of the following after the forward slash: 

• Type the wild-card “*” to poll all instances of the component. These 
restrictions apply to the use of the wildcard.

For Passport, you can use the wildcard character, “*”, at the end of the 
component name to select multiple components. For example, EM/
NODE47 SHELF CARD/* displays all cards on the shelf. Enter “*” 
when you want a multiple component display, since context supplies only 
single component names. If your Passport version supports it, you can 
also use component administration system (CAS) extended wildcarding. 
Substitute a wildcard character for a subcomponent within a component 
name. For example, EM/NODE47 FRUNI/* FRAMER displays 
information on all available FrameRelay UNI Framers. 

Note: Do not target too many components using extended wildcarding 
since this negatively impacts the performance of both the Passport node 
and the workstation.

• If the component instances are sequential, type the first and last numbers 
in the range, separated by dots (for example, to select instances 2, 3, 4, 
and 5, type EM/MUNICH SHELF CARD/2..5). 

Use the wildcard only for the lowest component type in the component 
name. For example, EM/MUNICH SHELF CARD/*

• Type the number of each component instance to be polled. Use a semi-
colon to separate each component instance from the next (for example, 
EM/MUNICH CARD SHELF/2;4;5).

Use the wildcard only for the lowest component type in the component 
name. For example, EM/MUNICH SHELF CARD/*
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The following procedure explains how to collect performance information for 
multiple components. If you start the Data Viewer from within another fault 
management tool by clicking an object, the device type and name, and the 
component name for the object, appear in the Data Viewer window at start-
up. In this case, begin at step 4 of this procedure. 

Otherwise, begin at step 1.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 In the Device Type field of the Data Viewer window, select the device 

type EM from the pull-down list.

2 In the Device Name field, enter the device name. A list of Passport device 
names appears in the Device Name field. You can also click the down 
arrow of the Device Type field to scroll to the device name.

The Authenticate dialog opens.

3 Use the arrow to select the following information: 

• Group

• Userid

• Password

4 Click OK.

A list of device names associated with the device appears in the 
Component field of the Data Viewer window. 

Note:  If the authentication fails, repeat step 2.

A list of device names associated with the device appears in the 
Component field of the Data Viewer window. 
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5 Select the components to monitor.

Do one of the following:

Click the down arrow at the right of the Component field to scroll to 
the component name.

Type the component name in the Component field.

The fully defined component name appears in the Component field. 
There can be multiple component levels in the fully defined 
component name, for example, EM/MUNICH SHELF CARD/1;3.

A forward slash after a component name indicates that there are 
multiple instances of that component. You must specify the instance 
for each of these components. 

a. If a forward slash appears after a component name, type the number 
of the component after the slash. 

Pressing the right arrow on the keyboard moves the cursor to the next 
component that requires a component number. 

b. Specify the multiple component instances to monitor by entering their 
values after the lowest level component in the Component field.

For guidelines on entering multiple component numbers see 
“Collecting performance information for multiple components for 
Passport devices” (page 72).

c. Press Enter.

The message area at the bottom of the Data Viewer window displays 
status information on device and component connection. When 
connection is successful, a message in the status line indicates that 
the metric list was received.

6 In the Max Components field, enter the maximum number of 
components to monitor. You must enter a number in this field if you 
entered the wildcard (*) or a range of sequential component numbers in 
the Component field.

The metrics that are available for the selected components appear in the 
Available Metrics list. You can add new metrics for the components if 
required. For information on adding metrics see “Applicable to replay 
mode” (page 32).

7 Enter the number of seconds for gathering data. 

The polling interval default setting is 60 seconds. You can choose an 
interval between 10 and 600 seconds (10 minutes).
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8 In the Number of Polls field, type a number if you wish to limit the number 
of times data is collected. 

Polling stops when the number of polls reaches the Number of Polls value. 

If you do not enter a number in this field, data collection continues until 
you click Pause or Stop, or File -> Exit from Data Viewer.

9 In the Available Metrics list, select the metrics to poll:

a. Click a metric name in the Available Metrics list.

b. Click Select to move the selected metric to the Selected Metrics list. 

You can click Remove to remove metrics from the Selected Metrics 
list. 

Note: For a metric description, select the metric, and then right-click 
to display Help. A dialog displays the selected metric’s description.

10 Click Start to begin data collection.

Incoming data appears in the data panel area in the lower half of the Data 
Viewer window. A delay equal to the number of seconds in the polling 
interval can occur before data starts arriving.

You can change the order of the columns in the data panel area and sort 
the values for each metric in ascending order. See “Rearranging data 
display” (page 108).

You can change the view from the View menu.

You can view detailed performance information about each component 
you are monitoring. See “Viewing summary and detailed performance 
information” (page 109).

CAUTION:
Selecting a low polling interval can flood the network and 
affect its performance.
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This sample screen displays information about multiple components. The 
Data Viewer used a polling interval of 60 seconds.
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Controlling data collection
The metric selection area of the Data Viewer window contains buttons to 
control data collection.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
• To begin polling metrics for the specified component(s) using the current 

polling selections click Start.

• To suspend data collection click Pause.

• To resume data collection click Continue.

• To stop polling metrics for the specified component(s) using the current 
polling selections click Stop. If you wish to restart polling using the same 
settings, click Start.
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Writing component information to a Data Viewer Saved 
Statistics file

You can record data files, and then write the component information to a Data 
Viewer Saved Statistics file for future reference.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 From the File menu, select Start Recording.

The Data Recording Options dialog opens.

2 Select one of the following options:

• Record All Available Data saves the metric data that the Data 
Viewer collects during the next and subsequent polling intervals

• Record Starting Now saves all the data the Data Viewer has 
collected since start-up

3 Click OK.
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The Select Recording File dialog opens.

4 Select an existing file name or enter a new name for the Data Viewer 
Saved Statistics file. The Data Viewer tool provides the default file name.

5 If you enter a new file name, select Open.

The Data Viewer opens a Data Viewer Saved Statistics file with the name 
you enter and writes the performance information to it. The Data Viewer 
Saved Statistics file is updated as more information is received.

6 If you select an existing file name, a dialog opens. Select an option in the 
dialog:

• Select Continue to add a new performance information to the Data 
Viewer Saved Statistics file.

All information already in the file is retained.

• Select Cancel to select another file name or to create a new Data 
Viewer Saved Statistics file.

The Open dialog opens. You can enter the file name you want to open.

7 From the File menu select Stop Recording to stop logging.

Output to the Data Viewer Saved Statistics file stops and the file closes.
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Viewing a Data Viewer Saved Statistics file
After you save the component information to the Data Viewer Saved Statistics 
file, you can view it.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure steps
1 From the File menu, select View Recording.

The View File window opens. 

If a Data Viewer Saved Statistics file is open, the name of the open Data 
Viewer Saved Statistics file appears in the window. You can view this Data 
Viewer Saved Statistics file or change the file name to view a different 
Data Viewer Saved Statistics file. 

2 To view a different Data Viewer Saved Statistics file, from the File sub 
menu, select Load file. 

The Open dialog opens. 

3 Select a Data Viewer Saved Statistics file to view. 

The Data Viewer Saved Statistics file appears in the View File window. If 
you choose to view the current Data Viewer Saved Statistics file, new data 
will continue to be written to the file as they are received. 

4 To close the Data Viewer Saved Statistics file and the View File window, 
select File -> Exit.
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Stopping data recording
You can stop the recording of data after you have started.

Prerequisites
The Data Viewer must be in real-time mode.

Procedure
1 From the Data Viewer window, select File -> Stop Recording.
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Integrating an SNMP device type
To integrate a new Simple Network Management Network Protocol (SNMP) 
device to the Data Viewer, you need to do one of the following:

• edit an existing metric file

• create a new metric file and revise configuration files

To revise an existing metric file, see “Updating an existing metric file for 
SNMP and Passport devices” (page 93). To create a new metric file, use the 
following procedures:

• “Creating a new metric file for SNMP devices” (page 83)

• “Updating the Data Viewer agent map file” (page 92)

• “Updating the PMDCD configuration file” (page 87)

• “Updating the Data Viewer client configuration file” (page 88)
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Creating a new metric file for SNMP devices
Use the following procedure to create a new metric file for an SNMP device 
type. For details about the required elements and format of the metric file, see 
“Metric file format” (page 271).

Procedure steps
1 Log on as root.

2 Access the appropriate directory for creating a new metric file:

cd /opt/MagellanNMS/cfg/pmr

3 Using a UNIX editor, open a new file for editing. The subsequent steps in 
this procedure specify the required entries that you need to add to create 
a metric file. 

4 Define the beginning of the metric file:

<METRICFILE>

5 Define a component:

<COMPONENT NAME = “<component name>”>

Note:  Use the symbol | after the component name to indicate if an 
instance is required.

6 If the component requires an IP address separate from the device itself, 
type the following entry. Otherwise, go to the next step.

<SEPARATE_IP/>

7 If the component requires mapping a component instance in the 
component name to a different value, type the following entry. Otherwise, 
go to the next step.

<MAP NAME = “<name>”
 VALUE = “DEC(<offset>)”>

</MAP>

8 Define the metric element:

<METRIC NAME = “<metric name>”

Note:  Do not use an equal sign “=” in the <metric name>; it may cause 
parsing errors.

9 Specify whether or not the metric is to be polled by default by specifying 
one of the POLLBYDEFAULT options.
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POLLBYDEFAULT = “<yes|no>”

10 If required, specify a threshold value for the metric.

THRESHOLD = “<value>”

11 Define the METRIC STACK attribute:

STACK = “<stack elements>”

For more information on stack elements, see “Metric file format” 
(page 271).

12 If required, specify the metric index.

INDEX = “<index elements>”

For more information on index elements, see “Metric file format” 
(page 271).

13 Define the end of the METRIC element tag:

</METRIC>

14 If required, define additional metric elements by repeating step 8 to 
step 13.

15 Define the end of the COMPONENT element tag:

</COMPONENT>

16 If required, define additional component elements by repeating step 5 to 
step 15.

17 Define the end of the METRICFILE element tag:

</METRICFILE>

18 Add an optional description to the METRIC component in the metric file 
using the CDATA label. For example

<METRIC NAME=“Tx Cells From Baseline”
POLLBYDEFAULT=”yes”
STACK=”(txCell/NUM)BASELINEDELTA”>
<![CDATA[Discarded packets with priority 0 from
interface since the last baseline reset.]]>

</METRIC>

Note:  Do not use a @ or ^ in CDATA. These characters may cause 
parsing errors.
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The CDATA section is optional. Any metric without the CDATA section will 
be used by Data Viewer; however, Data Viewer will show a dialog with the 
message, “The description for this metric is not available from the metric 
file.”

Note:  The only non-printable character allowed is ‘\n’.

19 Save and close the file.

Change the file permissions to allow read access by the group and others, 
and read-write access by the owner.

chmod 664 <file name>

Variable definitions

Variable Definition

<component name> is the name of the component to define

<SEPARATE_IP/> specifies that the IP address is separate from the 
device

<name> is the component instance in the component 
name

<offset> is an integer or single alphabetic character (A to 
Z) used to decrement the component instance

<metric name> is the name of the metric

<value> is the threshold value

<stack elements> specifies the attributes to be polled and their 
calculations

<index elements> specifies the index of the attributes in the stack

<file name> is the name of the metric file used in step 3
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Updating the Data Viewer agent map file
Data Viewer clients open sessions with the Data Viewer agent. The agent 
connects to the corresponding Preside Multiservice Data Manager (MDM) 
servers. Once connected to the servers, the agent provides information to the 
graphic user interface (GUI).

For information about the Data Viewer agent map file (pmrtype.map), see 
241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 Copy the pmrtype.map file from the directory /opt/MagellanNMS/lib/cfg/

pmr to the directory /opt/MagellenNMS/cfg/pmr.

2 Using a UNIX editor, open the file pmrtype.map.

3 Specify the device type and the name of the metric file.

<device type>:<metric file with full path name>:PMDCD

4 Save and close the file.
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Updating the PMDCD configuration file
The Data Viewer data collection daemon lets you collect and display real-
time performance information for Simple Network Management Protocol 
(SNMP) devices in the network. 

For information about the PMDCD configuration file (pmdcd.cfg), see 
241-6001-310 Preside MDM Server Reference Guide.

Procedure steps
1 Copy the pmdcd.cfg file from the directory /opt/MagellanNMS/lib/cfg/pmr 

to the directory /opt/MagellenNMS/cfg/pmr.

2 Using a UNIX editor, open the file pmdcd.cfg.

3 Add the device type and sysName OID:

sysName:<device type>:<sysName OID>

4 Save the changes and close the file.
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Updating the Data Viewer client configuration file
Use this procedure to update the Data Viewer client configuration file.

Procedure steps
1 Modify the file /opt/MagellanNMS/cfg/DataViewerResources.cfg. 

1 Make the modifications to the MIBS MIB block between the BEGIN and 
END statements:

a. If you add a new device type, then add the following information:

<device prefix>=“<MIB files>”

b. If you change the MIB files for an existing device type, then find the 
<device prefix> associated with the device type and replace the MIB 
file names.

Variable definitions

Variable Definition

<device prefix> is a valid prefix for the new device 

<MIB files> are the full path names of the MIB files for the 
device
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Integrating a Passport device type
To integrate a new Passport device to the Data Viewer, you need to do one of 
the following:

• edit an existing metric file

• create a new metric file and revise configuration files

To revise an existing metric file, see “Updating an existing metric file for 
SNMP and Passport devices” (page 93). To create a new metric file, use the 
following procedures:

• “Creating a new metric file for Passport devices” (page 89)

• “Updating the Data Viewer agent map file” (page 92)

Creating a new metric file for Passport devices
Use the following procedure to create a new metric file for a Passport device 
type. For details about the required elements and format of the metric file, see 
“Metric file format” (page 271).

Procedure steps
1 Log on as root.

2 Access one of the following directories for creating a new metric file:

cd /opt/MagellanNMS/cfg/pmr

cd /opt/MagellanNMS/ext/lib/cfg/pmr

3 Using a UNIX editor, open a new file for editing. The subsequent steps in 
this procedure specify the required entries that you need to add to create 
a metric file. 

4 Define the beginning of the metric file:

<METRICFILE>

Note:  Use the PPtype as the name of the map file to uniquely identify a 
map file. For example, the map file for a GPRS device should be 
GPRS.map. 

5 Define a component:

<COMPONENT NAME = “component name>”>
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Note:  Use the symbol | after the component name to indicate if an 
instance is required.

6 Define the metric element:

<METRIC NAME = “<metric name>”

Note:  Do not use an equal sign “=” in the <metric name>; it may cause 
parsing errors.

7 Specify whether or not the metric is to be polled by default by specifying 
one of the POLLBYDEFAULT options.

POLLBYDEFAULT = “<yes|no>”

8 If required, specify a threshold value for the metric.

THRESHOLD = “<value>”

9 Define the METRIC STACK attribute:

STACK = “<stack elements>”

10 Define the end of the METRIC element tag:

</METRIC>

11 If required, define additional metric elements by repeating step 8 to 
step 13.

12 Define the end of the COMPONENT element tag:

</COMPONENT>

13 If required, define additional component elements by repeating step 5 to 
step 15.

14 Define the end of the METRICFILE element tag:

</METRICFILE>

15 Add an optional description to the METRIC component in the metric file 
using the CDATA label. For example

<METRIC NAME=“Tx Cells From Baseline”
POLLBYDEFAULT=”yes”
STACK=”(txCell/NUM)BASELINEDELTA”>
<![CDATA[Discarded packets with priority 0 from
interface since the last baseline reset.]]>

</METRIC>
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Note:  Do not use a @ or ^ in CDATA. These characters may cause 
parsing errors.

The CDATA section is optional. Any metric without the CDATA section will 
be used by Data Viewer; however, Data Viewer will show a dialog with the 
message, “The description for this metric is not available from the metric 
file.”

Note:  The only non-printable character allowed is ‘\n’.

16 Save and close the file.

17 Change the file permissions to allow read access by the group and others, 
and read-write access by the owner.

chmod 664 <file name>

Variable definitions

Variable Definition

<component name> is the name of the component to define

<MIB files> are the full path names of the MIB files for the 
device

<metric name> is the name of the metric

<threshold value> is the threshold value

<stack elements> specifies the attributes to be polled and their 
calculations

<file name> is the name of the metric file used in step 3
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Updating the Data Viewer agent map file
For information about the Data Viewer agent map file (pmrtype.map), see 
241-6001-310 Preside MDM Server Reference Guide.

1 Copy the pmrtype.map file from the directory /opt/MagellanNMS/lib/cfg/
pmr to the directory /opt/MagellenNMS/cfg/pmr.

2 Using a UNIX editor, open the file pmrtype.map.

3 Specify the device type and the name of the metric file.

<device type>:<metric file with full path 
name>:<Passport device>.map

For example, EM:/opt/MagellanNMS/cfg/prm/myMetric:GPRS.map.

4 Save and close the file.
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Updating an existing metric file for SNMP and Passport 
devices

Use this procedure to update an existing metric file for SNMP and Passport 
devices.

Procedure steps
1 Copy the default metric file from one of the following directories:

• /opt/MagellanNMS/lib/cfg/pmr

• /opt/MagellanNMS/ext/lib/cfg/pmr

It is recommended that you copy the metric files to the directory /opt/
MagellanNMS/cfg/pmr.

2 Modify the metric file in the directory /opt/MagellanNMS/cfg/pmr, 
maintaining the format requirements specified in “Metric file format” 
(page 271).

3 Save the changes and close the file.

Note 1:  Use a different map file other than the default pmrtype.map file 
to contain the modified map information for the device type.

Note 2:  Use the device type or PPtype (for Passport) as the map file 
name to uniquely identify the file.

4 Copy the pmrtype.map from the directory /opt/MagellanNMS/lib/cfg/pmr 
or /opt/MagellanNMS/lib/cfg/pmr to the directory /opt/MagellanNMS/cfg/
prm.

5 Using a UNIX editor, open the file pmrtype.map.

6 Modify the path name of the metric file associated with the device type.

7 Save the changes and close the file.
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Procedures for replay mode
Getting started

• “Starting the Data Viewer from the Preside MDM window in replay 
mode” (page 94)

Replaying data files
• “Replaying data files on a local workstation” (page 95)

• “Replaying data files on a remote workstation” (page 98)

Working with collected data
• “Retrieving files” (page 101)

• “Viewing files in the Files Selected area” (page 103)

• “Removing files from the Files Selected area” (page 104)

• “Removing all files from the Files Selected area” (page 105)

Starting the Data Viewer from the Preside MDM window in 
replay mode

This section describes how to start the Data Viewer in replay mode from the 
Preside MDM window. You can analyze collected data at a later date in this 
mode.

Procedure
1 In the Preside MDM window, select Accounting -> Data Viewer.

The Data Viewer window opens. The default is replay mode and 
spreadsheet view.
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Replaying data files on a local workstation
After you record data files, you can replay BDF, Data Viewer Saved Statistics, 
Streamed Passport Statistics, Statistical Retrieval System files on a local 
workstation. The default record description files (RDF) are used to decode 
bulk data format (BDF) files. Data Viewer locates the default RDF when it is 
launched in replay mode. Data Viewer may not display BDF files correctly if 
changes are made to RDF or BDF files after the tool is launched. Use the 
Select RDF option to select the corresponding RDF for the BDF files.

Note: If the BDF files are recorded using an older version of RDF files 
and the data record does not contain the RDF version, you must begin 
this procedure at step 1. See 241-6001-309 Preside MDM Management 
Data Provider User Guide for information on managing BDF data, and 
customizing RDF data records.

Procedure steps
1 Use the default RDF or select an RDF. If you want to use the default RDF, 

go to step 3. Otherwise, continue with this step.

From the Options menu, choose Select RDF.

The Select RDF File dialog opens.
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2 Select the RDF file and click Open.

3 If required, select one or more the following:

• Data Type

• Device Type

• Device Name

• Start Date

• End Date

4 Click Retrieve Files to add data files.

The File Selection dialog opens.

5 Select the file(s) from the File Selection dialog by one of the following 
methods:

To select a single file

• Click the mouse on a file name and click OK. The file is added to the 
Files Selected area of the Data Viewer window and the File 
Selection dialog closes.
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• Click the mouse on a file name and click Apply. The file is added to 
the Files Selected area of the Data Viewer window and the File 
Selection dialog remains open.

To select a range of files

• Click the mouse on the first file name, press shift and click the mouse 
on the last file name and click OK or Apply to confirm your 
selections.

To select multiple files

• Press control, and click the mouse on multiple file names and click 
the OK or Apply to confirm your selections.

The file(s) appear in the Files Selected area.

6 To view multiple files with the same data type, select a file and click View. 

The files appear in the data panel area.

data 
panel 
area

files 
selected 
area
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7 If required, from the View menu, select a different view.

Replaying data files on a remote workstation
After you record data files, you can replay the files on a remote 
workstation.Record description files (RDF) are used to decode bulk data 
format (BDF) files. The Data Viewer selects the appropriate RDF by reading 
the first two fields of a BDF data file record. These fields are switch type (pp, 
dpn, vss, or gen) and data type (acc, sta, ala, log, scn, otg, or ava).

Note: If the RDF for the selected BDF file(s) was customized after the 
BDF records were created, the results displayed with this application 
may not be accurate.

Procedure steps
1 Access the files by a file system mount or FTP the files to the local 

workstation.

2 Verify that both record description file (RDF) and bulk data file (BDF) exist.

3 From the Options menu, choose Select RDF.

The Select RDF File dialog opens.

4 Select the RDF file and click Open.
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5 If required, select one or more the following:

• Data Type

• Device Type

• Device Name

• Start Date

• End Date

6 Click Retrieve Files to add data files.

The File Selection dialog opens.

7 Select the file(s) from the File Selection dialog by one of the following 
methods:

To select a single file

• Click the mouse on a file name and click OK. The file is added to the 
Files Selected area of the Data Viewer window and the File 
Selection dialog closes.

• Click the mouse on a file name and click Apply. The file is added to 
the Files Selected area of the Data Viewer window and the File 
Selection dialog remains open.
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To select a range of files

• Click the mouse on the first file name, press shift and click the mouse 
on the last file name and click OK or Apply to confirm your 
selections.

To select multiple files

• Press control and click the mouse on multiple file names and click the 
OK or Apply to confirm your selections.

The file(s) appear in the Files Selected area.

8 To view the files, select a file and click View.

The files appear in the data panel area.

9 If required, from the View menu, select a different view.

data 
panel 
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files 
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area
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Retrieving files
Retrieving files lets you analyze performance information at a later date. The 
retrieved files are displayed in the Files Selected area.

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 In the File Retrieval section of the Data Viewer window, select a Data 

Type from the pull-down menu, if required:

• Data Type
Accounting, Alarm, All (default), Availability, Data Viewer Saved 
Statistics, Log, Outage, SRS, Scn, Statistics, Streamed Passport 
Statistics

2 If required, select a Device Type from the pull-down menu:

• Device Type
All (default), DPN, Others, Passport

3 If required, in the Device Name field, type the device.

• specify <nodename | nodeid> for Accounting, Alarm, Scn, Log, 
Statistics and Outage data types

• device name has no impact on Availability type

• specify <nodename> for SRS and Data Viewer Saved Statistics data 
types

• specify <Passport-groupname> in Streamed Passport statistics data 
type

4 If required, specify the Start Date and End Date:

• Start Date lets you specify a range of the start date (yyyy/mm/dd) 
and time (hh:mm:ss) of the filename to be filtered. Any files with the 
start date and time larger than the Start Date are selected.

• End Date lets you specify a range of the end date (yyyy/mm/dd) and 
time (hh:mm:ss) of the filename to be filtered. Any files with the end 
date and time smaller than the End Date are selected.

5 Click Retrieve Files.
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The File Selection dialog opens.

6 Select the file(s) from the File Selection dialog by one of the following 
methods:

To select a single file

• Double-click the left mouse on a file name. The file is added to the 
Files Selected area of the Data Viewer window and the File 
Selection dialog closes.

• Click the left mouse on a file name and click OK. The file is added to 
the Files Selected area of the Data Viewer window and the File 
Selection dialog closes.

• Click the left mouse on a file name and click Apply. The file is added 
to the Files Selected area of the BDF Viewer window and the File 
Selection dialog remains open.

To select a range of files

• Click the left mouse on the first file name, press shift-left mouse on 
the last file name and click OK or Apply to confirm your selections.

To select multiple files

• Press control-left mouse on multiple file names and click the OK or 
Apply to confirm your selections.
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The file(s) appear in the Files Selected area.

Viewing files in the Files Selected area
Once the files are displayed in the Files Selected area, you can view them in 
more detail.

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 Select the file(s) to view from the Files Selected area by one of the 

following methods:

To select a single file

• Click the left mouse on a file name.

To select a range of files

• Click the left mouse on the first file name, and press shift-left mouse 
on the last file name.

To select multiple files

• Press control-left mouse on each file name.

2 Click View.

The Progress Information dialog flashes on the screen briefly, 
depending on the size of the files. The files are displayed in the Data Panel 
area of the Data Viewer window.
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Removing files from the Files Selected area
After you analyze data files, you may wish to remove one or more files.

Prerequisites
The Data Viewer must be in replay mode.

Procedure steps
1 From the Files Selected area, select the file(s) by one of the following 

methods:

To select a single file

• Click the left mouse on a file name.

To select a range of files

• Click the left mouse on the first file name, and press shift-left mouse 
on the last file name.

To select multiple files

• Press control-left mouse on each file name

• The selected files in the Files Selected area are highlighted.

2 Click Remove Selected.

3 The Files Selected area is refreshed without the removed files.
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Removing all files from the Files Selected area
After you analyze data files, you may wish to remove all files.

Prerequisites
The Data Viewer must be in replay mode.

Procedure
1 From the Files Selected area, click Remove All.

The Files Selected area is refreshed without any file names being 
displayed.
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Procedures for real-time and replay modes
Getting started

• “Starting the Data Viewer from the command line” (page 106)

• “Exiting the Data Viewer” (page 107)

Controlling the display of performance information
• “Rearranging data display” (page 108)

Viewing performance information
• “Viewing summary and detailed performance information” (page 109)

• “Managing the graphical display” (page 112)

Starting the Data Viewer from the command line
You can start the Data Viewer in real-time mode or replay mode from the 
command line.

Procedure steps
1 From the UNIX prompt, type

/opt/MagellanNMS/bin/dataviewer -mode 
<REALTIME|REPLAY>

Variable definitions

Variable Definition

<REALTIME|REPLAY> the mode in which the tool is launched. 
Specifying REALTIME launches the Data Viewer 
tool in real-time mode. REPLAY launches the 
tool in replay mode. If you do not specify the 
mode, the Data Viewer is launched in real-time 
mode.
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Exiting the Data Viewer
Use this procedure to exit the Data Viewer.

Procedure steps
1 From the File menu, select Exit

When you exit from the Data Viewer, all open windows close and history 
for the session is discarded.
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Rearranging data display
You can sort the values and change the order of the data columns. The Data 
Viewer displays metric values in two locations:

• Data panel area in the lower half of the Data Viewer window

• Summary and detailed statistics tables for a specified statistic in the 
views area (real-time mode only)

Procedure steps
1 To change the order of the columns, select each column header and drag 

it to its new position.

2 To sort the values for a metric in ascending order, right click in the column 
header for the metric. 
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Viewing summary and detailed performance information
The Data Viewer lets you view detailed and summary information collected 
for each component. The information is displayed in the Graph window, in 
both table and graphic formats.

Procedure steps
1 In the data panel area, click in the component row. 

2 Click Graph.
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The Graph window opens. You can launch multiple versions of the Graph 
window, one for each component you are monitoring. See “Managing the 
graphical display” (page 112).

This sample screen displays detailed information about one component.

3 View detailed or summary information by doing one of the following:

• Click the Detail tab to view detailed information.

• Click the Summary tab to view summary information.
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4 If you wish to change the color assigned to a metric, complete the 
following:

a. From the graph selection table, click the color bar for the metric in the 
statistics table. 

The Pick a Color window appears. This window provides options 
and sample displays to let you select or mix a new color for the metric.

b. Choose a new color for the metric.

c. Click OK to set the color.

The new color appears in the Color column of the graph selection 
table and in any existing graphs in which the metric is used. For more 
information on graphs see “Managing the graphical display” 
(page 112).

5 To exit from the Data Viewer tool, select File -> Exit.
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Managing the graphical display
You can specify performance data to view in thumbnails, multi graphs or 
trend graphs, and in line or bar graph format.

Procedure steps
1 In the Graph window, click the checkboxes in the graph selection table to 

select the metrics to graph.

The Data Viewer plots the data collected for the selected metrics and 
displays it in the graph area. Only the metrics that you select in the graph 
selection table appear in the graph.

The color of each line or bar in the graph matches the color assigned to 
the metric in the detailed statistics table. The x axis of the graph shows 
the time each set of data was collected.

The endpoint of the graph line represents the latest performance data 
collected. The data and the graph are updated according to the polling 
interval you select in the Data Viewer window.

2 To view a different type of graph, do one of the following:

• Click the ThumbNails, the Multi Graphs or the Trend Graphs tab in 
the graph area.

• From the Options menu, select Line or Bar.

Note:  For thumbnail graphs, you can also change the display by clicking 
the right mouse button on the Thumbnail graph. A context menu with 
Range setting (Default) or Range setting (Customized) is displayed. Click 
on the context menu and the Customize Display Range dialog opens. 
Change the minimum and maximum display values, and click OK.

3 To clear the graphs and display new data, deselect the graph box in the 
graph selection table.

Any graphs selected in the graph selection table are cleared.
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DPN Performance Viewer

This section describes the DPN Performance Viewer and provides you with 
instructions on how to use this tool. The following information is included:

• “DPN Performance Viewer overview” (page 115)

• “Performance Viewer window” (page 116)

• “DPN Performance Viewer dialogs” (page 121)

• “DPN Performance Viewer Procedures” (page 129)

• “Customizing DPN Performance Viewer default settings” (page 135)

• “Understanding DPN Performance Viewer log files” (page 137)

DPN Performance Viewer overview
The DPN Performance Viewer (Performance Viewer) collects and displays 
performance information about DPN network components. Use the DPN 
Performance Viewer tool to

• help trace faults in the network 

• collect information about network load 

• generate statistics for reporting and analytical purposes

The DPN Performance Viewer collects statistics on the status of components 
called metrics. You select the metrics you want to view, choosing a text or 
graphic format. Component information is obtained in real-time over short 
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periods. The display varies according to the type of component(s) you are 
monitoring. You can write the information you collect to an ASCII log file for 
later analysis or processing.

The DPN Performance Viewer collects attributes from DPN network 
components using the General Management Data Router (GMDR) server. 
The DPN Performance Viewer uses these attributes to derive more 
meaningful metric values. These values are displayed as a history in a 
graphical format.

For DPN metric details, see “DPN-100 metrics” (page 265).

For additional information on the DPN Performance Viewer, see

• “Performance Viewer window” (page 116)

• “DPN Performance Viewer dialogs” (page 121)

• “Keyboard shortcuts” (page 121)

• “Starting the DPN Performance Viewer” (page 129)

• “Displaying component information” (page 130)

• “Controlling the graphic display” (page 132)

Performance Viewer window
The Performance Viewer window contains three or four areas, depending on 
which component is being viewed. Except for the Menu Bar area, which is 
always visible, the other areas are separated by “window panes”. Clicking and 
dragging the mouse over one of the window pane movement boxes lets you 
configure the relative size of each area; one area can fill the entire DPN 
Performance Viewer display.

See the figure “Performance Viewer window” (page 117) to view a sample 
Performance View window.
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Figure 18
Performance Viewer window

When you first attempt to establish a connection to a network component, or 
subsequently use the Change Parameters command, there is a delay until a 
response is received from the GMDR. During this delay, the status line just 
below the menu bar displays a message, and the shape of the cursor turns into 
that of a clock. When a response is received, either as performance data or 
some kind of connection error, the status line turns blank and the cursor 
returns to its normal shape. A delay of about one minute occurs when the 
GMDR first connects to DPN networks. 

See the following information:

• “File menu” (page 118)

• “Options menu” (page 119)

• “Help menu” (page 120)

• “Status message area” (page 120)
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• “Shelf display area” (page 120)

• “History display area” (page 120)

• “Metric list area” (page 121)

File menu
The File menu contains commands for files, for the application as a whole, 
and for exiting the DPN Performance Viewer tool. The available commands 
include: 

• Log to File opens a dialog that prompts you for a file name to save the 
complete visible metric history. If that filename already exists, it is 
overwritten. 

The file is placed in your home directory, unless you provide an absolute 
pathname. 

The file is updated every time more data is collected until you select the 
Stop Log menu option, exit the DPN Performance Viewer, or change to 
a different component. The DPN Performance Viewer always provides a 
graphic display, whether or not you direct output to a file at the same 
time. 

Although you can view a file in text form, it is normally processed by 
other applications (custom and future tools). 

The Log to File command is only available when no log is currently 
running. 

• Stop Log stops output to the file and closes it. 

• View Log File enables you to view an ASCII file in a text window. The 
last known log file name is used as a default file name;, however, you can 
change this after the PV Log File Name dialog opens. If the current log 
file is being viewed, new logs are written to it as they are received. The 
text window that you see is actually an xtail command. It contains a file 
name field near the top of the window that can be changed to a different 
file name You can view the file by clicking Show. The Pause button 
freezes output to the xtail session until you toggle it off. 
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• Exit leaves the DPN Performance Viewer. All windows associated with 
the session are removed from the workstation screen. However, if you 
invoke an xtail session using the View Log File command, it is not 
closed. 

Options menu
The Options menu contains commands that let you customize the DPN 
Performance Viewer session. 

• Change Parameters opens the Performance Viewer Setup dialog. This 
setup dialog allows you to change the refresh interval for retrieving 
metrics and to change the component being monitored. 

If you change the refresh interval, the DPN Performance Viewer remaps 
the metric history based on the new refresh interval. If you choose a 
larger refresh interval, the older graph history appears squeezed; if you 
choose a smaller refresh interval the older graph history appears 
stretched.

Changing the refresh interval does not affect the log file. However, 
changing the component stops the log file and creates a new graph.

• Reset History Graph command applies when you work with a list of 
multiple components in the Performance Viewer window. This 
command toggles the reset function of the graph on or off. As a result, 
one of the following commands will be available:

— Reset History Graph On resets the graph to the initial data 
collection time whenever you select another component from the 
list.

— Reset History Graph Off retains the current position of the graph 
whenever you select another component from the list.

— The active behavior of the graph is always opposite to the choice that 
is visible in the Options menu.
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Help menu
The Help menu provides the following options:

• Help on Context provides help information about an object in the 
window. When you select this menu item, the cursor changes to a 
question mark. You can then move the cursor anywhere in the window 
and select an object in the window to get information about it. If you do 
not click on a specific object or if no specific help text is available for that 
object, general help for the application will be displayed.

• Help on Help contains information about how to use the help facility

• Help on Window provides descriptive help information about a window

• Help on Keys provides help information about keyboard shortcuts.

Status message area
The Status Message Area displays messages. For example, the message 
“Waiting for server response” is displayed during a connection attempt to a 
component. 

When no warning message is being displayed, the Status Message Area 
shows which component is currently selected for viewing. 

Shelf display area
The Shelf Display Area displays a list of DPN components. This list displays 
the name of the sub-components (omitting the module name) and the key 
metrics collected. You can view all the metrics in the history and metric list 
areas.

To select a component for viewing in the history and metric area, click the 
component in the list, or click the button below one of the cards or logical 
processors. 

A DPN component displayed in orange means that it is out of service. 

History display area
The History Display Area displays the history of metric values for a particular 
component using line graphs. Use the scrollbar at the bottom of the graph to 
scroll through the complete history of the current DPN Performance Viewer 
session. You can move the History Line to see values for specific times in the 
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graph. First, put the cursor in the History Display Area. Left click the mouse 
to move the History Line to the current cursor position. You can also use the 
left and right arrow keys to move the History Line in increments of one data 
point. 

Metric list area
The Metric List Area lets you toggle particular metric displays on or off. It 
also gives information about the metric value, its value at a particular time in 
history (corresponding to the vertical white bar in the History Display Area), 
and its minimum and maximum possible values. Shaded buttons cannot be 
selected for display. 

Note: For some metrics, notably the “packets per second” types, the 
maximum value may increase depending on the history. This allows 
trunks of different speeds to be monitored in a meaningful way. 

Clicking the HiWater button in the metric list area changes the history 
marker to that metric's high-water point. For information on the metrics, see 
“Customizing DPN Performance Viewer default settings” (page 135).

Keyboard shortcuts
The DPN Performance Viewer provides the following keyboard shortcuts: 

• Ctrl+L invokes Log to File

• Ctrl+S invokes Stop Log

• Ctrl+V invokes View Log File

• Ctrl+E invokes Exit

• Ctrl+C invokes Change Parameters

DPN Performance Viewer dialogs
The DPN Performance Viewer provides the following dialogs:

• “Performance Viewer Setup dialog” (page 122)

• “PV Log File Name Entry dialog” (page 124)

• “PV Log View dialog” (page 125)

•  “Warning and error dialogs” (page 125)
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Some DPN Performance Viewer dialogs have default action buttons. They are 
visually distinguished by an extra box around them. If you press the Return 
key anywhere in the dialog, Motif activates the default button. 

Performance Viewer Setup dialog
The Performance Viewer Setup dialog lets you to specify the performance 
information you would like to display. This dialog appears when you start the 
DPN Performance Viewer for the first time, or when you change components 
or change the probing interval. 

The following items appear in the dialog: 

• Refresh Interval (seconds) sets the refresh interval (in seconds) used to 
gather data. The refresh interval has a default value of 300 seconds, 
which changes when you slide the bar or click to the left or right of the 
bar for more refined tuning. The refresh interval is a target value; 
depending on network speed, some data collection may take longer. The 
selectable range of the refresh interval is from 60 seconds to 600 seconds 
(10 minutes) for DPN devices. 

When you select a DPN display, you need to set the refresh interval equal 
to or greater than the largest Network Control System (NCS) status probe 
interval for the whole network. Failure to do this may result in 
components incorrectly being displayed as out-of-service. 

The initial refresh interval used for a DPN status display is 30 seconds, 
regardless of the setting for Refresh Interval. The initial short collection 
interval is used to quickly gather data as it becomes available. The short 
refresh interval is used only for the first full Refresh Interval. That is, 5 
minutes of 30 second refreshes occur; after that, refreshes occur every 5 
minutes.
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• Radio buttons and component ID fields. The left side of the dialog is 
equipped with a number of radio buttons (Micro Status, Net Link 
Status, Trunk Status, Gateway Status and Summary Status) that 
allow you to select one type of performance information to display at a 
time.

Each radio button is accompanied by a component ID field (Module, or 
Dest Mem) that becomes active when you click the radio button. 

You can type in the component ID, or you can retrieve the component 
name from context by clicking Get Context. For DPN, only a PM or 
destination mnemonic name is required. Multiple displays for DPN are 
inherent and not triggered by a wildcard. The destination mnemonic is 
similar to an OA name, but allows identification of primary or backup. 
Note that if the “PM”, or “OA” prefix is missing, it is prefixed 
automatically to the component specification.

See “DPN-100 Metrics” (page 265).

• Reauthenticate with CM forces you to reauthenticate with the 
Connection Manager. This is useful when changing different 
components to different user privileges.

• OK starts DPN Performance Viewer. You need to specify a DPN 
component name in the component ID field.

• Cancel closes the Setup dialog. If the Setup dialog is presented as the 
result of starting the DPN Performance Viewer, then the Performance 
Viewer is not started. If the Setup dialog results from a Change 
Parameters command, only that change operation is canceled.

The Performance Viewer Setup dialog allows you to open the following 
types of DPN summary status displays by clicking the appropriate radio 
button:

• Micro Status. The format of the PM name is “PM/nodename”. 
Metrics: CPU Utilization (%), Free Heap (%), Free MSG (%), PPS Sent, 
PPS Received, PE Service. 

See also “Micro status” (page 265).
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• Net Link Summary Status. An OA destination mnemonic must be 
supplied (for example, OA/name). 
Metrics: Netlink Utilization (%), Netlink Local Mnemonic, Netlink 
Remote Mnemonic. 

See “Net Link status” (page 266).

• Trunk Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 

Note: NM trunk numbers are hexadecimal. 
Metrics: Trunk Utilization (%), Trunk Local Mnemonic, Trunk Remote 
Mnemonic. 

See “Trunk status” (page 267).

• Gateway Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 
Metrics: Gateway Type, Gateway Call, Gateway Link Utilization (%), 
Gateway Pkt Sent, Gateway Pkt Received. 

See “Gateway status” (page 268).

• Summary Status. An OA destination mnemonic must be supplied (for 
example, OA/name). 
Metrics: Bus Utilization (%), Common MSG (%). 

See “Summary status” (page 269).

PV Log File Name Entry dialog
The PV Log File Name Entry dialog requests a file name. The name that you 
enter in the text portion of the dialog specifies the file in which the DPN 
Performance Viewer dumps metric log information. 

If a log file has already been opened, its name appears in the dialog. You can 
change this name if you wish. The log begins when you click Start Log. 

You may change the default directory by double clicking on a directory name, 
or by single clicking and clicking Change Directory. 
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The following commands are available in the PV Log File Name Entry 
dialog:

• Log Entire History from Beginning writes all performance metrics to 
the named file from the moment the DPN Performance Viewer is 
originally started. The default value is Off. If you do not select this 
button, the DPN Performance Viewer only writes performance metrics to 
file from the next refresh to whenever you select Stop Log from the File 
menu. 

• Start Log opens a log file with the name specified in the selection text 
field. The dialog then closes. 

• Change Directory changes the current directory to the one specified in 
the directories list. 

PV Log View dialog
The PV Log View dialog displays the contents of the alarms as they are 
logged to a file. 

The following commands are available from the PV Log View dialog:

• Show refreshes the contents of the dialog with the current content of the 
specified alarm file.

• Pause lets you pause the display of incoming alarms. When the display 
has been paused, a red border surrounds the alarm information and the 
label on the button changes to Resume. Clicking the Resume button 
removes the red border and resumes the dislay the incoming alarms.

• Close closes the dialog.

Warning and error dialogs
If any of the following warning or error dialogs appear, you need to take 
appropriate action.

PV Exit Warning dialog
Exiting the Performance Viewer finishes this session. Any log file in progress 
is saved and closed. 

• No, cancel exit cancels the exit operation and returns to the Performance 
Viewer. 
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PV File Error dialog
A file operation error occurs on the log file. This happens when the specified 
ASCII log file is unwritable, perhaps because you do not have write 
permission to the directory, or because the file is already present but does not 
have write permission. 

If a close file operation fails, the Performance Viewer assumes the log file is 
dead. You can start another log. 

PV File Lock Error dialog
The specified file is locked. This results from another Performance Viewer 
currently using the named file for its log. You need to choose Stop log so that 
the DPN Performance Viewer can close the log file and unlock it. 

If the file is not in use, maybe it is wrongly marked as locked. You need to 
delete a file called “<filename>.lock” located in the same directory as 
<filename>, probably in your home directory. 

PV File Exists Warning dialog
The file you choose in which to dump the DPN Performance Viewer log, 
already exists. If you overwrite the file, you can lose any data it contains. If 
you do not wish to lose this file, click No, keep the file, select Log to File, 
and specify a different file name. 

• Yes, delete the file starts a new log and overwrites the existing file. 

• No, keep the file cancels the start log operation. 

No Component Error dialog
The specified component name may be incorrect or not supported by the DPN 
Performance Viewer for viewing metrics. For example, a CARD component 
is supported, whereas a SHELF component is not. If you are certain that the 
component is supported, make sure that the component name is in correct 
syntax, and try again using the Change Parameters option. If it persists, see 
your system administrator. 

PV IPC Error dialog 
The DPN Performance Viewer fails to establish a connection to the 
interprocess communication server. You need to exit the DPN Performance 
Viewer. Start the process “mnsd” should be started before invoking the DPN 
Performance Viewer. 
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Prober Busy Warning dialog
The lower layer devices are too busy to respond to the probe request within 
the specified refresh interval. As a result, some probe cycles may have been 
skipped. Increase the refresh interval using the Change Parameters option. 

Metric Database Error dialog
The target component does not have the specified probe attributes. Ensure that 
Nortel Networks checks your metric database.

Invalid Component Error dialog
The Invalid Component Error dialog is displayed for any of the following 
reasons:

• The specified component name is incorrect. Make sure the component 
name is in correct syntax and try again using the Change Parameters 
option. If the situation persists, see your system administrator. 

• A component is missing, such as a card that does not exist, or a 
component is out of range. 

Insufficient Authentication Error dialog
To access the networks to gather metrics, you need to have a certain level of 
security. This security is provided when the CM window is displayed and 
asks you to supply a group, id, and password. 

This window may be forced up if you change the component (probably the 
same one you tried) and select the Reauthenticate with CM button in the 
setup dialog. 

Device Error dialog
The specified component name does not exist in the current network view. 
Make sure the component name is correct and exists in the network view. You 
may try again using the Change Parameters option. If the situation persists, 
see your system administrator. 

Device Timeout Error dialog
No response is available from the target component. Make sure the 
component is active and the X.25 connection to the network is not congested. 
You may try again using the Change Parameters option. If the situation 
persists, see your system administrator. 
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Prober Internal Error dialog
The Prober Internal Error dialog is displayed for any of the following 
reasons:

• The lower layer has errors. No more data may be displayed. 

• Check the OAM Log Display for detailed error information about 
Generic Prober (GP), the GMDR, or Fdtr. Verify your system 
configuration for connection between Preside Multiservice Data 
Manager (MDM) and Passport. 

This error may be caused by the Passport component going down. Even 
when the component comes back up, probing does not take place unless 
you manually restart it using the Change Parameters option. 

You can try to solve this by reconnecting the DPN Performance Viewer using 
the Change Parameters option. If this fails, log out and log back in; this 
restarts a probe. If the situation persists, see your system administrator. 

Accumulator IPC Error
An attempt to connect to the server GMDR fails. Make sure that the server 
GMDR is running on the local workstation or the workstation you LAN select 
to. 

Accumulator Lost Connection dialog
Communication with the server GMDR is severed. Make sure the server 
GMDR is running on the local workstation or the workstation you LAN select 
to. 

Invalid Module Name or Destination Mnemonic dialog
The specified destination mnemonic or module name is not reporting status 
records. Make sure the connection from Preside Multiservice Data Manager 
(MDM) to the OA or from the OA to the reporting module is up. You may try 
again using the Change Parameters option. If the persists, see your system 
administrator. 

Make sure the specified PM or destination mnemonic exists within the 
network view. 
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Note: A refresh interval that is set too short may also cause this error. 
Make sure the refresh interval is set no smaller than the status probe 
interval of the switch. 

DPN Performance Viewer Procedures
You can perform the following tasks with DPN Performance Viewer:

• “Starting the DPN Performance Viewer” (page 129)

• “Displaying component information” (page 130)

Starting the DPN Performance Viewer
You need to specify a DPN status display and a DPN module name or a 
reporting destination mnemonic (Dest Mnem). 

Note: The DPN destination mnemonic is not the OA name; however, it 
allows you to identify an OA more precisely. For most setups, the 
primary OA and its destination mnemonic are the same.

Starting the DPN Performance Viewer from the Performance 
toolset
1 In the Preside MDM window, select Performance ->DPN Performance 

Viewer.
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The Performance Viewer Setup window opens.

2 To display performance information, choose one of the following:

a. For a DPN micro status display, click Micro Status and enter the PM 
you want to monitor.

b. For a DPN network link status display, click Net Link Status and 
enter the reporting Dest Mnem you want to monitor.

c. For a DPN trunk status display, click Trunk Status and enter the 
reporting Dest Mnem you want to monitor.

d. For a DPN gateway status display, click Gateway Status and enter 
the reporting Dest Mnem you want to monitor.

e. For a DPN summary status display, click Summary Status, and 
enter the reporting Dest Mnem you want to monitor.

Displaying component information
DPN Performance Viewer displays performance information about multiple 
DPN components.
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The DPN Performance Viewer gives multiple component displays only for 
the five different DPN status types that you can select in the setup dialog. The 
components in the DPN displays represent the various components that the 
Dest Mnem is reporting.

Displaying DPN status information
1 Click one of the DPN status buttons.

2 Type the component name in the PM or Dest Mnem field beside the 
button for example, OA/BARNEY is a reporting Dest Mnem name): or 
click Context action. This places the current context into the active text 
field. You need to have a Dest Mnem (or PM) in context.

3 Move the slider control in the Refresh Interval (seconds) field to select 
a desired probe frequency for displaying data. The Refresh Interval has 
a 60-second default setting. You can choose an interval between 60 and 
600 seconds (10 minutes).

Note:  An initial attempt occurs to get all the information at the start of the 
collection. After this attempt, the probe tries once every selected refresh 
interval. 

4 Click OK.

CAUTION
The refresh interval should be equal to or greater than the 
maximum NCS status probe interval for the whole 
network. If not, the accuracy of the DPN Performance 
Viewer is affected.
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The Performance Viewer window opens and the Performance Viewer 
Setup window closes.

This sample screen graphs the Trunk Utilization performance of DPN 
components under a Dest Mnem. The Performance Viewer used a refresh 
interval of 60 seconds and ran for about thirty minutes.

Controlling the graphic display
The Performance Viewer window contains several control areas. Use the 
mouse to activate a variety of display controls.
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Single component display information
The single component Performance Viewer window contains the following 
areas and controls: 

• a title bar at the top of the window showing the component name 

• a menu bar with File, Options, and Help menus

• a graphic display area with a moveable vertical History Line 

• a time scale and a horizontal scroll control below it 

• a textual display area with buttons to the left and a vertical scroll control 
to the right. The default for the metrics button is Off. You need to select 
the metrics that you want to view as a graph.

Filtering information about a single component
1 Use the inner buttons at the bottom of the screen on the left-hand side to 

filter the display you want to see. You can display graphs of CPU 
Utilization (%)and Msg Block Utilization (%) for card components. For 
trunk components, you can display Packets/sec from interface, Trunk Pks/
sec from interface, Discarded Packets/sec, and Round trip delay/ms. For 
bus components, you can display Bus Utilization (%).

The DPN Performance Viewer reports the values obtained in the text 
display area on the right of the buttons and graphs these results in the 
graphic display area. The color of the button matches the line displayed in 
the graph. The endpoint of the graph line represents the latest value 
obtained and is updated according to the Refresh Interval you select in 
the Performance Viewer Setup Dialog.

2 Position the cursor in the graph display area and move the History Line 
to display values for a chosen moment of interest. Left click the mouse to 
move the History Line to the current cursor position. You can also use the 
left and right arrow keys to move the History line in increments of one data 
point.

The History Line moves to the selected point, and the values obtained 
for that period are displayed in the text display area.

Note:  You cannot move the History Line to a point before the 
Performance Viewer is started or to a point beyond the current value.

3 If you want to view the maximum value for the period during which the 
Performance Viewer is active, click High Water Mark of the selected 
metric.
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The History Line finds the High Water Mark and reports this value in the 
text display area.

4 If you want to change the nature of the DPN Performance Viewer display, 
use the Options menu. Change parameters lets you view the 
performance of another component after you enter the component ID in 
the Performance Viewer Setup dialog. You may also reset the refresh 
interval to a different value.

Note 1:  Changing components is identical to exiting the current 
Performance Viewer and starting a new one. All history for the previous 
Performance Viewer is lost and any log file output is stopped. If you 
change the refresh interval, new history points are lined up based on the 
new refresh interval. This can result in the graph being stretched or 
squeezed.

Note 2:  See Help for Change Parameters to find detailed component 
support information. 

5 Use the File menu to create and view Performance Viewer log files. Start 
log prompts you to name a log file that you want to create and then writes 
collected information to that log file. The log file is updated every time 
more information is collected, until Stop log, Change Parameters, or 
Exit is selected. Stop log stops output to the log file. View log retrieves 
and displays saved Performance Viewer log files.

Note:  If you select a filename identical to a previously saved log file, the 
saved log file is overwritten with the latest performance information.

Multiple component display information
The multiple component Performance Viewer window is similar to the 
single component window but has one additional display area. The top of the 
window contains different displays depending on the kind of multiple 
components you are viewing. This area is always present when viewing Data 
Packet Network (DPN) status. 

Clicking one of the numbered radio button creates a display of that 
component’s performance in the graphic display area below. Any previous 
component display is replaced by the new selection.

For the DPN status displays, the multiple component area shows a list of all 
the PE’s, etc., that are report information through the specified Dest Mnem. 
Clicking an item in the list creates a display of that component’s performance 
in the graphic display area below. Any previous component display is 
replaced by the new selection.
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Note: Down DPN components appear in the list with an orange 
background.

Filtering information about multiple components
1 Use the inner buttons at the bottom of the screen to filter the display you 

want to see. You can display graphs of CPU Utilization (%) and Msg Block 
Utilization (%) for any single card on the Passport shelf. 

The DPN Performance Viewer reports the values obtained in the text 
display area on the right of the buttons and graphs these results in the 
graphic display area above. The color of the button matches the line 
displayed in the graph or list. The endpoint of the graph line represents the 
latest value obtained and is updated according to the Refresh Interval 

you select in the Performance Viewer Setup Dialog.

2 To see information on another component, click the numbered radio 
button or the list item that corresponds to that component at the top of the 
screen.

3 All other procedures and controls are identical to those described in steps 
2-5 in “Filtering information about a single component” (page 133).

Customizing DPN Performance Viewer default settings
You can change several default settings. To override these defaults, enter new 
values in the .Xdefaults file in your $HOME/MagellanNMS directory as 
shown in the table “Resources for customizing Performance Viewer default 
settings” (page 136).
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For additional information on customization, see 241-6001-301 Preside 
MDM Customization Administrator Guide.

Table 1
Resources for customizing Performance Viewer default settings

Resource Description Legal values

PV*historyLimit Specifies the number 
of data points the 
Performance Viewer 
can remember. This 
setting affects the size 
of the graphic display.
 

The default value is
 1 000. You can 
choose any value 
between 200 and 
10 000.

PV*logFile Is used to enter a 
default log filename 
whenever you use the 
Start Log… option 
under the File menu.

You can choose any 
valid UNIX absolute 
path file.

PV*refreshInterval Sets the refresh 
frequency default. 

The default value is 
300 seconds; 
however, you can 
choose a setting 
between 10 and 600 
seconds (60 and 600 
seconds for DPN 
displays).

PV*metricButton.set Is used to set the initial 
state of the metric 
buttons. 

The default is False, 
which means no 
graphs are initially 
displayed.
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Understanding DPN Performance Viewer log files
You can write the information collected by DPN Performance Viewer to a log 
file. These log files use an ASCII format and can be viewed or machine read. 
For procedures about creating and viewing DPN Performance Viewer log 
files, see step 5 in “Filtering information about a single component” 
(page 133). 

Log file information uses the following syntax:

time : component : metric : value

time is the time stamp of the current line’s output in the format yyyy mm dd 
hh mm ss. The time is fetched from the Preside Multiservice Data Manager 
(MDM) workstation clock at the moment the data is received.

component is a fully qualified component name. For example, PM/R34 PE/8

metric is the calculation defined in the metric database. For example, CPU 
Utilization (%).

value is the numeric or string result of the most recent calculation. For 
example, 42.

Here is an example of one line of output in a log file:

2002 01 31 15 52 51: PM/34 PE/8: CPU Utilization (%) : 0

Note: Colons are used to separate the fields and to improve machine 
readability. This means that you cannot use colons as part of the 
component identification or the metric name if machine readability is 
expected.
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Passport performance metrics

Passport performance metrics are generated by the Data Viewer and are 
detailed by component, in alphabetical order.

Note: Do not use an equal sign “=” in the <metric name>. It may cause 
parsing errors

Table 2
Component: EM/ AAL1CES/

Name Formula Meaning

Tx Cells per second (cellsTransmitted/NUM)                      
DELTA SECONDS DIVIDE

Number of cells sent to the 
interface per second since the 
last probe.

Tx Cells since Baseline (cellsTransmitted/NUM)                      
BASELINEDELTA

Number of cells sent to the 
interface since the last 
baseline reset.

Rx Cells per second (cellsReceived/NUM)                      
DELTA SECONDS DIVIDE

Number of cells received from 
the interface per second since 
the last  probe. 

Rx Cells since Baseline (cellsReceived/NUM)                      
BASELINEDELTA

Number of cells received from 
the interface since the last 
baseline reset.

Total Lost Cells (lostCells/NUM) Total number of cells lost 
since activation.

Total Buffer Underflows (bufferUnderflows/NUM) Total number of buffer 
underflows since activation.
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Total Buffer Overflows (bufferOverflows/NUM) Total number of buffer 
overflows since activation.

Reassembled Cells per 
second

(reassembledCells/NUM)                      
DELTA SECONDS DIVIDE

Number of reassembled cells 
per second since the last 
probe.

Reassembled Cells since 
Baseline

(reassembledCells/NUM)                      
BASELINEDELTA

Number of reassembled cells 
since the last baseline reset.

Total Header Errors (headerErrors/NUM) Number of header errors 
accumulated.

Total Pointer Reframe 
Errors

(pointerReframes/NUM) Number of Pointer Reframes 
accumulated.

Total Pointer Parity Errors (pointerParityErrors/NUM) Number of Pointer Parity 
Errors accumulated.

Total AAL1 Sequence 
Errors

(aal1SequenceErrors/NUM) Number of Sequence Errors 
accumulated.

Total Misinserted Cells (misinsertedCells/NUM) Number of Misinserted Cells 
accumulated.

Table 3
Component: EM/ ARTG PNNI

Name Formula Meaning

Routing Attempts (routingAttempts/NUM)                      
DELTA

Counts the calls routed. PNNI 
indicates the switch has PNNI 
routing capability.

Routing Attempts since 
Baseline

(routingAttempts/NUM)                      
BASELINEDELTA                      
(successfulRoutingAttempts/NUM)                      
BASELINEDELTA ADD

Counts the calls routed since 
the last baseline reset. PNNI 
indicates  the switch has 
PNNI routing capability.
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Component: EM/ AAL1CES/

Name Formula Meaning

 (Sheet 2 of 2)
241-6001-031   14.3RSUP   



Appendix A Passport performance metrics   141
Failed Routing Attempts (failedRoutingAttempts/NUM)                      
DELTA

Counts the calls which were 
not successfully routed. PNNI 
indicates the switch has PNNI 
routing capability.

Failed Routing Attempts 
since Baseline

(failedRoutingAttempts/NUM)                      
BASELINEDELTA

Counts the calls which were 
not successfully routed since 
the last baseline reset. PNNI 
indicates the switch has PNNI 
routing capability.

Calls Rerouted (alternateRoutingAttempts/NUM)                      
DELTA

Counts the calls that were 
routed an alternate route. 
PNNI indicates the switch has 
PNNI routing capability.

Calls Rerouted since 
Baseline

(alternateRoutingAttempts/NUM)                      
BASELINEDELTA

Counts the calls that were 
routed an alternate route 
since the last baseline reset. 
PNNI indicates the switch has 
PNNI routing capability.

Table 4
Component: EM/ ATMIF/

Name Formula Meaning

K Tx Cells per minute (TransmittedCells/NUM)                      
DELTA                     
(txCell/NUM)                      
DELTA ADD SECONDS DIVIDE                      
6 MULTIPLY 100 DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (TransmittedCells/NUM)                      
BASELINEDELTA                      
(txCell/NUM)                      
BASELINEDELTA ADD                      
1000 DIVIDE

Kilocells sent since the last 
baseline reset.
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Table 3 (continued)
Component: EM/ ARTG PNNI

Name Formula Meaning
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K Rx Cells per minute (receivedCells/NUM)                      
DELTA                     
(rxCell/NUM)                      
DELTA ADD SECONDS DIVIDE                      
6 MULTIPLY 100 DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (receivedCells/NUM)                      
BASELINEDELTA                      
(rxCell/NUM)                      
BASELINEDELTA ADD                      
1000 DIVIDE

Kilocells received since the 
last baseline reset.

Dropped Rx Cells (droppedRxCells/NUM)                      
DELTA

Cells dropped.

Dropped Rx Cells since 
Baseline

(droppedRxCells/NUM)                      
BASELINEDELTA

Cells dropped since the last 
baseline reset.

Tx LinkUtilization (txLinkUtilization/NUM) Indicates the current transmit 
traffic rate over the most 
recent minute.

Rx LinkUtilization (rxLinkUtilization/NUM) Indicates the current receive 
traffic rate over the most 
recent minute.

Table 5
Component: EM/ ATMIF/ VCC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      
DELTA SECONDS                      
DIVIDE 6 MULTIPLY 100 DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA 1000 DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      
DELTA SECONDS DIVIDE 
6 MULTIPLY 100 DIVIDE

Kilocells received per minute.
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Component: EM/ ATMIF/

Name Formula Meaning
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K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA 1000 DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                     
DELTA SECONDS DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                    
DELTA SECONDS DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      
DELTA                     
(txCellDiscard/NUM)                      
DELTA ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA ADD

Sent cells discarded since the 
last baseline reset.

Frame Transmit Discards (txDiscard/NUM)                     
DELTA                      
(txFrameDiscard/NUM)                      
DELTA ADD

Send frames discarded.

Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      
DELTA                     
(rxCellDiscard/NUM)                      
DELTA ADD

Received cells discarded.

Table 5 (continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                     
DELTA                     
(rxFrameDiscard/NUM)                      
DELTA ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA ADD

Sent frames discarded at 
CLP.

Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA ADD

Sent frames discarded at CLP 
since the last baseline reset.

Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA ADD

Received cells discarded at 
CLP.

Table 5 (continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      
DELTA

Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                     
DELTA

Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 5 (continued)
Component: EM/ ATMIF/ VCC/

Name Formula Meaning
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Table 6
Component: EM/ ATMIF/ VPC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                    
DELTA SECONDS DIVIDE                      
6 MULTIPLY 100 DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA 1000 DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                    
DELTA SECONDS DIVIDE                      
6 MULTIPLY 100 DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA 1000 DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                     
DELTA SECONDS DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM) 
DELTA SECONDS DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                    
DELTA                      
(txCellDiscard/NUM)                      
DELTA ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA ADD

Sent cells discarded since the 
last baseline reset.

Frame Transmit Discards (txDiscard/NUM)                      
DELTA                     
(txFrameDiscard/NUM)                      
DELTA ADD

Send frames discarded.
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Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Table 6 (continued)
Component: EM/ ATMIF/ VPC/

Name Formula Meaning

 (Sheet 2 of 3)
Preside MDM Performance Management  User Guide   14.3RSUP



148   Appendix A Passport performance metrics
Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 6 (continued)
Component: EM/ ATMIF/ VPC/

Name Formula Meaning
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Table 7
Component: EM/ ATMIF/ VPT/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.

Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.
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Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Table 7 (continued)
Component: EM/ ATMIF/ VPT/

Name Formula Meaning

 (Sheet 2 of 3)
241-6001-031   14.3RSUP   



Appendix A Passport performance metrics   151
Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 7 (continued)
Component: EM/ ATMIF/ VPT/

Name Formula Meaning
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Table 8
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning

K Tx Cells per minute (txCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells sent per minute.

K Tx Cells since Baseline (txCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells sent since the last 
baseline reset.

K Rx Cells per minute (rxCell/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
6                      MULTIPLY                      
100                      DIVIDE

Kilocells received per minute.

K Rx Cells since Baseline (rxCell/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Kilocells received since the 
last baseline reset.

Tx Cells CLP per second (txCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells sent at CLP.

Tx Cells CLP since 
Baseline

(txCellClp/NUM)                      
BASELINEDELTA

Cells sent at CLP since the 
last baseline reset.

Rx Cells CLP per second (rxCellClp/NUM)                      DELTA                      
SECONDS                      DIVIDE

Cells received at CLP.

Rx Cells CLP since 
Baseline

(rxCellClp/NUM)                      
BASELINEDELTA

Cells received at CLP since 
the last baseline reset.

Cell Transmit Discards (txDiscard/NUM)                      DELTA                      
(txCellDiscard/NUM)                      
DELTA                      ADD

Sent cells discarded.

Cell Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded since the 
last baseline reset.

Frame Transmit Discards (txDiscard/NUM)                      DELTA                      
(txFrameDiscard/NUM)                      
DELTA                      ADD

Send frames discarded.
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Frame Transmit Discards 
since Baseline

(txDiscard/NUM)                      
BASELINEDELTA                      
(txFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Send frames discarded since 
the last baseline reset.

Cell Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxCellDiscard/NUM)                      
DELTA                      ADD

Received cells discarded.

Cell Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxCellDiscard/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded 
since the last baseline reset.

Frame Receive Discards (rxDiscard/NUM)                      DELTA                      
(rxFrameDiscard/NUM)                      
DELTA                      ADD

Received frames discarded.

Frame Receive Discards 
since Baseline

(rxDiscard/NUM)                      
BASELINEDELTA                      
(rxFrameDiscard/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
since the last baseline reset.

Cell Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txCellDiscardClp/NUM)                      
DELTA                      ADD

Sent cells discarded at CLP.

Cell Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent cells discarded at CLP 
since the last baseline reset.

Frame Transmit Discards 
CLP

(txDiscardClp/NUM)                      
DELTA                      
(txFrameDiscardClp/NUM)                      
DELTA                      ADD

Sent frames discarded at 
CLP.

Frame Transmit Discards 
CLP since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA                      
(txFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Sent frames discarded at CLP 
since the last baseline reset.

Table 8 (continued)
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning
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Cell Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA                      
(rxCellDiscardClp/NUM)                      
DELTA                      ADD

Received cells discarded at 
CLP.

Cell Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxCellDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received cells discarded at 
CLP since the last baseline 
reset.

Frame Receive Discards 
CLP

(rxDiscardClp/NUM)                      
DELTA                      
(rxFrameDiscardClp/NUM)                      
DELTA                      ADD

Received frames discarded at 
CLP.

Frame Receive Discards 
CLP since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA                      
(rxFrameDiscardClp/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded at 
CLP since the last baseline 
reset.

Transmit Discards (txDiscard/NUM)                      DELTA Sent cells discarded.

Transmit Discards since 
Baseline

(txDiscard/NUM)                      
BASELINEDELTA

Sent cells discarded since the 
last baseline reset.

Receive Discards (rxDiscard/NUM)                      DELTA Received cells discarded.

Receive Discards since 
Baseline

(rxDiscard/NUM)                      
BASELINEDELTA

Received cells discarded 
since the last baseline reset.

Transmit Discards CLP (txDiscardClp/NUM)                      
DELTA

Sent cells discarded at CLP.

Transmit Discards CLP 
since Baseline

(txDiscardClp/NUM)                      
BASELINEDELTA

Sent cells discarded at CLP 
since the last baseline reset.

Receive Discards CLP (rxDiscardClp/NUM)                      
DELTA

Received cells discarded at 
CLP.

Receive Discards CLP 
since Baseline

(rxDiscardClp/NUM)                      
BASELINEDELTA

Received cells discarded at 
CLP since the last baseline 
reset.

Table 8 (continued)
Component: EM/ ATMIF/ VPT/ VCC/

Name Formula Meaning
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Table 9
Component: EM/ ATMMPE/ AC/

Name Formula Meaning

In Packets/sec (inPackets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on this 
connection.

In Packets since Baseline (inPackets/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection since the last 
baseline reset.

In Octects/sec (inOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets received on this 
connection.

In Octects since Baseline (inOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets received on this 
connection since the last 
baseline reset.

In UnknownProtos/sec (inUnknownProtos/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol.

In UnknownProtos since 
Baseline

(inUnknownProtos/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol, since 
the last baseline reset.

In Errors/sec (inErrors/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol.
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In Errors since Baseline (inErrors/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol, since the last 
baseline reset.

Out Packets/sec (outPackets/NUM)                      
DELTA                      SECONDS                      
DIVIDE

outPackets

Out Packets since Baseline (outPackets/NUM)                      
BASELINEDELTA

outPackets since the last 
baseline reset.

Out Octects/sec (outOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets sent on this 
connection.

Out Octects since Baseline (outOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets sent on this connection 
since the last baseline reset.

Out Discards/sec (outDiscards/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down, 
since the last baseline reset.

Table 9 (continued)
Component: EM/ ATMMPE/ AC/

Name Formula Meaning
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Table 10
Component: EM/ BSSMIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not define.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 11
Component: EM/ BTDS/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
transmitted to the link 
interface by Framer, since 
last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link interface by 
Framer, since the last 
baseline reset.
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Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number or frames per second 
received from the link 
interface by Framer, since 
last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number or frames received 
from the link interface by 
Framer, since the last 
baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames received 
from the link interface with 
CRC errors, since last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames received 
from the link interface with 
CRC errors, since the last 
baseline reset.

Frame Lost in Network (frmLostInNetwork/NUM)                      
DELTA

Number of frames the service 
did not receive from the 
network, since last probe.

Frame Lost in Network 
since Baseline

(frmLostInNetwork/NUM)                      
BASELINEDELTA

Number of frames the service 
did not receive from the 
network, since the last 
baseline reset.

Frames Underruns (frmUnderRuns/NUM)                      
DELTA

Number of times a frame was 
needed but was not available 
because it was delayed too 
long in the network, since last 
probe.

Frames Underruns since 
Baseline

(frmUnderRuns/NUM)                      
BASELINEDELTA

Number of times a frame was 
needed but was not available 
because it was delayed too 
long in the network, since the 
last baseline reset.

Table 11 (continued)
Component: EM/ BTDS/ FRAMER

Name Formula Meaning
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Frame Dumped (frmDumped/NUM)                      
DELTA

Number of frames dumped 
because the local interface 
output queue was too large, 
since last probe.

Frame Dumped since 
Baseline

(frmDumped/NUM)                      
BASELINEDELTA

Number of frames dumped 
because the local interface 
output queue was too large, 
since the last baseline reset.

Table 12
Component: EM/ BTS/ BTSIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txOctets (txOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

txOctets since Baseline (txOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxOctets (rxOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxOctets since Baseline (rxOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.
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Table 11 (continued)
Component: EM/ BTDS/ FRAMER

Name Formula Meaning
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txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 13
Component: EM/ CIUIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txOctets (txOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

txOctets since Baseline (txOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxOctets (rxOctets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxOctets since Baseline (rxOctets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

 (Sheet 1 of 2)

Table 12 (continued)
Component: EM/ BTS/ BTSIF/

Name Formula Meaning

 (Sheet 2 of 2)
241-6001-031   14.3RSUP   



Appendix A Passport performance metrics   161
txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 14
Component: EM/ CRS

Name Formula Meaning

Redir Attempts / second (requestsReceived/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Provides a set of alternate 
destinations for the original 
address.

Redir Attempts since 
Baseline

(requestsReceived/NUM)                      
BASELINEDELTA

Provides a set of alternate 
destinations for the original 
address since the last 
baseline reset.

Table 15
Component: EM/ DISCOIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.
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txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 16
Component: EM/ DLEP/ DS1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Frame Errors (frmErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

Frame Errors since 
Baseline

(frmErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

SLIP Errors (slipErrors/NUM)                      DELTA The description for this metric 
is currently not defined.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 15 (continued)
Component: EM/ DISCOIF/

Name Formula Meaning
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Table 17
Component: EM/ DLEP/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) The description for this metric 
is currently not defined.

Tx Cell Util (transmitCellUtilization/NUM) The description for this metric 
is currently not defined.

Table 18
Component: EM/ DPNGATE/

Name Formula Meaning

Packets/sec from Interface (pktFromIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Packets from interface per 
second.

Packets from Interface 
since Baseline

(pktFromIf/NUM)                      
BASELINEDELTA

Packets from interface since 
the last baseline reset.

Trunk Pks/s to Interface (trunkPktToIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Trunk packets to interface per 
second.

Trunk Pks to Interface 
since Baseline

(trunkPktToIf/NUM)                      
BASELINEDELTA

Trunk packets to interface 
since the last baseline reset.

Trunk Pks/s from Interface (trunkPktFromIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Trunk packets from interface 
per second.

Trunk Pks from Interface 
since Baseline

(trunkPktFromIf/NUM)                      
BASELINEDELTA

Trunk packets from interface 
since the last baseline reset.

Discarded packets/sec (discardUnforward/NUM)                      
DELTA SECONDS                      
DIVIDE

Discarded packets per 
second.
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Discarded packets since 
Baseline

(discardUnforward/NUM)                      
BASELINEDELTA

Discarded packets since the 
last baseline reset.

Round trip delay (ms) (measuredRoundTripDelay/NUM) Round trip delay in 
millisecond measured by the 
DPN Gateway.

Table 19
Component: EM/ DPNGATE/ UTP FRAMER

Name Formula Meaning

Frames per second to 
Interface

(frmToIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Frames sent per second.

Frames to Interface since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second from 
Interface

(frmFromIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.
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Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 20
Component: EM/ FRATM/ DLCI/

Name Formula Meaning

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
received from the interface 
since last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the interface since the 
last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Number of frames received 
from the interface with the 
Discard Eligibility (DE) bit set 
since last probe.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the interface with the 
Discard Eligibility (DE) bit set, 
since the last baseline reset.
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Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of frames, received 
from the interface with the 
Discard Eligibility (DE) bit 
clear, but subsequently set by 
the network due to rate 
enforcement, since the last 
probe.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames, received 
from the interface with the 
Discard Eligibility (DE) bit 
clear, but subsequently set by 
the network due to rate 
enforcement, since the last 
baseline reset.

Discard Excess Received 
per second

(discExcessFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of frames discarded 
due to rate enforcement. 

Discard Excess Received 
since Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Number of frames discarded 
due to rate enforcement, 
since the last baseline reset.

Discarded Frame A bit (discFrameAbit/NUM)                      
DELTA

Number of frames discarded 
at the Frame Relay Service 
due to an inactive PVC status 
in the direction toward the 
interworking function, since 
last probe.

Discarded Frame A bit 
since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Number of frames discarded 
at the Frame Relay Service 
due to an inactive PVC status 
in the direction toward the 
interworking function, since 
the last baseline reset.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Congested Frames 
Received Discarded

(discCongestedFromI/NUM)                      
DELTA

Number of frames discarded 
at the Frame Relay Service 
due to local congestion in the 
direction toward the 
interworking funcion, since 
last probe.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromI/NUM)                      
BASELINEDELTA

Number of frames discarded 
at the Frame Relay Service 
due to local congestion in the 
direction toward the 
interworking funcion, since 
the last baseline reset.

Error short Frame 
Received

(errorShortFrmFromI/NUM)                      
DELTA

Number of frames received 
with 0 octets in the 
information field, since last 
probe.

Error short Frame 
Received since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
with 0 octets in the 
information field, since the 
last baseline reset.

Error Long Frame 
Received

(errorLongFrmFromIf/NUM)                      
DELTA

Number of frames received 
with the number of octets in 
the information field greater 
than the subscribed 
maximum, since last probe.

Error Long Frame 
Received since Baseline

(errorLongFrmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
with the number of octets in 
the information field greater 
than the subscribed 
maximum, since the last  
baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      
DELTA                      1000                      
DIVIDE

Number of bytes sent out to 
the interface, since last probe.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of bytes sent out to 
the interface since the last 
baseline reset.

DE bytes (deBytesToIf/NUM)                      
DELTA

Number of bytes sent to the 
interface with Discard 
Eligibility (DE) bit set.

DE bytes since Baseline (deBytesToIf/NUM)                      
BASELINEDELTA

Number of bytes sent to the 
interface with Discard 
Eligibility (DE) bit set, since 
the last baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA                      1000                      
DIVIDE

Number of bytes received 
from the interface.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of bytes received 
from the interface since the 
last baseline reset.

DE bytes received per 
second

(deBytesFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of bytes per second 
received from the interface 
with Discard Eligibility (DE) bit 
set.

DE bytes received since 
Baseline

(deBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
from the interface with 
Discard Eligibility (DE) bit set, 
since the last baseline reset.

Excess bytes received per 
second

(excessBytesFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of bytes per second 
received from the interface 
with the Discard Eligibility 
(DE) bit clear but 
sebsequently set by the 
network due to rate 
enforcement, since last 
probe.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Excess bytes received 
since Baseline

(excessBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
from the interface with the 
Discard Eligibility (DE) bit 
clear but sebsequently set by 
the network due to  rate 
enforcement, since the last 
baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIfBy/NUM)                      
DELTA

Number of bytes discarded 
due to rate enforcement, 
since last probe.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Number of bytes discarded 
due to rate enforcement since 
the last baseline reset.

Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Number of bytes discarded 
due to the A bit being turned 
off, since last probe.

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Number of bytes discarded 
due to the A bit being turned 
off since the  last baseline 
reset.

Discarded congested 
received

(discCongestedFromI/NUM)                      
DELTA

Number of bytes discarded at 
the Frame Relay service due 
to local congestion in the 
direction toward the 
interworking function, since 
last probe.

Discarded congested 
received since Baseline

(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA

Number of bytes discarded at 
the Frame Relay service due 
to local congestion in the 
direction toward the 
interworking function, since 
the last baseline reset.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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DE Discarded congested 
received

(discDeCongestedFro/NUM)                      
DELTA

Number of bytes discarded 
with Discard Eligibility set due 
to local congestion in the 
direction toward the 
interworking fucntion, since 
last probe.

DE Discarded congested 
received since Baseline

(discDeCongestedFromIfBytes/
NUM)                      BASELINEDELTA

Number of bytes discarded 
with Discard Eligibility set due 
to local congestion in the 
direction toward the 
interworking fucntion, since 
the last baseline reset.

Error Long Bytes received (errorLongBytesFrom/NUM)                      
DELTA

Number of bytes received 
when the number of octets in 
the information  field is 
greater than the subscribed 
maximum, since last probe.

Error Long Bytes received 
since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Number of bytes received 
when the number of octets in 
the information  field is 
greater than the subscribed 
maximum, since the last 
baseline  reset.

Total Ingress Bytes (totalIngressBytes/NUM)                      
DELTA

Total payload bytes in 
received from link since the 
start of interval.

Total Ingress Bytes since 
Baseline

(totalIngressBytes/NUM)                      
BASELINEDELTA

Total payload bytes in 
received from link since the 
last baseline reset.

Total Egress Bytes (totalEgressBytes/NUM)                      
DELTA

Total payload bytes sent to 
link since start of interval.

Total Egress Bytes since 
Baseline

(totalEgressBytes/NUM)                      
BASELINEDELTA

Total payload bytes sent to 
link since the last baseline 
reset.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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EIR Ingress Bytes (eirIngressBytes/NUM)                      
DELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set to 1 received 
from link since start of 
interval.

EIR Ingress Bytes since 
Baseline

(eirIngressBytes/NUM)                      
BASELINEDELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set to 1 received 
from link, since the last 
baseline reset.

EIR Egress Bytes (eirEgressBytes/NUM)                      
DELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set sent to link since 
start of interval.

EIR Egress Bytes since 
Baseline

(eirEgressBytes/NUM)                      
BASELINEDELTA

Total valid payload bytes in 
frames with Discard Eligibility 
(DE) bit  set sent to link, since 
the last baseline reset.

Discarded Bytes (discardedBytes/NUM)                      
DELTA

Total payload bytes in invalid 
frames received from the link 
and siscarded at the DLCI 
since start of interval.

Discarded Bytes since 
Baseline

(discardedBytes/NUM)                      
BASELINEDELTA

Total payload bytes in invalid 
frames received from the link 
and siscarded at the DLCI, 
since the last baseline reset.

Total Ingress frames (totalIngressFrames/NUM)                      
DELTA

Total number of frames 
received from the link since 
start of interval.

Total Ingress frames since 
Baseline

(totalIngressFrames/NUM)                      
BASELINEDELTA

Total number of frames 
received from the link since 
the last baseline  reset.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Total Egress frames (totalEgressFrames/NUM)                      
DELTA

Total number of frames sent 
to the link since the start of 
interval.

Total Egress frames since 
Baseline

(totalEgressFrames/NUM)                      
BASELINEDELTA

Total number of frames sent 
to the link since the last 
baseline reset.

EIR Ingress frames (eirIngressFrames/NUM)                      
DELTA

Number of valid frames with 
Discard Eligibility set to 1, 
received from link since start 
of interval.

EIR Ingress frames since 
Baseline

(eirIngressFrames/NUM)                      
BASELINEDELTA

Number of valid frames with 
Discard Eligibility set to 1, 
received from link, since the 
last baseline reset.

EIR Egress frames (eirEgressFrames/NUM)                      
DELTA

Number of frames with 
Discard Eligibility bit set sent 
to the link since start of 
interval.

EIR Egress frames since 
Baseline

(eirEgressFrames/NUM)                      
BASELINEDELTA

Number of frames with 
Discard Eligibility bit set sent 
to the link, since the last 
baseline reset.

Discarded Frames (discardedFrames/NUM)                      
DELTA

Number of invalid frames 
received from the links and 
discarded at the  DLCI.

Discarded Frames since 
Baseline

(discardedFrames/NUM)                      
BASELINEDELTA

Number of invalid frames 
received from the links and 
discarded at the  DLCI, since 
the last baseline reset.

Table 20 (continued)
Component: EM/ FRATM/ DLCI/

Name Formula Meaning
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Table 21
Component: EM/ FRATM/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

The number of frames per 
second transmitted to the link 
interface by Framer since last 
probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

The number of frames 
transmitted to the link 
interface by Framer since the 
last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

The number of frames 
received from the link 
interface by Framer since the 
last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

The number of frames 
received from the link 
interface by Framer since  the 
last baseline reset.

CRC Errors (crcErrors/NUM)                      DELTA Number of frames with CRC 
errors occurring in the receive 
direction from the link since 
the last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of frames with CRC 
errors occurring in the receive 
direction from the link, since 
the last baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames with LRC 
errors occurring in the Tx link 
prior to transmission onto the 
link since the last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames with LRC 
errors occurring in the Tx link 
prior to transmission onto the 
link, since the last baseline 
reset.
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Overruns (overruns/NUM)                      DELTA Number of frames received 
from the link for which 
overruns occurred since last 
probe.

Overruns since Baseline (overruns/NUM)                      
BASELINEDELTA

Number of frames received 
from the link for which 
overruns occurred, since the 
last baseline reset.

Underruns (underruns/NUM)                      DELTA Number of frames transmitted 
to the link for which underruns 
occurred since last probe.

Underruns since Baseline (underruns/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link for which underruns 
occurred, since the last 
baseline reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of frames received 
that were too large since last 
probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of frames received 
that were too large since the 
last baseline  reset.

Table 22
Component: EM/ FRDTE/ DLCI/

Name Formula Meaning

Frames per second Sent (sentFrames/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(sentFrames/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.
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Frames per second 
Received

(receivedFrames/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(receivedFrames/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (sentOctets/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(sentOctets/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (receivedOctets/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(receivedOctets/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

FECN Frames Received (receivedFECNs/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(receivedFECNs/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.

BECN Frames Received (receivedBECNs/NUM)                      
DELTA

Frames received with BECN 
bit set.

BECN Frames Received 
since Baseline

(receivedBECNs/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

Table 22 (continued)
Component: EM/ FRDTE/ DLCI/

Name Formula Meaning
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Table 23
Component: EM/ FRDTE/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 24
Component: EM/ FRDTE/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 25
Component: EM/ FRNNI/

Name Formula Meaning

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 
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Frames To I/F (frmToIfByQueue[0]/NUM)                      
DELTA                      
(frmToIfByQueue[1]/NUM)                      
DELTA                      
(frmToIfByQueue[2]/NUM)                      
DELTA                      
(frmToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues.

Frames To I/F since 
Baseline

(frmToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Octecs To I/F (octetToIfByQueue[0]/NUM)                      
DELTA                      
(octetToIfByQueue[1]/NUM)                      
DELTA                      
(octetToIfByQueue[2]/NUM)                      
DELTA                      
(octetToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues.

Octecs To I/F since 
Baseline

(octetToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

 (continued)Table 25
Component: EM/ FRNNI/

Name Formula Meaning
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Table 25
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      DELTA                      
1000                      DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA                      1000                      
DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

Average Payload Size Sent (bytesToIf/NUM)                      DELTA                      
(frmToIf/NUM)                      DELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface.

Average Payload Size Sent 
since Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      
(frmToIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface since the  last 
baseline reset.

Average Payload Size 
Received

(bytesFromIf/NUM)                      
DELTA                      (frmFromIf/NUM)                      
DELTA                      DIVIDE

Average size of frames in 
bytes received from the 
interface.
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Average Payload Size 
Received since Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      
(frmFromIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes received from the 
interface since the  last 
baseline reset.

Kilobits per second Sent (bytesToIf/NUM)                      DELTA                      
8                      MULTIPLY                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Kilobits per second sent.

Kilobits Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent since the last 
baseline reset.

Kilobits per second 
Received

(bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits per second received.

Kilobits Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received since the 
last baseline reset.

Rx Utilization (% of CIR) (bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      
(committedInformationRate/NUM)                      
PERCENT

Percentage of CIR used 
receiving.

Tx Bytes Discarded (discCongestedToIfBytes/NUM)                      
DELTA

Bytes sent dropped due to 
congestion.

Tx Bytes Discarded since 
Baseline

(discCongestedToIfBytes/NUM)                      
BASELINEDELTA

Bytes sent dropped due to 
congestion since the last 
baseline reset.

Table 25 (continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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Rx Bytes Discarded (discExcessFromIfBytes/NUM)                      
DELTA                      (discByteAbit/
NUM)                      DELTA                      
ADD                      
(discCongestedFromIfBytes/NUM)                      
DELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
DELTA                      ADD

Bytes received dropped.

Rx Bytes Discarded since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA                      
(discByteAbit/NUM)                      
BASELINEDELTA                      ADD                      
(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
BASELINEDELTA                      ADD

Bytes received dropped since 
the last baseline reset.

Frame Discards due to A 
equals 0

(discFrameAbit/NUM)                      
DELTA

Received frames discarded 
due to zero A bit.

Frame Discards due to A 
equals 0 since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Received frames discarded 
due to zero A bit since the last 
baseline reset.

Frame Discards due to 
Frame Error

(errorShortFrmFromIf/NUM)                      
DELTA                      
(errorLongFrmFromIf/NUM)                      
DELTA                      ADD

Received frames discarded 
due to length errors.

Frame Discards due to 
Frame Error since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA                      
(errorLongFrmFromIf/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
due to length errors since the 
last baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIf/NUM)                      
DELTA

Received frames discarded 
by rate enforcement.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
by rate enforcement since the 
last baseline  reset.

Table 25 (continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning

 (Sheet 3 of 5)
Preside MDM Performance Management  User Guide   14.3RSUP



182   Appendix A Passport performance metrics
Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Received Bytes discarded 
due to zero A bit. 

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to zero A bit since the last 
baseline reset.

Byte Discards due to 
Frame Error

(errorLongBytesFromIf/NUM)                      
DELTA

Received Bytes discarded 
due to frame length error.

Byte Discards due to 
Frame Error since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to frame length error 
since the last baseline reset.

Byte Discards for Rate 
Enforcement

(discExcessFromIfBytes/NUM)                      
DELTA

Received bytes discarded by 
rate enforcement.

Byte Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Received bytes discarded by 
rate enforcement since the 
last baseline reset.

FECN Frames Sent (fecnFrmToIf/NUM)                      
DELTA

Frames sent with FECN bit 
set.

FECN Frames Sent since 
Baseline

(fecnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with FECN bit 
set since the last baseline 
reset.

FECN Frames Received (fecnFrmFromIf/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(fecnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.

BECN Frames Sent (becnFrmToIf/NUM)                      
DELTA

Frames sent with BECN bit 
set.

BECN Frames Sent since 
Baseline

(becnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with BECN bit 
set since the last baseline 
reset.

BECN Frames Received (becnFrmFromIf/NUM)                      
DELTA

Frames received with BECN 
bit set.

Table 25 (continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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BECN Frames Received 
since Baseline

(becnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

DE Frames Sent (deFrmToIf/NUM)                      
DELTA

Frames sent with DE bit set.

DE Frames Sent since 
Baseline

(deFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with DE bit set 
since the last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Frames received with DE bit 
set.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with DE bit 
set since the last baseline 
reset.

Congested Frames Sent 
Discarded

(discCongestedToIf/NUM)                      
DELTA

Sent frames discarded due to 
congestion.

Congested Frames Sent 
Discarded since Baseline

(discCongestedToIf/NUM)                      
BASELINEDELTA

Sent frames discarded due to 
congestion since the last 
baseline reset.

Congested Frames 
Received Discarded

(discCongestedFromIf/NUM)                      
DELTA

Received frames discarded 
due to congestion.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
due to congestion since the 
last baseline reset.

Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of excess frames.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of excess frames 
since the last baseline reset.

Table 25 (continued)
Component: EM/ FRNNI/ DLCI/

Name Formula Meaning
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Table 26
Component: EM/ FRNNI/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 27
Table 28Component: EM/ FRNNI/ LMI

Name Formula Meaning

Status Reports Tx (keepAliveStatusToIf/NUM)                      
DELTA                      (fullStatusToIf/
NUM)                      DELTA                      
ADD

Number of status reports sent 
since last probe.

Status Reports Tx since 
Baseline

(keepAliveStatusToIf/NUM)                      
BASELINEDELTA                      
(fullStatusToIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports sent 
since the last baseline reset.

Status Enquiries Rx (keepAliveSeFromIf/NUM)                      
DELTA                      
(fullStatEnqFromIf/NUM)                      
DELTA                      ADD

Number of status reports 
received since last probe.

Status Enquiries Rx since 
Baseline

(keepAliveSeFromIf/NUM)                      
BASELINEDELTA                      
(fullStatEnqFromIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports 
received since the last 
baseline reset.

Sequence Number 
Mismatches

(sequenceErrors/NUM) Number of Status enquiries 
with a sequence error.

Invalid Requests (unexpectedIes/NUM) Number of frames received 
with an unknown/unexpected 
IES.

Timeouts (pollingVerifTimeouts/NUM)                      
(noStatusReportCount/NUM)                      
ADD

Number of checkPointTimer 
expired.
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Table 29
Component: EM/ FRNNI/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 30
Component: EM/ FRUNI/

Name Formula Meaning

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 
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Frames To I/F (frmToIfByQueue[0]/NUM)                      
DELTA                      
(frmToIfByQueue[1]/NUM)                      
DELTA                      
(frmToIfByQueue[2]/NUM)                      
DELTA                      
(frmToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues.

Frames To I/F since 
Baseline

(frmToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(frmToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of frames transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Octecs To I/F (octetToIfByQueue[0]/NUM)                      
DELTA                      
(octetToIfByQueue[1]/NUM)                      
DELTA                      
(octetToIfByQueue[2]/NUM)                      
DELTA                      
(octetToIfByQueue[3]/NUM)                      
DELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues.

Octecs To I/F since 
Baseline

(octetToIfByQueue[0]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[1]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[2]/NUM)                      
BASELINEDELTA                      
(octetToIfByQueue[3]/NUM)                      
BASELINEDELTA                      ADD                      
ADD                      ADD

Number of octets transmitted 
to the interface through all 
egress queues since the last 
baseline reset.

Table 30 (continued)
Component: EM/ FRUNI/

Name Formula Meaning
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Table 31
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      
DELTA SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                     
DELTA SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Kilobytes Sent (bytesToIf/NUM)                      
DELTA 1000 DIVIDE

KiloBytes sent since the last 
probe.

Kilobytes Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes sent since the last 
baseline reset.

Kilobytes Received (bytesFromIf/NUM)                      
DELTA 1000 DIVIDE

KiloBytes received since the 
last probe.

Kilobytes Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

KiloBytes received since the 
last baseline reset.

Average Payload Size Sent (bytesToIf/NUM)                      DELTA                      
(frmToIf/NUM)                      
DELTA                      DIVIDE

Average size of frames in 
bytes sent out from the 
interface.

Average Payload Size Sent 
since Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      
(frmToIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes sent out from the 
interface since the  last 
baseline reset.

Average Payload Size 
Received

(bytesFromIf/NUM)                      
DELTA                      (frmFromIf/NUM)                      
DELTA                      DIVIDE

Average size of frames in 
bytes received from the 
interface.
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Average Payload Size 
Received since Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      
(frmFromIf/NUM)                      
BASELINEDELTA                      
DIVIDE

Average size of frames in 
bytes received from the 
interface since the  last 
baseline reset.

Kilobits per second Sent (bytesToIf/NUM)                      DELTA                      
8                      MULTIPLY                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Kilobits per second sent.

Kilobits Sent since 
Baseline

(bytesToIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent since the last 
baseline reset.

Kilobits per second 
Received

(bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits per second received.

Kilobits Received since 
Baseline

(bytesFromIf/NUM)                      
BASELINEDELTA                      8                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received since the 
last baseline reset.

Rx Utilization (% of CIR) (bytesFromIf/NUM)                      
DELTA                      8                      
MULTIPLY                      SECONDS                      
DIVIDE                      
(committedInformationRate/NUM)                      
PERCENT

Percentage of CIR used 
receiving.

Tx Bytes Discarded (discCongestedToIfBytes/NUM)                      
DELTA

Bytes sent dropped due to 
congestion.

Tx Bytes Discarded since 
Baseline

(discCongestedToIfBytes/NUM)                      
BASELINEDELTA

Bytes sent dropped due to 
congestion since the last 
baseline reset.

Table 31 (continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Rx Bytes Discarded (discExcessFromIfBytes/NUM)                      
DELTA                      (discByteAbit/
NUM)                      DELTA                      
ADD                      
(discCongestedFromIfBytes/NUM)                      
DELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
DELTA                      ADD

Bytes received dropped.

Rx Bytes Discarded since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA                      
(discByteAbit/NUM)                      
BASELINEDELTA                      ADD                      
(discCongestedFromIfBytes/NUM)                      
BASELINEDELTA                      ADD                      
(errorLongBytesFromIf/NUM)                      
BASELINEDELTA                      ADD

Bytes received dropped since 
the last baseline reset.

Frame Discards due to A 
equals 0

(discFrameAbit/NUM)                      
DELTA

Received frames discarded 
due to zero A bit.

Frame Discards due to A 
equals 0 since Baseline

(discFrameAbit/NUM)                      
BASELINEDELTA

Received frames discarded 
due to zero A bit since the last 
baseline reset.

Frame Discards due to 
Frame Error

(errorShortFrmFromIf/NUM)                      
DELTA                      
(errorLongFrmFromIf/NUM)                      
DELTA                      ADD

Received frames discarded 
due to length errors.

Frame Discards due to 
Frame Error since Baseline

(errorShortFrmFromIf/NUM)                      
BASELINEDELTA                      
(errorLongFrmFromIf/NUM)                      
BASELINEDELTA                      ADD

Received frames discarded 
due to length errors since the 
last baseline reset.

Frame Discards for Rate 
Enforcement

(discExcessFromIf/NUM)                      
DELTA

Received frames discarded 
by rate enforcement.

Frame Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
by rate enforcement since the 
last baseline  reset.

Table 31 (continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Byte Discards due to A 
equals 0

(discByteAbit/NUM)                      
DELTA

Received Bytes discarded 
due to zero A bit. 

Byte Discards due to A 
equals 0 since Baseline

(discByteAbit/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to zero A bit since the last 
baseline reset.

Byte Discards due to 
Frame Error

(errorLongBytesFromIf/NUM)                      
DELTA

Received Bytes discarded 
due to frame length error.

Byte Discards due to 
Frame Error since Baseline

(errorLongBytesFromIf/NUM)                      
BASELINEDELTA

Received Bytes discarded 
due to frame length error 
since the last baseline reset.

Byte Discards for Rate 
Enforcement

(discExcessFromIfBytes/NUM)                      
DELTA

Received bytes discarded by 
rate enforcement.

Byte Discards for Rate 
Enforcement since 
Baseline

(discExcessFromIfBytes/NUM)                      
BASELINEDELTA

Received bytes discarded by 
rate enforcement since the 
last baseline reset.

FECN Frames Sent (fecnFrmToIf/NUM)                      
DELTA

Frames sent with FECN bit 
set.

FECN Frames Sent since 
Baseline

(fecnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with FECN bit 
set since the last baseline 
reset.

FECN Frames Received (fecnFrmFromIf/NUM)                      
DELTA

Frames received with FECN 
bit set.

FECN Frames Received 
since Baseline

(fecnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with FECN 
bit set since the last baseline 
reset.

BECN Frames Sent (becnFrmToIf/NUM)                      
DELTA

Frames sent with BECN bit 
set.

BECN Frames Sent since 
Baseline

(becnFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with BECN bit 
set since the last baseline 
reset.

BECN Frames Received (becnFrmFromIf/NUM)                      
DELTA

Frames received with BECN 
bit set.

Table 31 (continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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BECN Frames Received 
since Baseline

(becnFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with BECN 
bit set since the last baseline 
reset.

DE Frames Sent (deFrmToIf/NUM)                      
DELTA

Frames sent with DE bit set.

DE Frames Sent since 
Baseline

(deFrmToIf/NUM)                      
BASELINEDELTA

Frames sent with DE bit set 
since the last baseline reset.

DE Frames Received (deFrmFromIf/NUM)                      
DELTA

Frames received with DE bit 
set.

DE Frames Received since 
Baseline

(deFrmFromIf/NUM)                      
BASELINEDELTA

Frames received with DE bit 
set since the last baseline 
reset.

Congested Frames Sent 
Discarded

(discCongestedToIf/NUM)                      
DELTA

Sent frames discarded due to 
congestion.

Congested Frames Sent 
Discarded since Baseline

(discCongestedToIf/NUM)                      
BASELINEDELTA

Sent frames discarded due to 
congestion since the last 
baseline reset.

Congested Frames 
Received Discarded

(discCongestedFromIf/NUM)                      
DELTA

Received frames discarded 
due to congestion.

Congested Frames 
Received Discarded since 
Baseline

(discCongestedFromIf/NUM)                      
BASELINEDELTA

Received frames discarded 
due to congestion since the 
last baseline reset.

Excess Frames Received (excessFrmFromIf/NUM)                      
DELTA

Number of excess frames.

Excess Frames Received 
since Baseline

(excessFrmFromIf/NUM)                      
BASELINEDELTA

Number of excess frames 
since the last baseline reset.

Table 31 (continued)
Component: EM/ FRUNI/ DLCI/

Name Formula Meaning
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Table 32
Component: EM/ FRUNI/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 33
Component: EM/ FRUNI/ LMI

Name Formula Meaning

Status Reports Tx (keepAliveStatusToIf/NUM)                      
DELTA                      (fullStatusToIf/
NUM)                      DELTA                      
ADD

Number of status reports sent 
since last probe.

Status Reports Tx since 
Baseline

(keepAliveStatusToIf/NUM)                      
BASELINEDELTA                      
(fullStatusToIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports sent 
since the last baseline reset.

Status Enquiries Rx (keepAliveSeFromIf/NUM)                      
DELTA                      
(fullStatEnqFromIf/NUM)                      
DELTA                      ADD

Number of status reports 
received since last probe.

Status Enquiries Rx since 
Baseline

(keepAliveSeFromIf/NUM)                      
BASELINEDELTA                      
(fullStatEnqFromIf/NUM)                      
BASELINEDELTA                      ADD

Number of status reports 
received since the last 
baseline reset.

Sequence Number 
Mismatches

(sequenceErrors/NUM) Number of Status enquiries 
with a sequence error.

Invalid Requests (unexpectedIes/NUM) Number of frames received 
with an unknown/unexpected 
IES.

Timeouts (pollingVerifTimeouts/NUM)                      
(noStatusReportCount/NUM)                      
ADD

Number of checkPointTimer 
expired.
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Table 34
Component: EM/ FRUNI/ VFRAMER

Name Formula Meaning

Frames per second Sent (frmToOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToOtherVFramer/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromOtherVFramer/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromOtherVFramer/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Table 35
Component: EM/ HTDS/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
transmitted to the link 
interface by Framer, since 
last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames per second 
transmitted to the link 
interface by Framer, since the 
last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames per second 
received from the link 
interface by Framer, since 
last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
from the link interface by 
Framer, since the last 
baseline reset.

CRC Errors (crcErrors/NUM)                      DELTA Number of frames with CRC 
errors, since last probe.
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CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of frames with CRC 
errors since the last baseline 
reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of frames with LRC 
errors, since last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of frames with LRC 
errors since the last baseline 
reset.

Overruns (overruns/NUM)                      DELTA Number of frames received 
from the link for which 
overruns occurred, since last 
probe.

Overruns since Baseline (overruns/NUM)                      
BASELINEDELTA

Number of frames received 
from the link for which 
overruns occurred, since the 
last baseline reset.

Underruns (underruns/NUM)                      DELTA Number of frames transmitted 
to the link for which underruns 
occurred, since last probe.

Underruns since Baseline (underruns/NUM)                      
BASELINEDELTA

Number of frames transmitted 
to the link for which underruns 
occurred, since the last 
baseline reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of frames received 
that were too large, since last 
probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of frames received 
that were too large since the 
last baseline  reset.

Table 35 (continued)
Component: EM/ HTDS/ FRAMER

Name Formula Meaning
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Table 36
Component: EM/ ISSHOIF/

Name Formula Meaning

txPackets (txPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

txPackets since Baseline (txPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPackets (rxPackets/NUM)                      DELTA The description for this metric 
is currently not defined.

rxPackets since Baseline (rxPackets/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

txPacketDiscards (txPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

txPacketDiscards since 
Baseline

(txPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

rxPacketDiscards (rxPacketDiscards/NUM)                      
DELTA

The description for this metric 
is currently not defined.

rxPacketDiscards since 
Baseline

(rxPacketDiscards/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 37
Component: EM/ LP/

Name Formula Meaning

CPU Utilization (%) (cpuUtil/NUM) CPU utilization.

Fast Ram Memory 
Utilization (%)

(memoryUsage[0]/NUM)                      
(memoryCapacity[0]/NUM)                      
PERCENT

Fast ram memory utilization.

Normal Ram Memory 
Utilization (%)

(memoryUsage[1]/NUM)                      
(memoryCapacity[1]/NUM)                      
PERCENT

Normal ram memory 
utilization.

Shared Ram Memory 
Utilization (%)

(memoryUsage[2]/NUM)                      
(memoryCapacity[2]/NUM)                      
PERCENT

Shared ram memory 
utilization.
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Shared Msg Block 
Utilization (%)

(sharedMsgBlockUsage/NUM)                      
(sharedMsgBlockCapacity/NUM)                      
PERCENT

Shared message block 
utilization.

Local Msg Block Utilization 
(%)

(localMsgBlockUsage/NUM)                      
(localMsgBlockCapacity/NUM)                      
PERCENT

Local message block 
utilization.

Table 38
Component: EM/ LP/ ARU/

Name Formula Meaning

Tx Cell Block Util (%) (txCellBlockUsage/NUM)                      
(txCellBlockCapacity/NUM)                      
PERCENT

Sending cell block utilization.

Rx Cell Block Util (%) (rxCellBlockUsage/NUM)                      
(rxCellBlockCapacity/NUM)                      
PERCENT

Receiving cell block 
utilization.

Tx Frame Block Util (%) (txFrameBlockUsage/NUM)                      
(txFrameBlockCapacity/NUM)                      
PERCENT

Sending frame block 
utilization.

Rx Frame Block Util (%) (rxFrameBlockUsage/NUM)                      
(rxFrameBlockCapacity/NUM)                      
PERCENT

Receiving frame block 
utilization.

Table 39
Component: EM/ LP/ DS1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA Number of CRC errors since 
last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of CRC errors since 
the last baseline reset.
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Component: EM/ LP/

Name Formula Meaning
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Frame Errors (frameErrors/NUM)                      
DELTA

Number of frame errors since 
last probe.

Frame Errors since 
Baseline

(frameErrors/NUM)                      
BASELINEDELTA                      
(frmErrors/NUM)                      
BASELINEDELTA                      ADD

Number of frame errors since 
the last baseline reset.

SLIP Errors (slipErrors/NUM)                      DELTA Number of SLIP errors since 
last probe.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

Number of SLIP errors since 
the last baseline reset.

Table 40
Component: EM/ LP/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 41
Component: EM/ LP/ DS3/

Name Formula Meaning

Line Failures (lineFailures/NUM)                      
DELTA

Number of line failures since 
last probe.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Number of line failures since 
the last baseline reset.
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Component: EM/ LP/ DS1/

Name Formula Meaning

 (Sheet 2 of 2)
Preside MDM Performance Management  User Guide   14.3RSUP



200   Appendix A Passport performance metrics
Path Failures (pathFailures/NUM)                      
DELTA

Number of path failures since 
last probe.

Path Failures since 
Baseline

(pathFailures/NUM)                      
BASELINEDELTA

Number of path failures since 
the last baseline reset.

Table 42
Component: EM/ LP/ DS3/ CBIT

Name Formula Meaning

C bit Error Free Second (cbitErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
DS3 port has not suffered any 
C Bit errors.

C bit Error Free Second 
since Baseline

(cbitErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
DS3 port has not suffered any 
C Bit errors, since the last 
baseline reset.

C bit code violations (cbitCodeViolations/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Rate of C bit code violdations 
since last probe.

C bit code violations since 
Baseline

(cbitCodeViolations/NUM)                      
BASELINEDELTA

Number of C bit code 
violdations since the last 
baseline reset.

C bit Errors Second (cbitErroredSec/NUM)                      
DELTA

Number of seconds sufferred 
from C Bit Parity Errored.

C bit Errors Second since 
Baseline

(cbitErroredSec/NUM)                      
BASELINEDELTA

Number of seconds sufferred 
from C Bit Parity Errored, 
since the last  baseline reset.

C bit Severe Error Second (cbitSevErroredSec/NUM)                      
DELTA

Number of seconds suffered 
C bit severe errors.

C bit Severe Error Second 
since Baseline

(cbitSevErroredSec/NUM)                      
BASELINEDELTA

Number of seconds suffered 
C bit severe errors, since the 
last baseline reset.
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Component: EM/ LP/ DS3/

Name Formula Meaning
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C bit Unavailable Second (cbitUnavailSec/NUM)                      
DELTA

Number of seconds which 
DS3 is unavailable.

C bit Unavailable Second 
since Baseline

(cbitUnavailSec/NUM)                      
BASELINEDELTA

Number of seconds which 
DS3 is unavailable since the 
last baseline reset.

Table 43
Component: EM/ LP/ DS3/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 44
Component: EM/ LP/ DS3/ DS1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 42 (continued)
Component: EM/ LP/ DS3/ CBIT

Name Formula Meaning
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Table 45
Component: EM/ LP/ E1/

Name Formula Meaning

CRC Errors (crcErrors/NUM)                      DELTA Number of CRC errors since 
last probe.

CRC Errors since Baseline (crcErrors/NUM)                      
BASELINEDELTA

Number of CRC errors since 
the last baseline reset.

Frame Errors (frameErrors/NUM)                      
DELTA

Number of frame errors since 
last probe.

Frame Errors since 
Baseline

(frameErrors/NUM)                      
BASELINEDELTA                      
(frmErrors/NUM)                      
BASELINEDELTA                      ADD

Number of frame errors since 
the last baseline reset.

SLIP Errors (slipErrors/NUM)                      DELTA Number of SLIP errors since 
last probe.

SLIP Errors since Baseline (slipErrors/NUM)                      
BASELINEDELTA

Number of SLIP errors since 
the last baseline reset.

Table 46
Component: EM/ LP/ E1/ CHAN/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.
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Table 47
Component: EM/ LP/ E3/

Name Formula Meaning

Line Failures (lineFailures/NUM)                      
DELTA

Number of line failures since 
last probe.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Number of line failures since 
the last baseline reset.

Path Failures (pathFailures/NUM)                      
DELTA

Number of path failures since 
last probe.

Path Failures since 
Baseline

(pathFailures/NUM)                      
BASELINEDELTA

Number of path failures since 
the last baseline reset.

Table 48
Component: EM/ LP/ E3/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 49
Component: EM/ LP/ ENET/

Name Formula Meaning

Alignment Errors (alignmentErrors/NUM)                      
DELTA

Number of alignment errors 
since last probe.

Alignment Errors since 
Baseline

(alignmentErrors/NUM)                      
BASELINEDELTA

Number of alignment errors 
since the last baseline reset.

FCS Errors (fcsErrors/NUM)                      DELTA Number of FCS errors since 
last probe.
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FCS Errors since Baseline (fcsErrors/NUM)                      
BASELINEDELTA

Number of FCS errors since 
the last baseline reset.

Single Collision Frames (singleCollisionFrames/NUM)                      
DELTA

Number of single frame 
collisions since last probe.

Single Collision Frames 
since Baseline

(singleCollisionFrames/NUM)                      
BASELINEDELTA

Number of single frame 
collisions since the last 
baseline reset.

Multiple Collision Frames (multipleCollisionFrames/NUM)                      
DELTA

Number of multiple frame 
collisions since last probe.

Multiple Collision Frames 
since Baseline

(multipleCollisionFrames/NUM)                      
BASELINEDELTA

Number of multiple frame 
collisions since the last 
baseline reset.

SQE Test Errors (sqeTestErrors/NUM)                      
DELTA

Number of SQE test errors 
since last probe.

SQE Test Errors since 
Baseline

(sqeTestErrors/NUM)                      
BASELINEDELTA

Number of SQE test errors 
since the last baseline reset.

Deferred Transmissions (deferredTransmissions/NUM)                      
DELTA

Number of deferred 
transmissions since last 
probe.

Deferred Transmissions 
since Baseline

(deferredTransmissions/NUM)                      
BASELINEDELTA

Number of deferred 
transmissions since the last 
baseline reset.

Late Collisions (lateCollisions/NUM)                      
DELTA

Number of late collisions 
since last probe.

Late Collisions since 
Baseline

(lateCollisions/NUM)                      
BASELINEDELTA

Number of late collisions 
since the last baseline reset.

Excessive Collisions (excessiveCollisions/NUM)                      
DELTA

Number of excessive 
collisions since last probe.

Excessive Collisions since 
Baseline

(excessiveCollisions/NUM)                      
BASELINEDELTA

Number of excessive 
collisions since the last 
baseline reset.

Table 49 (continued)
Component: EM/ LP/ ENET/

Name Formula Meaning
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MAC Transmit Errors (macTransmitErrors/NUM)                      
DELTA

Number of mac transmit 
errors since last probe.

MAC Transmit Errors since 
Baseline

(macTransmitErrors/NUM)                      
BASELINEDELTA

Number of mac transmit 
errors since the last baseline 
reset.

Carrier Sense Errors (carrierSenseErrors/NUM)                      
DELTA

Number of carrier sense 
errors since last probe.

Carrier Sense Errors since 
Baseline

(carrierSenseErrors/NUM)                      
BASELINEDELTA

Number of carrier sense 
errors since the last baseline 
reset.

Frame Size Errors (frameTooLongs/NUM)                      
DELTA

Number of frame size errors 
since last probe.

Frame Size Errors since 
Baseline

(frameTooLongs/NUM)                      
BASELINEDELTA

Number of frame size errors 
since the last baseline reset.

MAC Receive Errors (macReceiveErrors/NUM)                      
DELTA

Number of mac receive errors 
since last probe.

MAC Receive Errors since 
Baseline

(macReceiveErrors/NUM)                      
BASELINEDELTA

Number of mac receive errors 
since the last baseline reset.

Table 50
Component: EM/ LP/ ENG AALIST

Name Formula Meaning

Rx Alarm (alarmsRx/NUM) Number of active alarms 
received from the LP.

Discarded Alarm (alarmsDiscarded/NUM) Number of active alarms 
discarded from the LP.
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Table 49 (continued)
Component: EM/ LP/ ENET/

Name Formula Meaning
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Current List Size (currentListSize/NUM) Number of active alarms 
stored on this LP.

Peak List Size (peakListSize/NUM) Indicates the maximum 
number of active alarms 
received on the LP since it 
last came up.

Table 51
Component: EM/ LP/ ENG HGS

Name Formula Meaning

Hunts per second (huntAttempts/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Number of hunt group hunt, 
since last probe.

Hunts since Baseline (huntAttempts/NUM)                      
BASELINEDELTA

Number of hunt group hunt 
since the last baseline reset.

Table 52
Component: EM/ LP/ ETHERNET/

Name Formula Meaning

Frames Transmitted Ok (framesTransmittedOk/NUM)                      
DELTA

Number of frames transmitted 
Ok since last probe.

Frames Transmitted Ok 
since Baseline

(framesTransmittedOk/NUM)                      
BASELINEDELTA

Number of frames transmitted 
Ok since the last baseline 
reset.

Frames Received Ok (framesReceivedOk/NUM)                      
DELTA

Number of frames received 
Ok since last probe.

Frames Received Ok since 
Baseline

(framesReceivedOk/NUM)                      
BASELINEDELTA

Number of frames received 
Ok since the last baseline 
reset.
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Component: EM/ LP/ ENG AALIST

Name Formula Meaning
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Octets Transmitted Ok (octetsTransmittedOk/NUM)                      
DELTA

Number of octets transmitted 
Ok since last probe.

Octets Transmitted Ok 
since Baseline

(octetsTransmittedOk/NUM)                      
BASELINEDELTA

Number of octets transmitted 
Ok since the last baseline 
reset.

Octets Received Ok (octetsReceivedOk/NUM)                      
DELTA

Number of octets received Ok 
since last probe.

Octets Received Ok since 
Baseline

(octetsReceivedOk/NUM)                      
BASELINEDELTA

Number of octets received Ok 
since the last baseline reset.

Undersize Frames (undersizeFrames/NUM)                      
DELTA

Number of undersize frames 
since last probe.

Undersize Frames since 
Baseline

(undersizeFrames/NUM)                      
BASELINEDELTA

Number of undersize frames 
since the last baseline reset.

Fragments (fragments/NUM)                      DELTA Number of fragments since 
last probe.

Fragments since Baseline (fragments/NUM)                      
BASELINEDELTA

Number of fragments since 
the last baseline reset.

Frames Too Long (framesTooLong/NUM)                      
DELTA

Number of frames too long 
since last probe.

Frames Too Long since 
Baseline

(framesTooLong/NUM)                      
BASELINEDELTA

Number of frames too long 
since the last baseline reset.

Jabbers (jabbers/NUM)                      DELTA Number of jabbers since last 
probe.

Jabbers since Baseline (jabbers/NUM)                      
BASELINEDELTA

Number of jabbers since the 
last baseline reset.

FCS Errors (fcsErrors/NUM)                      DELTA Number of FCS errors since 
last probe.

FCS Errors since Baseline (fcsErrors/NUM)                      
BASELINEDELTA

Number of FCS errors since 
the last baseline reset.

Symbol Errors (symbolErrors/NUM)                      
DELTA

Number of symbol errors 
since last probe.

Table 52 (continued)
Component: EM/ LP/ ETHERNET/

Name Formula Meaning
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Symbol Errors since 
Baseline

(symbolErrors/NUM)                      
BASELINEDELTA

Number of symbol errors 
since the last baseline reset.

Pause Frames Received (pauseFramesReceived/NUM)                      
DELTA

Number of pause frames 
received since last probe.

Pause Frames Received 
since Baseline

(pauseFramesReceived/NUM)                      
BASELINEDELTA

Number of pause frames 
received since the last 
baseline reset.

Table 53
Component: EM/ LP/ IMA/

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Failures (failures/NUM)                      DELTA Number of failures that the 
link has experienced during 
link addition  or normal 
operation.

Failures since Baseline (failures/NUM)                      
BASELINEDELTA

Number of failures that the 
link has experienced during 
link addition  or normal 
operation, since the last 
baseline reset.

Table 52 (continued)
Component: EM/ LP/ ETHERNET/

Name Formula Meaning
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Table 54
Component: EM/ LP/ JT2/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 55
Component: EM/ LP/ SDH/

Name Formula Meaning

Error Free Sec (errorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state.

Error Free Sec since 
Baseline

(errorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state, since the last baseline 
reset.

Section Code Violations (sectCodeViolations/NUM)                      
DELTA

Total number of Section Code 
Violations. 

Section Code Violations 
since Baseline

(sectCodeViolations/NUM)                      
BASELINEDELTA

Total number of Section Code 
Violations, since the last 
baseline reset.

Section Error Sec (sectErroredSec/NUM)                      
DELTA

Total number of Section Error 
Seconds.

Section Error Sec since 
Baseline

(sectErroredSec/NUM)                      
BASELINEDELTA

Total number of Section Error 
Seconds, since the last 
baseline reset.

Section Severe Error Sec (sectSevErroredSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Seconds.

 (Sheet 1 of 3)
Preside MDM Performance Management  User Guide   14.3RSUP



210   Appendix A Passport performance metrics
Section Severe Error Sec 
since Baseline

(sectSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Seconds, 
since the last baseline reset.

Section Los Sec (sectLosSec/NUM)                      
DELTA

Total number of section LOS 
seconds.

Section Los Sec since 
Baseline

(sectLosSec/NUM)                      
BASELINEDELTA

Total number of section LOS 
seconds, since the last 
baseline reset.

Section Severe Error 
Frame Sec

(sectSevErroredFrmSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Frame 
Seconds.

Section Severe Error 
Frame Sec since Baseline

(sectSevErroredFrmSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Frame 
Seconds, since the last 
baseline reset.

Section Failures (sectFailures/NUM)                      
DELTA

Total number of times a 
section failure (LOS or LOF) 
occurs.

Section Failures since 
Baseline

(sectFailures/NUM)                      
BASELINEDELTA

Total number of times a 
section failure (LOS or LOF) 
occurs since the  last baseline 
reset.

Line Code Violations (lineCodeViolations/NUM)                      
DELTA

Total number of Line Code 
Violations. 

Line Code Violations since 
Baseline

(lineCodeViolations/NUM)                      
BASELINEDELTA

Total number of Line Code 
Violations since the last 
baseline reset.

Line Errored Sec (lineErroredSec/NUM)                      
DELTA

Total number of Line Errored 
Seconds.

Line Errored Sec since 
Baseline

(lineErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Errored 
Seconds since the last 
baseline reset.

Table 55 (continued)
Component: EM/ LP/ SDH/

Name Formula Meaning
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Line Severe Errored Sec (lineSevErroredSec/NUM)                      
DELTA

Total number of Line Severely 
Errored Seconds.

Line Severe Errored Sec 
since Baseline

(lineSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Severely 
Errored Seconds since the 
last baseline  reset.

Line Ais Sec (lineAisSec/NUM) Total number of Line AIS 
Seconds. 

Line Unavailable Sec (lineUnavailSec/NUM) Total number of one-second 
intervals for which the STS 
line is unavailable.

Line Failures (lineFailures/NUM)                      
DELTA

Total number of times that a 
line failure (L-AIS) occurs.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Total number of times that a 
line failure (L-AIS) occurs, 
since the last baseline reset.

Table 56
Component: EM/ LP/ SDH/ PATH/

Name Formula Meaning

Path Error Free Sec (pathErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state.

Path Error Free Sec since 
Baseline

(pathErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state, since 
the last baseline reset.

Path Code Violations (pathCodeViolations/NUM)                      
DELTA

Number of path code 
violations.
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Table 55 (continued)
Component: EM/ LP/ SDH/

Name Formula Meaning
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Path Code Violations since 
Baseline

(pathCodeViolations/NUM)                      
BASELINEDELTA

Number of path code 
violations since the last 
baseline reset.

Path Errored Sec (pathErroredSec/NUM)                      
DELTA

Number of path errored 
seconds.

Path Errored Sec since 
Baseline

(pathErroredSec/NUM)                      
BASELINEDELTA

Number of path errored 
seconds, since the last 
baseline reset.

Path Severe Errored Sec (pathSevErroredSec/NUM)                      
DELTA

Number of path severe 
errored seconds.

Path Severe Errored Sec 
since Baseline

(pathSevErroredSec/NUM)                      
BASELINEDELTA

Number of path severe 
errored seconds, since the 
last baseline reset.

Path Ais Lop Sec (pathAisLopSec/NUM)                      
DELTA

Number of path AIS and LOP 
seconds.

Path Ais Lop Sec since 
Baseline

(pathAisLopSec/NUM)                      
BASELINEDELTA

Number of path AIS and LOP 
seconds, since the last 
baseline reset.

Path Unavailable Sec (pathUnavailSec/NUM)                      
DELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable.

Path Unavailable Sec since 
Baseline

(pathUnavailSec/NUM)                      
BASELINEDELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable, 
since the last baseline reset.

Table 56 (continued)
Component: EM/ LP/ SDH/ PATH/

Name Formula Meaning
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Table 57
Component: EM/ LP/ SDH/ PATH/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 58
Component: EM/ LP/ SONET/

Name Formula Meaning

Error Free Sec (errorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state.

Error Free Sec since 
Baseline

(errorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/Sdh component has 
been in a near error-free 
state, since the last baseline 
reset.

Section Code Violations (sectCodeViolations/NUM)                      
DELTA

Total number of Section Code 
Violations. 

Section Code Violations 
since Baseline

(sectCodeViolations/NUM)                      
BASELINEDELTA

Total number of Section Code 
Violations since the last 
baseline reset.

Section Error Sec (sectErroredSec/NUM)                      
DELTA

Total number of Section Error 
Seconds.

Section Error Sec since 
Baseline

(sectErroredSec/NUM)                      
BASELINEDELTA

Total number of Section Error 
Seconds since the last 
baseline reset.

Section Severe Error Sec (sectSevErroredSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Seconds.
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Section Severe Error Sec 
since Baseline

(sectSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Seconds 
since the last baseline reset.

Section Los Sec (sectLosSec/NUM)                      
DELTA

Total number of section LOS 
seconds.

Section Los Sec since 
Baseline

(sectLosSec/NUM)                      
BASELINEDELTA

Total number of section LOS 
seconds since the last 
baseline reset.

Section Severe Error 
Frame Sec

(sectSevErroredFrmSec/NUM)                      
DELTA

Total number of Section 
Severely Errored Frame 
Seconds.

Section Severe Error 
Frame Sec since Baseline

(sectSevErroredFrmSec/NUM)                      
BASELINEDELTA

Total number of Section 
Severely Errored Frame 
Seconds since the last  
baseline reset.

Section Failures (sectFailures/NUM)                      
DELTA

Total number of times a 
section failure (LOS or LOF) 
occurs.

Section Failures since 
Baseline

(sectFailures/NUM)                      
BASELINEDELTA

Total number of times a 
section failure (LOS or LOF) 
occurs since the  last baseline 
reset.

Line Code Violations (lineCodeViolations/NUM)                      
DELTA

Total number of Line Code 
Violations. 

Line Code Violations since 
Baseline

(lineCodeViolations/NUM)                      
BASELINEDELTA

Total number of Line Code 
Violations since the last 
baseline reset.

Line Errored Sec (lineErroredSec/NUM)                      
DELTA

Total number of Line Errored 
Seconds.

Line Errored Sec since 
Baseline

(lineErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Errored 
Seconds since the last 
baseline reset.

Table 58 (continued)
Component: EM/ LP/ SONET/

Name Formula Meaning
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Line Severe Errored Sec (lineSevErroredSec/NUM)                      
DELTA

Total number of Line Severely 
Errored Seconds.

Line Severe Errored Sec 
since Baseline

(lineSevErroredSec/NUM)                      
BASELINEDELTA

Total number of Line Severely 
Errored Seconds since the 
last baseline  reset.

Line Ais Sec (lineAisSec/NUM)                      
DELTA

Total number of Line AIS 
Seconds. 

Line Ais Sec since Baseline (lineAisSec/NUM)                      
BASELINEDELTA

Total number of Line AIS 
Seconds since the last 
baseline reset.

Line Unavailable Sec (lineUnavailSec/NUM)                      
DELTA

Total number of one-second 
intervals for which the STS 
line is unavailable.

Line Unavailable Sec since 
Baseline

(lineUnavailSec/NUM)                      
BASELINEDELTA

Total number of one-second 
intervals for which the STS 
line is unavailable, since the 
last baseline reset.

Line Failures (lineFailures/NUM)                      
DELTA

Total number of times that a 
line failure (L-AIS) occurs.

Line Failures since 
Baseline

(lineFailures/NUM)                      
BASELINEDELTA

Total number of times that a 
line failure (L-AIS) occurs, 
since the last baseline reset.

Table 58 (continued)
Component: EM/ LP/ SONET/

Name Formula Meaning
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Table 59
Component: EM/ LP/ SONET/ PATH/

Name Formula Meaning

Path Error Free Sec (pathErrorFreeSec/NUM)                      
DELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state.

Path Error Free Sec since 
Baseline

(pathErrorFreeSec/NUM)                      
BASELINEDELTA

Number of seconds that the 
Sonet/SDH/ PATH 
component has been in a 
near error-free state, since 
the last baseline reset.

Path Code Violations (pathCodeViolations/NUM)                      
DELTA

Number of path code 
violations.

Path Code Violations since 
Baseline

(pathCodeViolations/NUM)                      
BASELINEDELTA

Number of path code 
violations since the last 
baseline reset.

Path Errored Sec (pathErroredSec/NUM)                      
DELTA

Number of path errored 
seconds.

Path Errored Sec since 
Baseline

(pathErroredSec/NUM)                      
BASELINEDELTA

Number of path errored 
seconds, since the last 
baseline reset.

Path Severe Errored Sec (pathSevErroredSec/NUM)                      
DELTA

Number of path severe 
errored seconds.

Path Severe Errored Sec 
since Baseline

(pathSevErroredSec/NUM)                      
BASELINEDELTA

Number of path severe 
errored seconds, since the 
last baseline reset.

Path Ais Lop Sec (pathAisLopSec/NUM)                      
DELTA

Number of path AIS and LOP 
seconds.

Path Ais Lop Sec since 
Baseline

(pathAisLopSec/NUM)                      
BASELINEDELTA

Number of path AIS and LOP 
seconds, since the last 
baseline reset.
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Path Unavailable Sec (pathUnavailSec/NUM)                      
DELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable.

Path Unavailable Sec since 
Baseline

(pathUnavailSec/NUM)                      
BASELINEDELTA

Number of one-second 
intervals for which the STS/
STM path is unavailable, 
since the last baseline reset.

Table 60
Component: EM/ LP/ SONET/ PATH/ CELL

Name Formula Meaning

Rx Cell Util (receiveCellUtilization/NUM) Ratio of number of valid 
assigned cells received on 
link to nominal capacity.

Tx Cell Util (transmitCellUtilization/NUM) Ratio of number of valid 
assigned cells transmitted on 
link to nominal capacity.

Table 61
Component: EM/ MPANL/

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames sent per 
second since last probe.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Number of frames sent since 
the last baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Number of frames received 
per second since last probe.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Number of frames received 
since the last baseline reset.
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Table 59 (continued)
Component: EM/ LP/ SONET/ PATH/

Name Formula Meaning
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Kilobytes per second Sent (octetToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE                      
1000                      DIVIDE

Number of kilobytes sent per 
second since last probe.

Kilobytes Sent since 
Baseline

(octetToIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of kilobytes sent 
since the last baseline reset.

Kilobytes per second 
Received

(octetFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Number of kilobytes received 
per second since last probe.

Kilobytes Received since 
Baseline

(octetFromIf/NUM)                      
BASELINEDELTA                      1000                      
DIVIDE

Number of kilobytes received 
since the last baseline reset.

Frame Header Format 
Errors

(invalidHeaderFramesFromIf/
NUM)                      DELTA

Number of frames with invalid 
headers since last probe.

Frame Header Format 
Errors since Baseline

(invalidHeaderFramesFromIf/
NUM)                      BASELINEDELTA

Number of frames with invalid 
headers since the last 
baseline reset.

Unknown DLCI Errors (unknownDlciFramesFromIf/NUM)                      
DELTA

Number of frames with 
unknown DLCI since last 
probe.

Unknown DLCI Errors 
since Baseline

(unknownDlciFramesFromIf/NUM)                      
BASELINEDELTA

Number of frames with 
unknown DLCI since the last 
baseline reset.

Last Unknown DLCI (lastUnknownDlci/NUM) DLCI of the last unknown 
DLCI frame. 

Table 61 (continued)
Component: EM/ MPANL/

Name Formula Meaning
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Table 62
Component: EM/ MPANL/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames per second Sent 
since Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe. 

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.
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Table 63
Component: EM/ MPANL/ SIGMPANL

Name Formula Meaning

Protocol Errors (protocolErrors/NUM)                      
DELTA

Number of protocol error 
reports sent since last probe.

Protocol Errors since 
Baseline

(protocolErrors/NUM)                      
BASELINEDELTA

Number of protocol error 
reports sent since the last 
baseline reset.

SAP 0 Commands Sent (sap0CommandsTx/NUM)                      
DELTA

Number of SAP-0 commands 
sent since last probe.

SAP 0 Commands Sent 
since Baseline

(sap0CommandsTx/NUM)                      
BASELINEDELTA

Number of SAP-0 commands 
sent since the last baseline 
reset.

SAP 0 Commands 
Received

(sap0CommandsRx/NUM)                      
DELTA

Number of SAP-0 commands 
received since last probe.

SAP 0 Commands 
Received since Baseline

(sap0CommandsRx/NUM)                      
BASELINEDELTA

Number of SAP-0 commands 
received since the last 
baseline reset.

SAP X Commands Sent (sapXCommandsTx/NUM)                      
DELTA

Number of SAP X commands 
sent since last probe.

SAP X Commands Sent 
since Baseline

(sapXCommandsTx/NUM)                      
BASELINEDELTA

Number of SAP X commands 
sent since the last baseline 
reset.

SAP X Commands 
Received

(sapXCommandsRx/NUM)                      
DELTA

Number of SAP X commands 
receivd since last probe.

SAP X Commands 
Received since Baseline

(sapXCommandsRx/NUM)                      
BASELINEDELTA

Number of SAP X commands 
receivd since the last baseline 
reset.
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Table 64
Component: EM/ PCGTL/ NSE/

Name Formula Meaning

Oct From Sgsn (octetsFromSgsn/NUM)                      
DELTA                      SECONDS                      
DIVIDE

The description for this metric 
is currently not defined.

Oct From Sgsn since 
Baseline

(octetsFromSgsn/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Oct To Sgsn (octetsToSgsn/NUM)                      
DELTA                      SECONDS                      
DIVIDE

The description for this metric 
is currently not defined.

Oct To Sgsn since Baseline (octetsToSgsn/NUM)                      
BASELINEDELTA

The description for this metric 
is currently not defined.

Table 65
Component: EM/ PPP/ FRAMER

Name Formula Meaning

Frames per second Sent (frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames Sent since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.

Frames per second 
Received

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames Received since 
Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.
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Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 66
Component: EM/ RTR/

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
probe.
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Table 65 (continued)
Component: EM/ PPP/ FRAMER

Name Formula Meaning
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Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.

Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Table 66 (continued)
Component: EM/ RTR/

Name Formula Meaning
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Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Table 66 (continued)
Component: EM/ RTR/

Name Formula Meaning
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Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 66 (continued)
Component: EM/ RTR/

Name Formula Meaning
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Table 67
Component: EM/ RTR/ IF/

Name Formula Meaning

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters, in 32-bit.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 32-bit.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.
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In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.

Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 32-
bit.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 32-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Table 67 (continued)
Component: EM/ RTR/ IF/

Name Formula Meaning
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Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Table 67 (continued)
Component: EM/ RTR/ IF/

Name Formula Meaning
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Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

Table 68
Component: EM/ RTR/ IF/ LDPIF

Name Formula Meaning

In Octets Received (inOctets/NUM)                      DELTA The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.

In Octets Received since 
Baseline

(inOctets/NUM)                      
BASELINEDELTA

The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.

In Frames Received (inFrames/NUM)                      DELTA The number of frames 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.
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In Frames Received since 
Baseline

(inFrames/NUM)                      
BASELINEDELTA

The number of frames 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.

In Frames Discarded (inFramesDiscards/NUM)                      
DELTA

The number of frames 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last probe.

In Frames Discarded since 
Baseline

(inFramesDiscards/NUM)                      
BASELINEDELTA

The number of frames 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last baseline reset.

Out Octets Received (outOctets/NUM)                      DELTA The number of octets 
transmitted for originating or 
outgoing transit MPLS data 
since the last probe.

Out Octets Received since 
Baseline

(outOctets/NUM)                      
BASELINEDELTA

The number of octets 
transmitted for originating or 
outgoing transit MPLS data 
since the last baseline reset.

Out Frames Transmitted (outFrames/NUM)                      
DELTA

The total number frames of  
transmitted since the last 
probe.

Out Frames Transmitted 
since Baseline

(outFrames/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted since the last 
baseline reset.

Table 68 (continued)
Component: EM/ RTR/ IF/ LDPIF

Name Formula Meaning

 (Sheet 2 of 3)
241-6001-031   14.3RSUP   



Appendix A Passport performance metrics   231
Out Frames Discarded (outFramesDiscards/NUM)                      
DELTA

The total number frames of  
transmitted that were 
discarded since the last 
probe.

Out Frames Discarded 
since Baseline

(outFramesDiscards/NUM)                      
BASELINEDELTA

The total number of frames 
transmitted that were 
discarded since the last 
baseline reset.

Table 69
Component: EM/ RTR/ VRF/

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
probe.
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Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.

Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Table 69 (continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Table 69 (continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 69 (continued)
Component: EM/ RTR/ VRF/

Name Formula Meaning
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Table 70
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters, in 32-bit.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 32-bit.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 32-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.
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In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.

Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 32-
bit.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 32-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Table 70 (continued)
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning
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Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 32-bit.

Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Table 70 (continued)
Component: EM/ RTR/ VRF/ IF/

Name Formula Meaning
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Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

Table 71
Component: EM/ RTR/ VRF/ IF/ ATMMPE AC/

Name Formula Meaning

In Packets/sec (inPackets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on this 
connection.

In Packets since Baseline (inPackets/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection since the last 
baseline reset.

In Octects/sec (inOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets received on this 
connection.

In Octects since Baseline (inOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets received on this 
connection since the last 
baseline reset.
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In UnknownProtos/sec (inUnknownProtos/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol.

In UnknownProtos since 
Baseline

(inUnknownProtos/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on this 
connection which were 
discarded because they 
contained an unknown or 
unsupported protocol, since 
the last baseline reset.

In Errors/sec (inErrors/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol.

In Errors since Baseline (inErrors/NUM)                      
BASELINEDELTA

Counts the total number of 
packets received on the 
connection which contained 
errors preventing them from 
being delivered to a higher-
layer protocol, since the last 
baseline reset.

Out Packets/sec (outPackets/NUM)                      
DELTA                      SECONDS                      
DIVIDE

outPackets

Out Packets since Baseline (outPackets/NUM)                      
BASELINEDELTA

outPackets since the last 
baseline reset.

Out Octects/sec (outOctets/NUM)                      DELTA                      
SECONDS                      DIVIDE

Counts the total number of 
octets sent on this 
connection.

Table 71 (continued)
Component: EM/ RTR/ VRF/ IF/ ATMMPE AC/

Name Formula Meaning

 (Sheet 2 of 3)
Preside MDM Performance Management  User Guide   14.3RSUP



240   Appendix A Passport performance metrics
Out Octects since Baseline (outOctets/NUM)                      
BASELINEDELTA

Counts the total number of 
octets sent on this connection 
since the last baseline reset.

Out Discards/sec (outDiscards/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down.

Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

Counts the total number of 
packets which were 
supposed to be sent on this 
connection, but were 
discarded due to congestion 
or the connection being down, 
since the last baseline reset.

Table 72
Component: EM/ SHELF BUS/

Name Formula Meaning

Bus Utilization (%) (utilization/NUM) Bus utilization.

Table 73
Component: EM/ SHELF BUS/ TEST

Name Formula Meaning

self test result(0) (selfTestResults[0]/NUM) Verifies the operation of a 
bus.

self test result(15) (selfTestResults[15]/NUM) Verifies the operation of a 
bus.
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clock source test 
result(0..0)

(clockSourceTestResults[0,0]/
NUM)

Verifies the operation of a 
bus.

clock source test 
result(0..15)

(clockSourceTestResults[1,15]/
NUM)

Verifies the operation of a 
bus.

Table 74
Component: EM/ SHELF CARD/

Name Formula Meaning

CPU Utilization (%) (cpuUtil/NUM) Card CPU utilization.

Fast Ram Memory 
Utilization (%)

(memoryUsage[0]/NUM)                      
(memoryCapacity[0]/NUM)                      
PERCENT

Fast ram memory utilization.

Normal Ram Memory 
Utilization (%)

(memoryUsage[1]/NUM)                      
(memoryCapacity[1]/NUM)                      
PERCENT

Normal ram memory 
utilization.

Shared Ram Memory 
Utilization (%)

(memoryUsage[2]/NUM)                      
(memoryCapacity[2]/NUM)                      
PERCENT

Shared ram memory 
utilization.

Shared Msg Block 
Utilization (%)

(sharedMsgBlockUsage/NUM)                      
(sharedMsgBlockCapacity/NUM)                      
PERCENT

Shared message block 
utilization.

Local Msg Block Utilization 
(%)

(localMsgBlockUsage/NUM)                      
(localMsgBlockCapacity/NUM)                      
PERCENT

Local message block 
utilization.

Table 73 (continued)
Component: EM/ SHELF BUS/ TEST

Name Formula Meaning
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Table 75
Component: EM/ SHELF FABRICCARD/

Name Formula Meaning

Bus Utilization (%) (utilization/NUM) Estimates the current fabric 
utilization.

Table 76
Component: EM/ TRK/

Name Formula Meaning

Packets/sec from Interface (pktFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Packets from interface per 
second.

Packets from Interface 
since Baseline

(pktFromIf/NUM)                      
BASELINEDELTA

Packets from interface since 
the last baseline reset.

Trunk Pks/s to Interface (trunkPktToIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets to interface per 
second.

Trunk Pks to Interface 
since Baseline

(trunkPktToIf/NUM)                      
BASELINEDELTA

Trunk packets to interface 
since the last baseline reset.

Trunk Pks/s from Interface (trunkPktFromIf/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Trunk packets from interface 
per second.

Trunk Pks from Interface 
since Baseline

(trunkPktFromIf/NUM)                      
BASELINEDELTA

Trunk packets from interface 
since the last baseline reset.

Discarded packets/sec (discardUnforward/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets per 
second.

Discarded packets since 
Baseline

(discardUnforward/NUM)                      
BASELINEDELTA

Discarded packets since the 
last baseline reset.

Round trip delay (ms / 10) (measuredRoundTripDelay/NUM) Round trip delay in 
millisecond measured by the 
trunk or DPN Gateway.
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Packet/sec from Interface 
EP equals 0

(pktFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 0 from 
interface per second.

Packet from Interface EP 
equals 0 since Baseline

(pktFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Packets with priority 0 from 
interface since the last 
baseline reset.

Packet/sec from Interface 
EP equals 1

(pktFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 1 from 
interface per second.

Packet from Interface EP 
equals 1 since Baseline

(pktFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Packets with priority 1 from 
interface since the last 
baseline reset.

Packet/sec from Interface 
EP equals 2

(pktFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Packets with priority 2 from 
interface per second.

Packet from Interface EP 
equals 2 since Baseline

(pktFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Packets with priority 2 from 
interface since the last 
baseline reset.

Discarded Packet/sec from 
IF EP equals 0

(discPktFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 0 from interface per 
second.

Discarded Packet from IF 
EP equals 0 since Baseline

(discPktFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 0 from interface since 
the last baseline reset.

Discarded Packet/sec from 
IF EP equals 1

(discPktFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 1 from interface per 
second.

Discarded Packet from IF 
EP equals 1 since Baseline

(discPktFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 1 from interface since 
the last baseline reset.

Discarded Packet/sec from 
IF EP equals 2

(discPktFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Discarded packets with 
priority 2 from interface per 
second.

Table 76 (continued)
Component: EM/ TRK/

Name Formula Meaning
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Discarded Packet from IF 
EP equals 2 since Baseline

(discPktFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Discarded packets with 
priority 2 from interface since 
the last baseline reset.

Octets/sec from Interface 
EP equals 0

(octetFromIfByPrio[0]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 0 from 
interface per second.

Octets from Interface EP 
equals 0 since Baseline

(octetFromIfByPrio[0]/NUM)                      
BASELINEDELTA

Octets with priority 0 from 
interface since the last 
baseline reset.

Octets/sec from Interface 
EP equals 1

(octetFromIfByPrio[1]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 1 from 
interface per second.

Octets from Interface EP 
equals 1 since Baseline

(octetFromIfByPrio[1]/NUM)                      
BASELINEDELTA

Octets with priority 1 from 
interface since the last 
baseline reset.

Octets/sec from Interface 
EP equals 2

(octetFromIfByPrio[2]/NUM)                      
DELTA                      SECONDS                      
DIVIDE

Octets with priority 2 from 
interface per second.

Octets from Interface EP 
equals 2 since Baseline

(octetFromIfByPrio[2]/NUM)                      
BASELINEDELTA

Octets with priority 2 from 
interface since the last 
baseline reset.

Utilization (utilization/NUM) Average trunk utilization.

Table 77
Component: EM/ TRK/ UNACKED FRAMER

Name Formula Meaning

Frames per second from 
Interface

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.
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Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 78
Component: EM/ TRK/ UTP FRAMER

Name Formula Meaning

Frames per second to 
Interface

(frmToIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames sent per second.

Frames to Interface since 
Baseline

(frmToIf/NUM)                      
BASELINEDELTA

Frames sent since the last 
baseline reset.
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Component: EM/ TRK/ UNACKED FRAMER

Name Formula Meaning
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Frames per second from 
Interface

(frmFromIf/NUM)                      DELTA                      
SECONDS                      DIVIDE

Frames received per second.

Frames from Interface 
since Baseline

(frmFromIf/NUM)                      
BASELINEDELTA

Frames received since the 
last baseline reset.

Outgoing Normal Link 
Utilization

(normPrioLinkUtilToIf/NUM) Normal traffic sending link 
utilization.

Incoming Normal Link 
Utilization

(normPrioLinkUtilFromIf/NUM) Normal traffic receiving link 
utilization.

Outgoing Priority Link 
Utilization

(highPrioLinkUtilToIf/NUM) Priority traffic sending link 
utilization.

Incoming Priority Link 
Utilization

(highPrioLinkUtilFromIf/NUM) Priority traffic receiving link 
utilization.

Octet Alignment Errors (nonOctetErrors/NUM)                      
DELTA

Number of non-octet aligned 
frames since last probe.

Octet Alignment Errors 
since Baseline

(nonOctetErrors/NUM)                      
BASELINEDELTA

Number of non-octet aligned 
frames since the last baseline 
reset.

Frame Length Errors (largeFrmErrors/NUM)                      
DELTA

Number of bad length frames 
since last probe.

Frame Length Errors since 
Baseline

(largeFrmErrors/NUM)                      
BASELINEDELTA

Number of bad length frames 
since the last baseline reset.

Frame Abort Errors (aborts/NUM)                      DELTA Number of aborted frames 
since last probe.

Frame Abort Errors since 
Baseline

(aborts/NUM)                      
BASELINEDELTA

Number of aborted frames 
since the last baseline reset.

Table 78 (continued)
Component: EM/ TRK/ UTP FRAMER

Name Formula Meaning
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Table 79
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning

comp Name (componentName/STR) Provides a component name 
associated with the IFentry.

In Octets (ifInOctets/NUM)                      DELTA Number of octets received on 
the interface, including 
framing characters.

In Octets since Baseline (ifInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset.

Out Octets (ifOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters.

Out Octets since Baseline (ifOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset.

In Discards (ifInDiscards/NUM)                      
DELTA

Number of inbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being delivered 
to a higher layer protocol.

In Discards since Baseline (ifInDiscards/NUM)                      
BASELINEDELTA

Number of inbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being delivered 
to a higher layer protocol.

Out Discards (ifOutDiscards/NUM)                      
DELTA

Number of outbound packets 
discarded even though no 
errors detected. Prevents the 
packets from being 
transmitted.
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Out Discards since 
Baseline

(ifOutDiscards/NUM)                      
BASELINEDELTA

Number of outbound packets 
discarded even though no 
errors detected since the last 
baseline reset. Prevents the 
packets from being 
transmitted.

In Ucast Pkts (ifInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol.

In Ucast Pkts since 
Baseline

(ifInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset.

Out Ucast Pkts (ifOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets.

Out Ucast Pkts since 
Baseline

(ifOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets.

In NUcast Pkts (ifInNuCastPkts/NUM)                      
DELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol.

In NUcast Pkts since 
Baseline

(ifInNuCastPkts/NUM)                      
BASELINEDELTA

Number of non-unicast 
packets delivered to a higher 
layer protocol, since the last 
baseline reset.

Table 79 (continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Out NUcast Pkts (ifOutNuCastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address. Includes discarded 
and unsent packets.

Out NUcast Pkts since 
Baseline

(ifOutNuCastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a non-unicast 
address, since the last 
baseline reset. Includes 
discarded and unsent 
packets.

In Octets (64-bit) (ifHCInOctets/NUM)                      
DELTA

Number of octets received on 
the interface, including 
framing characters, in 64-bit.

In Octets since Baseline 
(64-bit)

(ifHCInOctets/NUM)                      
BASELINEDELTA

Number of octets received on 
the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

Out Octets (64-bit) (ifHCOutOctets/NUM)                      
DELTA

Number of octets transmitted 
out the interface, including 
framing characters, in 64-bit.

Out Octets since Baseline 
(64-bit)

(ifHCOutOctets/NUM)                      
BASELINEDELTA

Number of octets transmitted 
out the interface, including 
framing characters, since the 
last baseline reset, in 64-bit.

In Ucast Pkts (64-bit) (ifHCInUcastPkts/NUM)                      
DELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol, in 64-
bit.

In Ucast Pkts since 
Baseline (64-bit)

(ifHCInUcastPkts/NUM)                      
BASELINEDELTA

Number of subnetwork-
unicast packets delivered to a 
higher layer protocol since the 
last baseline reset, in 64-bit.

Table 79 (continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Out Ucast Pkts (64-bit) (ifHCOutUcastPkts/NUM)                      
DELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address. Includes 
discarded and unsent 
packets, in 64-bit.

Out Ucast Pkts since 
Baseline (64-bit)

(ifHCOutUcastPkts/NUM)                      
BASELINEDELTA

Number of packets the higher 
level protocols request to be 
transmitted to a subnetwork-
unicast address, since the 
last baseline reset. Includes 
discarded and unsent 
packets, in 64-bit.

Table 80
Component: EM/ VR/ IP

Name Formula Meaning

Input Datagrams Received (inReceives/NUM)                      
DELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
probe.

Input Datagrams Received 
since Baseline

(inReceives/NUM)                      
BASELINEDELTA

The number of input 
datagrams received from the 
interfaces, including those 
received in error since the last 
baseline reset.

Invalid Address Errors 
Discarded

(inAddrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors such as  invalid 
address, unsupported 
address class since the last 
probe.
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Table 79 (continued)
Component: EM/ VR/ IFTABLEENTRY/

Name Formula Meaning
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Invalid Address Errors 
Discarded since Baseline

(inAddrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors such as  invalid 
address, unsupported 
address class since the last 
baseline reset.

Invalid Header Errors 
Discarded

(inHdrErrors/NUM)                      
DELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
probe.

Invalid Header Errors 
Discarded since Baseline

(inHdrErrors/NUM)                      
BASELINEDELTA

The number of input 
datagrams discarded due to 
errors in their IP headers, 
including bad checksums, 
version number mismatch, 
other format errors, time-to-
live exceeded, errors 
discovered in processing their 
IP options, etc since the last 
baseline reset.

Input Datagrams Discarded (inDiscards/NUM)                      
DELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to  the lack of 
buffers since the last probe. 
This does not include any 
datagram discarded while 
awaiting for re-asembly.

Table 80 (continued)
Component: EM/ VR/ IP

Name Formula Meaning
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Input Datagrams Discarded 
since Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of input 
datagrams for which no 
problems were encountered 
to prevent their continued 
processing, but which were 
discarded due to  the lack of 
buffers since the last baseline 
reset. This does not include 
any datagram discarded 
while awaiting for re-asembly.

Input Datagrams Delivered (inDelivers/NUM)                      DELTA The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last probe.

Input Datagrams Delivered 
since Baseline

(inDelivers/NUM)                      
BASELINEDELTA

The number of input 
datagrams successfully 
delivered to IP user- protocols 
(including ICMP) since the 
last baseline reset.

Out Requests (outRequests/NUM)                      
DELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP) supplied to 
IP in requests for 
transmission since the last 
probe.

Out Requests since 
Baseline

(outRequests/NUM)                      
BASELINEDELTA

The number of datagrams 
which local IP user-protocols 
(including ICMP)  supplied to 
IP in requests for 
transmission since the last 
baseline reset.

Out Discards (outDiscards/NUM)                      
DELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last probe.

Table 80 (continued)
Component: EM/ VR/ IP

Name Formula Meaning
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Out Discards since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams that were 
discarded due to the lack of 
buffers since the last baseline 
reset.

No Route Out Discards (outNoRoutes/NUM)                      
DELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
probe.

No Route Out Discards 
since Baseline

(outNoRoutes/NUM)                      
BASELINEDELTA

The number of outbound 
datagrams discarded 
because no route could be 
found to transmit them to their 
destination since the last 
baseline reset.

Routing Discards (routingDiscards/NUM)                      
DELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last probe.

Routing Discards since 
Baseline

(routingDiscards/NUM)                      
BASELINEDELTA

The number of routing entries 
which were chosen to be 
discarded even though they 
are valid since the last 
baseline reset.

Table 80 (continued)
Component: EM/ VR/ IP

Name Formula Meaning
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Table 81
Component: EM/ VR/ IP RTD VCGDESTADDR/

Name Formula Meaning

Minimum Round Trip Delay (minRoundTripDelay/NUM) Minimum round trip delay 
measured in the last 
monitoring session.

Maximum Round Trip 
Delay

(maxRoundTripDelay/NUM) Maximum round trip delay 
measured in the last 
monitoring session.

Average Round Trip Delay (avgRoundTripDelay/NUM) Average round trip delay 
calculated in the last 
monitoring session.

RTD Frame Transmitted (framesTransmitted/NUM) The number of RTD frames 
transmitted to this remote 
destination address.

RTD Frame Received (framesReceived/NUM) The number of RTD frames 
received.

Last Monitoring Time (time/STR) The start time of the latest 
RTD session.

Table 82
Component: EM/ VR/ PP/ MPLSPORT

Name Formula Meaning

In Octets Received (inOctets/NUM)                      DELTA The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last probe.

In Octets Received since 
Baseline

(inOctets/NUM)                      
BASELINEDELTA

The number of octets 
received from terminating or 
incoming tandem MPLS data 
traffic since the last baseline 
reset.
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In Octets Discarded (inDiscards/NUM)                      
DELTA

The number of octets 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last probe.

In Octets Discarded since 
Baseline

(inDiscards/NUM)                      
BASELINEDELTA

The number of octets 
received but discarded from 
terminating or incoming 
tandem MPLS data traffic 
since the last baseline reset.

Out Octets Received (outOctets/NUM)                      DELTA The number of octets 
transmitted for originating or 
outgoing transit  MPLS data 
since the last probe.

Out Octets Received since 
Baseline

(outOctets/NUM)                      
BASELINEDELTA

The number of octets 
transmitted for originating or 
outgoing transit  MPLS data 
since the last baseline reset.

Out Octets Discarded (outDiscards/NUM)                      
DELTA

The total number of packets 
transmitted that were 
discarded since  the last 
probe.

Out Octets Discarded since 
Baseline

(outDiscards/NUM)                      
BASELINEDELTA

The total number of packets 
transmitted that were 
discarded since  the last 
baseline reset.

Table 82 (continued)
Component: EM/ VR/ PP/ MPLSPORT

Name Formula Meaning
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Table 83
Component: EM/ VR/ PP/ MPLSPORT INSEG/

Name Formula Meaning

De0 Octets Received (de0Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De0 Octets Received since 
Baseline

(de0Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Received (de1Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Received since 
Baseline

(de1Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets  for the ingress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De0 Octets Discarded (de0OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
ingress  traffic on this 
segment since the last probe. 
The octets reflect the non 
discard-eligible traffic.
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De0 Octets Discarded 
since Baseline

(de0OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
ingress  traffic on this 
segment since the last 
baseline reset. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Discarded (de1OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
ingress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Discarded 
since Baseline

(de1OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
ingress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

Table 83 (continued)
Component: EM/ VR/ PP/ MPLSPORT INSEG/

Name Formula Meaning
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Table 84
Component: EM/ VR/ PP/ MPLSPORT OUTSEG/

Name Formula Meaning

De0 Octets Received (de0Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De0 Octets Received since 
Baseline

(de0Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Received (de1Oct/NUM)                      DELTA The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last probe. The octets 
reflect the non discard-
eligible traffic.

De1 Octets Received since 
Baseline

(de1Oct/NUM)                      
BASELINEDELTA

The number of the received 
and successfully passed 
through octets for the egress 
traffic on this segment since 
the last baseline reset. The 
octets reflect the non discard-
eligible traffic.

De0 Octets Discarded (de0OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.
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De0 Octets Discarded 
since Baseline

(de0OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

De1 Octets Discarded (de1OctDsc/NUM)                      
DELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last probe. The 
octets reflect the non discard-
eligible traffic.

De1 Octets Discarded 
since Baseline

(de1OctDsc/NUM)                      
BASELINEDELTA

The number of the received 
but discarded octets for the 
egress traffic on this segment 
since the last baseline reset. 
The octets reflect the non 
discard-eligible traffic.

Table 85
Component: EM/ VROUTE/

Name Formula Meaning

Calls From Subnet (totalCallsFromSubnet/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe.

Calls From Subnet since 
Baseline

(totalCallsFromSubnet/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet since the last 
baseline reset.

Calls Cleared (No Channel) (callsClearedNoChannel/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected  due to lack of 
idle channels.
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Component: EM/ VR/ PP/ MPLSPORT OUTSEG/

Name Formula Meaning
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Calls Cleared (No Channel) 
since Baseline

(callsClearedNoChannel/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
lack of idle channels, since 
the last baseline reset.

Calls Cleared (Out of 
Service)

(callsClearedOutOfService/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected  due to lack of 
in-service channels.

Calls Cleared (Out of 
Service) since Baseline

(callsClearedOutOfService/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
lack of in-service channels, 
since the last baseline reset.

Calls Rejected (callsRejected/NUM)                      
DELTA

Number of call attempts from 
the subnet since the last 
probe rejected due to 
typeOfCall or signaling 
protocol mismatches.

Calls Rejected since 
Baseline

(callsRejected/NUM)                      
BASELINEDELTA

Number of call attempts from 
the subnet rejected due to 
typeOfCall or  signaling 
protocol mismatches, since 
the last baseline reset.

Table 86
Component: EM/ VS/ FRAMER

Name Formula Meaning

Total Cells (totalCells/NUM)                      DELTA Total number of cells since 
last probe.

Total Cells since Baseline (totalCells/NUM)                      
BASELINEDELTA

Total number of cells since 
the last baseline reset.

Audio Cells (audioCells/NUM)                      
DELTA

Number of audio cells since 
last probe.
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Component: EM/ VROUTE/

Name Formula Meaning
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Audio Cells since Baseline (audioCells/NUM)                      
BASELINEDELTA

Number of audio cells since 
the last baseline reset.

Frames To Network (64 s) (frmToNetwork[0]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (64 s) 
since Baseline

(frmToNetwork[0]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (32 s) (frmToNetwork[1]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (32 s) 
since Baseline

(frmToNetwork[1]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (24 s) (frmToNetwork[2]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (24 s) 
since Baseline

(frmToNetwork[2]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (16 s) (frmToNetwork[3]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (16 s) 
since Baseline

(frmToNetwork[3]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames To Network (8 s) (frmToNetwork[4]/NUM)                      
DELTA

Number of frames to network 
since last probe.

Frames To Network (8 s) 
since Baseline

(frmToNetwork[4]/NUM)                      
BASELINEDELTA

Number of frames to network 
since the last baseline reset.

Frames Lost In Network (frmLostInNetwork/NUM)                      
DELTA

Number of frames lost in 
network since last probe.

Frames Lost In Network 
since Baseline

(frmLostInNetwork/NUM)                      
BASELINEDELTA

Number of frames lost in 
network since the last 
baseline reset.

Frames Underruns (frmUnderRuns/NUM)                      
DELTA

Number of frame underruns 
since last probe.

Frames Underruns since 
Baseline

(frmUnderRuns/NUM)                      
BASELINEDELTA

Number of frame underruns 
since the last baseline reset.

Table 86 (continued)
Component: EM/ VS/ FRAMER

Name Formula Meaning
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Frames Dumped (frmDumped/NUM)                      
DELTA

Number of frame dumps 
since last probe.

Frames Dumped since 
Baseline

(frmDumped/NUM)                      
BASELINEDELTA

Number of frame dumps 
since the last baseline reset.

LRC Errors (lrcErrors/NUM)                      DELTA Number of LRC errors since 
last probe.

LRC Errors since Baseline (lrcErrors/NUM)                      
BASELINEDELTA

Number of LRC errors since 
the last baseline reset.

Modem Cells (modemCells/NUM)                      
DELTA

Number of modem cells since 
last probe.

Modem Cells since 
Baseline

(modemCells/NUM)                      
BASELINEDELTA

Number of modem cells since 
the last baseline reset.

Table 87
Component: EM/ VS/ LCO

Name Formula Meaning

Voice Tx Rate (kb/s) (pktsToNetwork/NUM)                      
DELTA                      352                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits sent per second (44 
Bytes/packet).

Voice Tx (kb) since 
Baseline

(pktsToNetwork/NUM)                      
BASELINEDELTA                      352                      
MULTIPLY                      1000                      
DIVIDE

Kilobits sent (44 Bytes/
packet) since the last 
baseline reset.

Voice Rx Rate (kb/s) (pktsFromNetwork/NUM)                      
DELTA                      352                      
MULTIPLY                      SECONDS                      
DIVIDE                      1000                      
DIVIDE

Kilobits received per second 
(44 Bytes/packet).
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Component: EM/ VS/ FRAMER
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Voice Rx (kb) since 
Baseline

(pktsFromNetwork/NUM)                      
BASELINEDELTA                      352                      
MULTIPLY                      1000                      
DIVIDE

Kilobits received (44 Bytes/
packet) since the last 
baseline reset.

Round trip delay (ms) (measuredRoundTripDelay/NUM) Measured round trip delay in 
milliseconds. 

Path Up DateTime (pathUpDateTime/STR) Path up date and time.

Table 88
Component: EM/ VSR/

Name Formula Meaning

Active Channel Number (activeChannels/NUM) Number of currently active B-
channels.

Active Voice Channel 
Number

(activeVoiceChannels/NUM) Number of currently active B-
channels carrying voice.

Active Modem Channel 
Number

(activeModemChannels/NUM) Number of currently active B-
channels carrying MODEM 
(2100Hz tone).

Active Data Channel 
Number

(activeDataChannels/NUM) Number of currently active B-
channels carrying data.

Table 87 (continued)
Component: EM/ VS/ LCO

Name Formula Meaning
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DPN-100 metrics

DPN-100 Metrics
DPN-100 metrics are generated by the DPN Performance Viewer, and are 
detailed in the following sections.

• “Micro status” (page 265).

• “Net Link status” (page 266).

• “Trunk status” (page 267).

• “Gateway status” (page 268).

• “Summary status” (page 269).

Micro status
This DPN Performance Viewer option provides metrics for the PEs of a 
specific DPN-100 module. The information for these metrics is gathered from 
the DPN-100 NCS PE status records.

See the table “Destination mnem: PM/<mnemonic> or just <mnemonic>” 
(page 266).
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Net Link status
This PV option provides metrics for all the network links whose endpoint 
modules report to a specific DPN-100 NCS OA. The information for these 
metrics is gathered from the DPN-100 NCS Network Link status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 267).

Table 89
Destination mnem: PM/<mnemonic> or just <mnemonic> 

Name Formula Label Meaning
CPU Utilization (%) peCpuUtilization UT PE CPU utilitilization 

Range: 0-100 %, -1 = 
down

Free Heap (%) peFreeHeap HP PE free heap space 
utilization 
Range: 0-100 %, -1 = 
down

Free MSG (%) peFreeMsgPE MSG free message blocks 
utilization
Range: 0-100 %, -1 = 
down

PPS Sent pePpsSent TXPK/S Packets per second sent
Initial Range: 0-20 pps, -1 
= down

PPS Received pePpsReceived RXPK/S Packets per second 
received
Initial Range: 0-20 pps, -1 
= down

PE Service peService SERVICE PE service name
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Trunk status
This DPN Performance Viewer option provides metrics for all the Trunks 
whose endpoint modules report to a specific DPN-100 NCS OA. The 
information for these metrics is gathered from the DPN-100 NCS Trunk 
status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 267).

Table 90
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Netlink Transmit 
Utilization (%)

netlinkUtilization UT Network link transmit side 
utilization Range: 0-100 
%, -1 = down

Netlink Local Mnemonic netlinkLocalMnemonic LOCAL Local network link 
mnemonic

Netlink Remote 
Mnemonic

netlinkRemoteMnemonic REMOTE Remote network link 
endpoint component ID

Table 91
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Trunk Transmit 
Utilization (%)

trunkUtilization UT Trunk transmit side link 
utilization
Range: 0-100 %, -1 = 
down

Trunk Local Mnemonic trunkLocalMnemonic LOCAL Local trunk mnemonic

Trunk Remote 
Mnemonic

trunkRemoteMnemonic REMOTE Remote trunk endpoint 
component ID
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Gateway status
This DPN Performance Viewer option provides metrics for all the X.25 and 
X.75 gateways whose endpoint module reports to a specific DPN-100 NCS 
OA. The information for these metrics is gathered from the DPN-100 NCS 
X.25 and X.75 Gateway status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 268).

Table 92
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Gateway Type gatewayType TYPE Type of gateway (X25 or 

X75)

Gateway Call (%) gatewayCall CALL Maximum percentage 
number of active LCNs 
compared to the total 
number of LCNs for the 
status interval
Range: 0-100 %, -1 = 
down

Link Transmit Utilization 
(%)

gatewayLinkUtilization LINK UT Total link sending and 
receiving utilization
Range: 0-100 %, -1 = 
down

Gateway Pkt Sent gatewayPktSent TXPK/S Packets per second sent
Initial Range: 0-20 pps, -1 
= down

Gateway Pkt Received gatewayPktReceived RXPK/S Packets per second 
received
Initial Range: 0-20 pps, -1 
= down
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Summary status
This DPN Performance Viewer option provides NCS Common Memory 
metrics for modules reporting to a specific DPN-100 NCS OA. The 
information for these metrics is gathered from the DPN-100 NCS Common 
Memory status records.

See the table “Destination mnem: OA/<mnemonic> or just <mnemonic>” 
(page 269).

Table 93
Destination mnem: OA/<mnemonic> or just <mnemonic>

Name Formula Label Meaning
Bus Utilization (%) pmBusUtilization BUS Module bus utilization

Range: 0-100

Common MSG (%) pmCommonMsg MSG Common memory 
message block utilization
Range: 0-100
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Appendix C 
Metric file format

This appendix describes the metric elements and their associated attributes in 
SNMP metric files, describes their formats, and provides sample metric files. 
The section contains the following topics:

• “SNMP metric file formats” (page 271)

• “METRICFILE” (page 271)

• “Metric file example” (page 282)

You can add metrics and components to extend the SNMP metric file as 
required.

The metric file is a flat ASCII file in XML format. To edit it, use a standard 
Unix text editor.

SNMP metric file formats
The metric file contains elements and attributes. For a description of the 
format of this file, see “METRICFILE” (page 271). To view sample metric 
file formats, see “Metric file example” (page 282)

METRICFILE
The keyword <METRICFILE> is mandatory. This keyword denotes the 
beginning of a metric file and must be the first entry in the metric file. The 
keyword </METRICFILE> is also mandatory. This keyword denotes the end 
of a metric file and must be the last entry in the metric file.
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Comment
The comment element is optional. You can place comments anywhere within 
the metric file. The format for this element is <!--Comments-->.

COMPONENT
The COMPONENT element is mandatory. This element describes the 
characteristics of the component. You can embed one or more COMPONENT 
elements within the METRICFILE tags. The notation <COMPONENT...> 
indicates the beginning of the COMPONENT definition and the notation 
</COMPONENT> indicates the end of that definition. You need to define all 
attributes of the COMPONENT element within these notations. The 
attributes of the COMPONENT element are as follows:

COMPONENT NAME
The format for the NAME attribute of the COMPONENT element is 
<COMPONENT NAME = “<component name>”> where <component 
name> is the component name used in the Preside MDM component 
hierarchy. The name begins with the device type which is the root of the 
hierarchy. A slash (/) at the end of each component type indicates that a 
component attribute is required. Use only uppercase characters in this field.

Note: The short form of the component prompt must be used for 
<component name>. Do not leave any white space before or after 
<component name>. Failure to do this when adding or editing metrics 
results in a component not available message when polling for one or 
more metrics.

SEPARATE_IP
The SEPARATE_IP element is optional. When used, it is an element within 
the COMPONENT element. This element indicates that the component has a 
different IP address than the device with which it is associated. To define this 
element, use the <SEPARATE_IP/> notation. 

MAP
The MAP element is optional. When used, it is an element within the 
COMPONENT element. Use this element to map a component instance in the 
component name to a different value. You can define one or more MAP 
elements within the COMPONENT element. The notation <MAP...> 
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indicates the beginning of the MAP element definition and the notation </
MAP> indicates the end of that definition. The are two attributes of the MAP 
element are as follows:

• NAME
The MAP NAME attribute is mandatory when you use the MAP element. 
This attribute is an attribute of the MAP element and defines the 
component instance in the component name. The format of the MAP 
NAME attribute is <MAP NAME=”<name>” where <name> uses the 
convention $n to indicate the nth component instance in the component 
name. 

• VALUE
The MAP VALUE indicates the decrement value of the component 
instance. The format of this attribute is VALUE=”<value>” where 
<value> is “DEC(<offset>)” and <offset> is any integer or single 
alphabetic character (A to Z). The notation “DEC(<offset>)” decrements 
the component instance specified in the NAME attribute by the value 
specified in <offset>. The following example shows a sample MAP 
element:

<MAP NAME=”$4”
VALUE=”DEC(A)”>

</MAP>

The value of “$4” for the MAP NAME attribute indicates the mapping of 
the value is performed on the fourth component instance in the 
component name. The value “DEC(A) indicates the fourth component 
instance value will be decremented by the value of the character A. If the 
fourth component instance is “A”, then the resulting value is “0”. If the 
fourth component instance is “B”, then the resulting value is “1”. The 
resulting VALUE is then used as the INDEX value in the METRIC 
element if this component instance is defined in the metric INDEX 
attribute.

METRIC
This METRIC element is mandatory. This element is an element within the 
COMPONENT element. You can define one or more METRIC elements 
within the COMPONENT element. The notation <METRIC...> indicates the 
beginning of the METRIC element definition and the notation </METRIC> 
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indicates the end of that definition. You need to define all attributes of the 
METRIC element within these notations. The attributes of the METRIC 
element are as follows:

• NAME
The format for the NAME attribute of the METRIC element is 
<METRIC NAME=“<metric name>...>” where <metric name> is the 
name of the metric. The Data Viewer main window uses this name to 
identify the metric.

• POLLBYDEFAULT
The POLLBYDEFAULT attribute of the METRIC element specifies the 
default polling of the metric. The value of this keyword can be “yes” or 
“no”. If “yes”, the metric is polled by default and the metric name 
appears in the “Metrics to be Polled” list in the Data Viewer main 
window. If “no”, the metric is not polled by default and appears in the 
“Metrics Available” list in the Data Viewer main window. To define this 
attribute, use the notation POLLBYDEFAULT=“<yes or no>”.

• THRESHOLD
The THRESHOLD attribute is optional. This attribute of the METRIC 
element specifies the maximum threshold value of the metric. If a metric 
value exceeds the defined threshold, the Data Viewer windows displays 
that data in red. To define this attribute, use the notation 
THRESHOLD=“<value>” where <value> is the threshold value. 

• STACK
The STACK attribute of the METRIC element identifies the attributes to 
be polled and the required calculation. To define this attribute, use the 
notation STACK=“<stack elements>” where <stack elements> contain 
one of the following items:

— an attribute which is defined as name/type

— a constant, which you type as a string of digits

— an operator keyword, which indicates that a numerical operation 
should be performed on the current stack contents (for example, 
ADD, SUBTRACT, MULTIPLY). 

— a special keyword (SECONDS) used to represent the elapsed time 
since the last update
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The following are examples of metric stacks:

STACK=“(sdmErroredSeconds/NUM)
(sdmSeverelyErroredSeconds/NUM
PERCENT”

STACK=“(sdmErroredSeconds/NUM)
DELTA
8
MULTIPLY
SECONDS
DIVIDE
2
DIVIDE
2
SUBTRACT”

The stack depth is limited to two. Therefore you must express new Data 
Viewer metrics in a manner that will run with a stack depth of two.

Attributes
Each attribute specification is replaced on the stack by the corresponding 
value received from the network. Attributes are written as (name/type), where

 name is the table column name taken from the MIB table for SNMP devices

type indicates the type of data returned from the device for this attribute. The 
Data Viewer supports only the numeric data type (NUM).

You can include the same attribute in more than one metric. In this case, only 
one copy of the attribute is stored in the Data Viewer; however, all metrics are 
calculated using the same attribute value.

Constants
You can place integer constants on the stack as required to compute the 
desired value. Constants are useful for

• dividing a value by 100 for display as a percentage
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• converting between different units (for example, bytes per second to bits 
per second).

Operators
Several operators are available for use in a metric definition. In the following 
descriptions the top of the stack is the value (attribute or constant) most 
recently placed onto the stack. The bottom of the stack is the other value 
(since Data Viewer requires a stack depth of two).

The following binary operators are supported. When you use an operator, 
both the top and bottom values on the stack are removed and the resulting 
value is placed on the top of the stack.

• ADD 
Use this operator to add the two values on the stack and store the result.

• SUBTRACT
Use this operator to subtract the top value from the bottom value and 
store the result. For example, “7 4 SUBTRACT” leaves a result of “3” on 
the stack.

• MULTIPLY
Use this operator to multiply the stack values and store the result.

• DIVIDE
Use this operator to divide the value on the bottom of the stack by the 
value on top and store the result. For example, “6 2 DIVIDE” leaves a 
result of “3” on the stack.

• PERCENT
Use this operator as a shortcut to ensure that percentage calculations are 
performed correctly. In this example, “A B DIVIDE 100 MULTIPLY” 
normally produces the wrong answer because the (integer) division is 
performed before the multiplication. To ensure correct results, use the 
format “A B PERCENT”.
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The following unary operators affect only the top element on the stack. You 
can apply them to both attributes and constants. However, they are only useful 
when the top element on the stack is an attribute or the result of a previous 
stack operation.

• NEGATE
This operator toggles the sign of the value on top of the stack. For 
example, “6 2 NEGATE” leaves “6 -2” on the stack.

• DELTA
This operator replaces the attribute value with the difference between the 
current value and the previous value for the same attribute. This is useful 
when dealing with attributes, such as alarm counts, that continue to grow 
over time.

• BASELINEDELTA
This operator replaces the attribute value with the difference between the 
current value and the baseline value. The baseline value is the first 
sample taken after polling is started or resumed. 

SECONDS Keyword
You can place the SECOND keyword on the stack to support time-based 
calculations. It is replaced on the stack by the elapsed time since the last 
update or calculation cycle, expressed in the appropriate units. For example, 
you might use the SECOND keyword to construct metrics of the form 
“Alarms per minute”. To do so, you would define the following (pseudo) 
stack:

(AlarmCount/123)
DELTA
SECONDS
DIVIDE
60
MULTIPLY
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In this case the AlarmCount attribute is assumed to be a continually 
increasing variable. Therefore, you would use the DELTA operator to ensure 
that only the new alarms are used in this calculation.

• INDEX 
The INDEX describes the index of the attributes specified in the stack 
elements. 

The following conventions describe an index:

— $n
The index for the object identifier (OID) of the attribute in the stack 
uses the nth component instance in the component name. In the 
following example, the INDEX attribute has a value of $3. As a 
result, the third-level component in the component name is used as 
the index for the OID of the STACK attribute.

<COMPONENT NAME = “<deivce type>/ <component>/”>
<METRIC NAME=“Uncorrectable HEC errors”

POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“$3” >

</METRIC>
</COMPONENT>

where: 
device typeis the device type
componentis the component type
attribute stackis the attribute name of which its value is used
to calculate the metric value

When you enter the component <ABC>/NNE CA/1 SH/1 AWM/11 
in the Data Viewer, and select the metric “Uncorrectable HEC 
errors”, the attribute “awmUncorrHecErrors” translates into the OID 
.1.3.6.1.4.1.562.21.1.1.8.1.4.17.2.1.16. Because the INDEX 
attribute has a value of “$3”, the third component instance (which is 
11 for AWM) is used as the index to the MIB table column. The 
resulting OID is .1.3.6.1.4.1.562.21.1.1.8.1.4.17.2.1.16.11.
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— (<table column>)
The index uses an entry in a MIB table column. The <table column> 
identifies the MIB table column that contains the index. This 
notation retrieves all values for the OID that are associated with the 
<table column>.

If there is only one value in the <table column>, then that value is 
used as the index. If there is more than one value in the <table 
column>, select the appropriate value for the index. This value is 
used as the index for all the selected component instances.

In the following example, the INDEX attribute is defined as the table 
column “brmUpChanId”.

<COMPONENT NAME = “<device type>/ <component>/”>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute)” >

</METRIC>
</COMPONENT>

where: 
device typeis the device type
componentis the component type
metric nameis the name of the metric
stack attributeis the attribute name of which its value is used to
calculate the metric value
index attributeis the attribute name of which its value is used to
define the index value of the attribute name
<attribute name>

When you enter the component <device type>/ <component>/” in 
the Data Viewer and select the metric “Up Total Cell Count”, the 
INDEX attribute “brmUpChanId” is polled and values in this table 
column display in the Index Selection dialog.
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— The value you select is used as the index to the attribute 
“bUpToTCellCount”. For example, if the OID for 
“bUpToTCellCount” is 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.and you select an index 
value of 2, then the OID becomes 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.2.

— (<table column>/COMPONENT)
The index uses an index of the <table column>. The keyword 
COMPONENT uses the component name in the Data Viewer 
window to find the index. When a value of the <table column> 
matches the component, the value’s associated index is used as the 
index for the OID of the attribute name.

In the following example, the INDEX attribute is defined as the 
value “mcmSysIfExtName/COMPONENT”.

<COMPONENT NAME = “MPA/ CARD/ PO/”>
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<METRIC NAME=“Frames received from WAN”
POLLBYDEFAULT=“no” 
THRESHOLD=“100” 
STACK=“(wanifGlobalStatisticsRxBlockCount/NUM) 

DELTA”
INDEX=“(mcmSysIfExtName/COMPONENT)” >

</METRIC>
</COMPONENT>

When you enter the component MPA/MPA1 CARD/1 PO/1 in Data 
Viewer and select the metric 
“wanifGlobalStatisticsRxBlockCount”, the table column 
“mcmSysIfExtName” is polled. If a value in this table matches the 
string CARD/1 PO/1, then the index of the matched entry is used as 
the index for the STACK attribute 
“wanifGlobalStatisticsRxBlockCount”. For example, if the OID for 
“wanifGlobalStatisticsRxBlockCount” is 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2 and the index entry of the 
table column “mcmSysIfExtName” that matches the string 
CARD/1 PO/1 is 150, then the OID of the STACK attribute 
“wanifGlobalStatisticsRxBlockCount” becomes 
.1.3.6.1.4.1.562.21.1.1.8.1.4.19.1.18.1.2.150.

— <any string>
The constant string <any string> is used as the index for the OID of 
the attribute.

In the following example, the INDEX attribute has the value “0”.

<COMPONENT NAME = “<device type>/ <component>/”>
<METRIC NAME=“Snr”

POLLBYDEFAULT=“no” 
STACK=“(<stack attribute>/NUM)”
INDEX=“(<index attribute>)” >

</METRIC>
</COMPONENT>

where: 
device type is the device type
componentis the component type
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stack attributeis the attribute name of which its value is used to
calculate the metric value

When you enter the component <ABC>/NIU3 TMM in Data Viewer 
and select the metric “Snr”, the STACK attribute “tmmDsSnr” is 
translated into its OID .1.3.6.1.4.1.562.21.1.2.14.12. With an 
INDEX value of “0”, the OID for “tmmDsSnr becomes 
.1.3.6.1.4.1.562.21.1.2.14.12.0.

If the OID of the attribute name specified in the stack requires more than one 
index, you can combine any index method, except for (<table column>/
COMPONENT).

Metric file example
<METRICFILE>

<COMPONENT NAME = “<device type>/ <component>/”>
<SEPARATE_IP/>

<METRIC NAME=“<metric name>”
POLLBYDEFAULT=“yes” 
THRESHOLD=“100” 
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute>)” 

</METRIC>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“(<index attribute>)”>

</METRIC>

<--! This is different COMPONENT -->
<COMPONENT NAME = “<device type>/ <component?/”>

<MAP NAME=”$4”
VALUE=”DEC(A)”>

</MAP>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
241-6001-031   14.3RSUP   



Appendix C Metric file format   283
STACK=“(<stack attribute>>/NUM) DELTA”
INDEX=“$3 $4”>

</METRIC>
<METRIC NAME=“<metric name>”

POLLBYDEFAULT=“no”
THRESHOLD=“100”
STACK=“(<stack attribute>/NUM) DELTA”
INDEX=“$3 $4”>

</METRIC>
</COMPONENT>

</METRICFILE>

where: 
device type is the device type
component is the component type
metric name is the name of the metric
stack attribute is the attribute name of which its value is used to

calculate the metric value
index attribute is the attribute name of which its value is used to 
define

the index value of the attribute name <attribute 
name>
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